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About this manual1.

Copyright1.1.

This document and parts thereof must not be reproduced or copied without written per-
mission from ABB, and the contents thereof must not be imparted to a third party, nor
used for any unauthorized purpose.

The software or hardware described in this document is furnished under a license and
may be used, copied, or disclosed only in accordance with the terms of such license.

Warranty

Please inquire about the terms of warranty from your nearest ABB representative.

http://www.abb.com/substationautomation

Disclaimer1.2.

The data, examples and diagrams in this manual are included solely for the concept or
product description and are not to be deemed as a statement of guaranteed properties.
All persons responsible for applying the equipment addressed in this manual must satisfy
themselves that each intended application is suitable and acceptable, including that any
applicable safety or other operational requirements are complied with. In particular, any
risks in applications where a system failure and/ or product failure would create a risk
for harm to property or persons (including but not limited to personal injuries or death)
shall be the sole responsibility of the person or entity applying the equipment, and those
so responsible are hereby requested to ensure that all measures are taken to exclude or
mitigate such risks.

This product is designed to be connected and to communicate information and data via
a network interface, which should be connected to a secure network. It is sole responsib-
ility of person or entity responsible for network administration to ensure a secure connec-
tion to the network and to establish and maintain any appropriate measures (such as but
not limited to the installation of firewalls, application of authentication measures,
encryption of data, installation of anti virus programs, etc) to protect the product, the
network, its system and the interface against any kind of security breaches, unauthorized
access, interference, intrusion, leakage and/or theft of data or information. ABB is not
liable for damages and/or losses related to such security breaches, unauthorized access,
interference, intrusion, leakage and/or theft of data or information.

This document has been carefully checked by ABB but deviations cannot be completely
ruled out. In case any errors are detected, the reader is kindly requested to notify the
manufacturer. Other than under explicit contractual commitments, in no event shall ABB
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be responsible or liable for any loss or damage resulting from the use of this manual or
the application of the equipment.

Conformity1.3.

This product complies with the directive of the Council of the European Communities
on the approximation of the laws of the Member States relating to electromagnetic
compatibility (EMC Directive 2004/108/EC) and concerning electrical equipment for
use within specified voltage limits (Low-voltage directive 2006/95/EC). This conformity
is the result of tests conducted by ABB in accordance with the product standards EN
50263 and EN 60255-26 for the EMC directive, and with the product standards EN
60255-1 and EN 60255-27 for the low voltage directive. The product is designed in
accordance with the international standards of the IEC 60255 series.

Trademarks1.4.

ABB is a registered trademark of ABB Group. All other brand or product names men-
tioned in this document may be trademarks or registered trademarks of their respective
holders.

General information1.5.

This manual provides thorough information on all the Ethernet-based Master protocols
supported by the COM600 and and their central concepts. You will find instructions on
how to configure the related objects belonging to the different Ethernet-based master
protocol servers. The basic operation procedures are also discussed.

Information in this user’s manual is intended for application engineers.

As a prerequisite, you should understand the basic principles of the different Ethernet-
based master protocols and the IEC 61850 standard.

This user’s manual is divided into following sections:

Introduction

This section gives an overview of the Ethernet based master protocol servers and
their features.
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Configuration

In this section you will find an overview of configuration. You are given instructions
on how to configure Master Protocol OPC Server related objects and the model of a
substation or system.

Operation

This section covers the basic operation procedures you can carry out when transferring
or activating COM600 with new configurations.

You are also given instructions on how to monitor and control the conditions of substation
communication network.

Document conventions1.6.

The following conventions are used for the presentation of material:
• The words in names of screen elements (for example, the title in the title bar of a

window, the label for a field of a dialog box) are initially capitalized.
• Capital letters are used for the name of a keyboard key if it is labeled on the keyboard.

For example, press the ENTER key.
• Lowercase letters are used for the name of a keyboard key that is not labeled on the

keyboard. For example, the space bar, comma key, and so on.
• Press CTRL+C indicates that you must hold down the CTRL key while pressing

the C key (to copy a selected object in this case).
• Press ESC E C indicates that you press and release each key in sequence (to copy

a selected object in this case).
• The names of push and toggle buttons are boldfaced. For example, click OK.
• The names of menus and menu items are boldfaced. For example, the  File menu.

• The following convention is used for menu operations: MenuName > Menu-
Item > CascadedMenuItem. For example: select File > New > Type.

• The Start menu name always refers to the Start menu on the Windows taskbar.
• System prompts/messages and user responses/input are shown in the Courier font.

For example, if you enter a value out of range, the following message is displayed:

Entered value is not valid. The value must be 0 - 30 .

• You can be asked to enter the string MIF349 in a field. The string is shown as follows
in the procedure:

MIF349
• Variables are shown using lowercase letters:

sequence name
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Use of symbols1.7.

This publication includes warning, caution, and information icons that point out safety-
related conditions or other important information. It also includes tip icons to point out
useful information to the reader. The corresponding icons should be interpreted as follows.

The electrical warning icon indicates the presence of a hazard
which could result in electrical shock.

The warning icon indicates the presence of a hazard which
could result in personal injury.

The caution icon indicates important information or warning
related to the concept discussed in the text. It may indicate
the presence of a hazard which could result in corruption of
software or damage to equipment or property.

The information icon alerts the reader to relevant facts and
conditions.

The tip icon indicates advice on, for example, how to design
your project or how to use a certain function.

Terminology1.8.

DescriptionTerm

An abnormal state of a condition.Alarm

An OPC service for providing information about alarms and
events to OPC clients.

Alarms and Events; AE

COM600 as a generic name for COM600S IEC and COM600F
ANSI products

COM600 Series; COM600

An OPC service for providing information about process data to
OPC clients.

Data Access; DA

Part of a logical node object representing specific information,
for example, status, or measurement. From an object-oriented
point of view, a data object is an instance of a class data object.
DOs are normally used as transaction objects; that is, they are
data structures.

Data Object; DO
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DescriptionTerm

The data set is the content basis for reporting and logging. The
data set contains references to the data and data attribute val-
ues.

Data Set

A physical device that behaves as its own communication node
in the network, for example, protection relay.

Device

Change of process data or an OPC internal value. Normally, an
event consists of value, quality, and timestamp.

Event

A physical IEC 61850 device that behaves as its own commu-
nication node in the IEC 61850 protocol.

Intelligent Electronic Device

Representation of a group of functions. Each function is defined
as a logical node. A physical device consists of one or several
LDs.

Logical Device; LD

The smallest part of a function that exchanges data. An LN is
an object defined by its data and methods.

Logical Node; LN

Series of standards specifications aiming at open connectivity
in industrial automation and the enterprise systems that support
industry.

OPC

Representation of a connection to the data source within the
OPC server. An OPC item is identified by a string <object
path>:<property name>. Associated with each OPC item are
Value, Quality, and Time Stamp.

OPC item

Named data item.Property

The report control block controls the reporting processes for
event data as they occur. The reporting process continues as
long as the communication is available.

Report Control Block

ABB proprietary communication protocol used in substation
automation.

SPA

Protection and/or Control Product supporting the SPA protocol
version 2.5 or earlier.

SPA device

XML-based description language for configurations of electrical
substation IEDs. Defined in IEC 61850 standard.

Substation Configuration Lan-
guage; SCL

Abbreviations1.9.

The following is a list of abbreviations associated with COM600 that you should be
familiar with. See also 1.8, Terminology.

DescriptionAbbreviation

Alarms and EventsAE

Application Service Data UnitASDU

Buffered Report Control BlockBRCB

Data AccessDA
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DescriptionAbbreviation

Data Message Code DefinitionDMCD

Data ObjectDO

Gateway, component connecting two communication networks togetherGW

Web Human Machine InterfaceWebHMI

International Electrotechnical CommissionIEC

Intelligent Electronic DeviceIED

Local Area NetworkLAN

Logical DeviceLD

Logical NodeLN

Network Control CenterNCC

Norwegian User ConventionNUC

Object Linking and EmbeddingOLE

OLE for Process ControlOPC

Protection & ControlP&C

Programmable Logic ControllerPLC

Program Organization UnitPOU

Request To SendRTS

Substation AutomationSA

Substation Configuration DescriptionSCD

Substation Configuration LanguageSCL

Sequential Function ChartSFC

Single Line DiagramSLD

Simple Network Management ProtocolSNMP

Simple Network Time ProtocolSNTP

Report Control BlockRCB

Unbuffered Report Control BlockURCB

eXtended Markup LanguageXML

Related documents1.10.

MRS numberName of the manual

1MRS756125COM600 User’s Manual
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Document revisions1.11.

HistoryProduct revisionDocumentversion/date

Document created5.0A/24.5.2017

Document revised5.1B/9.4.2018
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Introduction2.

General information about the COM600 series2.1.

The COM600 product series are versatile Substation Management Units that help realize
smart substation and grid automation solutions in industrial and utility distribution net-
works.

They get deployed together with protection and control IEDs, substation devices such
as RTUs, meters and PLCs in dedicated cabinets and switchgear.

The COM600 product is an all-in-one unit that functions as:
• Communication gateway
• Web Human Machine Interface (WebHMI)
• Automation controller
• Real-time and historical data management unit

The COM600 product series use process information and device data, acquired over
Ethernet or serial communication protocol interfaces to execute specific substation
functions and applications. Thus, they are critical building blocks to realize substation
secondary system solutions and in the process solving diverse customer needs.

COM600 product series variants and rationale2.2.

To facilitate substation and grid automation solutions in IEC and ANSI market areas, a
variant-based system similar to Relion® 615 and 620 series is being followed from
COM600 5.0 release.

The main reasons for such an approach are the following:

• To ensure all COM600 product series features are advantageously used in end-cus-
tomer projects in the medium voltage substation automation domain.

• To ensure an optimum feature set to be bundled together to realize specific applica-
tions required in IEC and ANSI market areas.

• To ensure a future-proof product approach.

This release then comprises of two variants, based on the primary intent or application
are defined as follows:
• COM600S IEC – COM600 for substation automation, analysis and data management

(for IEC markets)
• COM600S IEC is a substation automation, analyzer and data management unit

that integrates devices, facilitates operations, manages communication and runs
analysis applications pertinent to equipment or operations in utility or industrial
distribution substations.

• COM600F ANSI – COM600 as distribution automation controller (for ANSI markets)
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• COM600F is a dedicated distribution automation controller unit that runs dis-
tributed grid and feeder applications for ANSI power networks and inherits all
core features of the COM600 series.

Functional overview2.3.

COM600 supports multiple master communication protocols by which it exchanges data
with field devices such as protection and control IEDs, meters or other devices such as
station controllers, Ethernet switches and WebHMIs. The data communication can be
accomplished using Ethernet or serial interfaces such as RS 232 or RS 485. The following
master protocols are supported by the COM600:

1. Ethernet-based protocols
• IEC 61850-8-1
• IEC 60870-5-104
• DNP 3.0 LAN/WAN
• Modbus
• OPC
• SNMP

2. Serial interface-based protocols
• IEC 60870-5-101
• IEC 60870-5-103
• DNP 3.0 Serial
• Modbus
• SPA

COM600 converts all field data, acquired using the communication protocols listed
above, into OPC items. An OPC server is dedicated to every supported protocol. This
OPC server enables other OPC clients (internal) to access process data from slave devices.

This manual specifically covers the above listed Ethernet based master protocols.
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SysConf.bmp

Figure 2.3-1 System overview

1. Network Control Center (NCC), Distributed Control System (DCS)
2. Station Automation Builder 600 (SAB600)
3. COM600 with Ethernet-based OPC Server (IEC 61850/IEC 60878-5-104/DNP3.0-

LAN/MODBUS-TCP/OPC/SNMP/SNTP)
4. Ethernet switch (SNMP compliant)
5. Field devices like protection and control devices, PLCs, IO units etc.

The protocol handling, that is, configuration and operation aspects comprise of generic
and specific aspects. These generic and specific parts will be described separately in this
manual.

Handling in brief:

All master (client) protocols have two common aspects

• An OPC server layer
• Data modeling based on IEC 61850

While the OPC server layer provides access to data from the slave devices, the IEC
61850 data model creates a common and protocol-independent data interface between
the OPC server and the Master protocol (client) layer. All the 3 layers together are referred
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as a ‘Master protocol OPC server’. Each master protocol OPC server is a separate identity.

handling_in_brief.png

Figure 2.3-2 

The master protocol and OPC server layers are runtime software components. The IEC
61850 data model is built based on the imported SCL file using Station Automation
Builder 600 (SAB600). To simplify the protocol conversion and the signal mapping,
each master protocol OPC server uses the same common data modeling (common data
classes and services) specified in the IEC 61850 standard. The COM600 configuration
data is also in SCL (XML-based) format.

After the master protocol OPC server is launched, it reads the configuration data and
establishes communication with the slave devices through the master (client) protocol
stack. Configured slave devices and their data are then exposed to OPC clients (Web
Server, slave protocols etc.) through the master protocol OPC server. The slave devices’
reported data changes together with Data Access subscription are reported to the sub-
scribing OPC clients.

The Master protocol OPC server component handles the data transfer and conversion
between the underlying master protocol communication stack and OPC interfaces.

Master protocol OPC server features2.4.

IEC 61850 OPC Server features2.4.1.

The IEC 61850 standard is a set of specifications, which detail a layered approach to
substation communication architecture. It specifies the usage of Manufacturing Message
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Specification (MMS, ISO 9506) between the IEC 61850 server (slave devices) and IEC
61850 client (IEC 61850 OPC Server, master). The COM600 IEC 61850 OPC server
can subscribe to both MMS and GOOSE based data. However, it can only send MMS
based command information to the slave devices.

The IEC 61850 OPC Server supports the following features:

• OPC Data Access v. 1.0/2.0
• OPC Alarms and Events specifications v. 1.10
• Communication diagnostics
• IEC 61850 data modeling
• System supervision:

• IEC 61850 device communication
• Command handling:

• The IEC 61850 OPC Server supports the IEC 61850 command services.
• • SPS, DPS, INS, ACT, ACD, SEC, BCR, MV, CMV, SAV, WYE, DEL, SEQ,

SPC, DPC, BSC, ISC, APC, SPG, ING, ASG, CURVE, DPL, LPL.
• IEC 61850 buffered and unbuffered reporting services
• IEC 61850 File Transfer
• IEC 61850 GOOSE receive (received GOOSE data updated to OPC)
• Automatic Disturbance Recording upload using IEC 61850 file transfer or FTP
• SPA TCP
• SPA Parameter access (configured with Parameter Filtering Tool)
• Time synchronization:

• The IEC 61850 OPC Server can act as an SNTP client and server for time syn-
chronization. When the IEC 61850 OPC Server is configured for receiving time
synchronization, it updates the operating system time of the PC.

• Multiple instance support
• GOOSE Analyzer support

IEC 60870-5-104 OPC Server features2.4.2.

The IEC 60870-5-104 (IEC 104) protocol is a standard for power system monitoring,
control and associated communications for telecontrol, protection and associated tele-
communications for electric power systems. The IEC 104 master protocol implementation
in the COM600 uses a TCP/IP interface for substation LAN (Local Area Network)
connectivity and thereby to field slave devices supporting IEC 104. The application layer
of IEC 104 is preserved same as that of IEC 101.

The IEC 104 OPC Server supports the following features:
• OPC Data Access v. 1.0/2.0
• OPC Alarms and Events specification v. 1.10
• IEC 61850 data modeling
• System supervision:

• IEC 104 channel supervision
• IEC 104 device communication

• Supported IEC 60870-5-104 data types and functions.
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DNP 3.0 OPC Server features2.4.3.

DNP3 (Distributed Network Protocol) is a de-facto communication protocol for commu-
nication between SCADA master stations (control centres), RTUs, protection and control
devices and meters. It is used mainly in electric and water utilities. The COM600 incor-
porates the DNP 3.0 master LAN/WAN for Ethernet based communication with station
devices.

The DNP LAN/WAN OPC Server supports the following features:
• OPC Data Access v. 1.0/2.0
• OPC Alarms and Events specifications v. 1.10
• IEC 61850 data modeling
• System supervision:

• DNP channel communication
• DNP device communication

• Level of DNP implementation

Modbus OPC Server features2.4.4.

Modbus is a de-facto standard communication protocol used in electrical and industrial
process data exchange between substation devices such as IEDs, meters or PLCs with
COM600.

The Modbus OPC Server is intended for connecting simple Modbus devices like energy
meters and input/ouput modules. As the protocol is based on scanning the state of the
inputs of the device, it depends on the scan rate how short signal transients are registered.
No events or time stamps are supported.

The Modbus messaging service provides a client/server communication between devices
connected on an Ethernet TCP/IP network. This model is based on four types of messages:
request, confirmation, indication, and response.

A system using Modbus TCP/IP can include different types of devices. There can be
ModbusTCP/IP client and server devices connected to an TCP/IP network. There can
also be devices such as bridges, routers and gateways for connections between the TCP/IP
network and a serial line sub-network, permitting connections to Modbus serial line client
and server end devices.

The Modbus OPC Server supports the following features:

• OPC Data Access v. 1.0/2.0
• OPC Alarms and Events specifications v. 1.10
• IEC 61850 data modeling
• System supervision:

• Modbus channel communication
• Modbus device communication
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Supported transmission modes:
• Modbus RTU
• Modbus ASCII

Table 2.4.4-1 The function codes supported by Modbus OPC Server
Memory areaDescriptionFunction code

00001 - 09999Read coil status01

10001 - 19999Read input status02

40001 - 49999Read holding register03

30001 - 39999Read input registers04

00001 - 09999Force single coil05

40001 - 49999Write single register06

40001 - 49999Write multiple registers16

60001 - 65535Write General Reference21

The following data formats are supported:
• Bit, one coil, or input status
• Word, one register in IED's memory. The data is used in an unsigned form
• Integer, one register in IED's memory. The MSB bit is used as a sign bit
• Long MSW last, signed 32-bit object, which needs two registers from IED's memory

in lsw-msw order
• Long MSW first, signed 32-bit object which needs two registers from IED's memory

in msw-lsw order.
• Float MSW last, floating point type which needs two input registers from IED's

memory in lsw-msw order
• Float MSW first, floating point type which needs two input registers from IED's

memory in msw-lsw order.

External OPC Server features2.4.5.

OPC Data Access is used for continuous, real-time data communication between
PLC/DCS systems and COM600 communicating real-time data from data acquisition
devices such as PLCs to display and interface devices like Web Human-Machine Inter-
faces (WebHMI). OPC DA is also used for inter-process communication in COM600.

SNMP features2.4.6.

The Simple Network Management Protocol (SNMP) is used to manage network con-
nectivity of substation devices in the substation LAN network.

The SNMP OPC Server is intended for providing methods for OPC clients to monitor
network-attached devices.
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The SNMP OPC Server supports the following features:
• SNMP V1, SNMPv2c and SNMPV3 network monitoring
• IEC 61850 data modeling
• System supervision

• SNMP channel communication
• SNMP device communication

SNTP features2.4.7.

The Simple Network Time Protocol (SNTP) is used for clock synchronization between
substation devices. Specifically, COM600 can act as an SNTP master to synchronize the
internal clocks of the protection and control IEDs (SNTP slaves), in the absence of a
dedicated GPS (SNTP server).

The SNTP OPC Server supports the following features:
• OPC Data Access Server v. 1.0/2.0
• OPC Alarms and Events server v. 1.10
• SNTP client and server for time synchronization

27

COM600 series 5.11MRS758689

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



IEC 61850 Master OPC server configuration3.

Overview of configuration3.1.

This chapter guides you in the configuration tasks required before you can start using
the IEC 61850 OPC Server. For information on the IEC 61850 data modeling, refer to
the respective standards and specifications.

Start SAB600 to open and name a project.

The configuration work can be divided into two separate tasks:
1. Building an object tree
2. Configuring object properties

Build an object tree by adding objects to the object tree, refer to 3.2.1, General information
about building object tree. Connectivity Packages for certain protection and control
products usually contain preconfigurations and tools to facilitate the building of the
object tree.

When configuring OPC servers the following characters cannot
be used in object names: \ ` ' ' #

Table 3.1-1 describes the possible objects shown in the object tree. After you have added
the necessary objects to the object tree in the Communication structure, configure them.
Refer to 3.3.1, Configuring object properties.

Table 3.1-1 IEC 61850 OPC Server related objects
DescriptionObject

Object representing the IEC 61850 OPC ServerIEC 61850 OPC Server

Object representing event definitions for IEC 61850 OPC Server
diagnostics

Event Definitions

Object representing a physical subnetwork. IEC 61850 OPC
Server supports only one subnetwork.

IEC 61850 Subnetwork

Object representing a physical IEC 61850 protection and control
device. You should not have more than 30 devices per each
subnetwork.

IEC 61850 Device (IEC 61850
IED)

Predefined object that contains items for controlling or retrieving
status information for the parent object. The parent object can
be the Server, a Subnetwork, or a Device object.

Attributes

Object representing a group of functions, each function is defined
as a logical node. A physical device consists of one or several
LDs.

Logical Device (LD)

An object defined by its data and methods. LN is the smallest
part of a function that exchanges data.

Logical Node (LN)
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DescriptionObject

A data object is an instance of one of the IEC 61850 Common
Data Classes, for example single point status, measured value
etc. Depending on the class, each data object has a set of
attributes for monitoring and controlling the object, for instance
value, quality and control.

Data Object (DO)

The data set is the content basis for reporting and logging. The
data set contains references to the data and data attribute val-
ues.

Data Set (DS)

The report control block controls the reporting process for event
data as they occur. The reporting process continues as long as
the communication is available.

Report Control Block (RCB)

Building object tree3.2.

General information about building object tree3.2.1.

Before you can start using the IEC 61850 OPC Server, you must build and configure an
object tree in SAB600 to define the Communication structure.

Figure 3.2.1-1 shows an example of an object tree after it has been built. In the example
tree, you can see the IEC 61850 OPC Server object and its child objects like subnetworks,
devices and data objects. Indentation is used to indicate the parent-child relationship
between the objects.

29

COM600 series 5.11MRS758689

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



SAB600_Example_View.png

Figure 3.2.1-1  Example view of SAB600

You have several possible ways to add objects to the object tree in the Communication
structure:

• You can right-click the object to which you want to add a child object.
• You can copy the object.
• You can drag and drop the object.

Add the objects in the following order:
1. Gateway (COM600) or Computer Node (MicroSCADA Pro)
2. IEC 61850 OPC Server
3. IEC 61850 Subnetwork
4. IEC 61850 Device (IEC 61850 IED)
5. Import device configurations.

If you want to connect Device Connection Status events to
device objects at this point, make sure that you have already
created and configured the event objects.

For information on building a substation structure, refer to COM600 HMI Configuration
Manual.
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Adding Gateway or Computer Node object3.2.2.

To add a Gateway or Computer Node object:
1. To start building the object tree, add a COM600 Gateway object in the Communic-

ation structure by selecting the project name.
2. Right-click the project name and select New > Communication > Gateway, see

Figure 3.2.2-1.

Continue building the object tree in the same way until you have added all the necessary
objects in your current project.

SAB600_Gateway.png

Figure 3.2.2-1 Adding COM600 Gateway object

Adding IEC 61850 OPC Server object3.2.3.

After the Gateway object has been successfully added, you can continue building the
object tree by adding an IEC 61850 OPC Server object.

To add an IEC 61850 OPC Server object:
1. Select the Gateway object in the Communication structure.
2. Right-click the Gateway object.
3. Add an IEC 61850 OPC Server object.

By using the SCL Import function, it is possible to import configurations of an entire
server or individual devices without having to insert them manually.

To open the SCL Import function:
1. Click the wanted object.
2. Select Tools > SCL Import.
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Connectivity Packages for certain protection and control devices may also support other
ways to build this structure, depending on the configuration of an individual device, for
example device-related object types and wizards. Typically, Connectivity Packages
include SCL description files which must be installed. For further information on these
Connectivity Packages, see the Connectivity Package of a certain device in the product
documentation.

You can also import the whole communication structure under IEC 61850 OPC Server
with new configurations from an existing file. The communication structure is imported
using the SCL import function. The file extensions for the import files can be .icd, .cid,
.scd, or .xml. Right-click the IEC 61850 OPC Server and select  SCL Import from the
shortcut menu, see Figure 3.2.3-1

To import a new configuration file:
1. Click  Select File.
2. Browse to a new configuration file from the appearing dialog.
3. Select the file and click Open.
4. Select the device to import from the drop-down list. You can preview the configur-

ation on the right.
5. Click  Import.

The new preconfigurated objects appear in the object tree. If the configuration file is
large, the import can take time. To import a configuration file for a different OPC Server,
right-click the OPC Server, select  SCL Import  again, and repeat the steps above.

SAB600_SCLImport_Example.png

Figure 3.2.3-1  IEC 61850 OPC Server SCL Import
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For more information about the SCL Import function, see COM600 User's Manual.

Adding IEC 61850 Subnetwork objects3.2.4.

After the server object has been successfully added, you can continue building the object
tree by adding IEC 61850 subnetwork objects.

To add an IEC 61850 subnetwork object:
1. Select an IEC 61850 OPC Server object.
2. Right-click the IEC 61850 OPC Server object.
3. Add an IEC 61850 subnetwork object.
4. Rename the new object. The names of the IEC 61850 subnetwork objects have to

be unique.

You can define one subnetwork per OPC Server.

Adding IEC 61850 IED objects3.2.5.

After adding a subnetwork you can add device objects.

To add a Device object:
1. Select a Subnetwork object.
2. Add an IEC 61850 Device (IEC 61850 IED) object.
3. Rename the new object. The names of the devices within an IEC 61850 channel

have to be unique.

The maximum number of devices per each subnetwork is 30.

With SCL import function, you can import new objects with configurations from an
existing file. Right-click the device and select SCL Import from the shortcut menu, see
Figure 3.2.3-1

To import a new configuration file:
1. Click Select File.
2. Browse to a new configuration file from the appearing dialog.
3. Select the file and click Open.
4. Select the device to import from the drop-down list. You can preview the configur-

ation on the right.
5. Click Import.

The new preconfigured objects appear in the object tree. If the configuration file is large,
the import may take time. To import a configuration file for a different device, right-
click the device, select SCL Import again and repeat the steps above.
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For more information about the SCL Import function, see COM600 User's Manual.

Configuring objects3.3.

Configuring object properties3.3.1.

After the objects have been added, you must configure the object properties.

To configure an object:
1. Select an object in the object tree of the Communication structure.
2. The object properties appear now in the Object Properties window, see Figure 3.3.1-

1. You can see the selected object on the left and the available properties on the
right.

3. Select the property you want to configure. Depending on the property value type,
configuring is always done either by
• selecting a predefined value from a drop-down combo box, or
• entering a text string or a numerical value in a text field.

SAB600_Object_Properties_Example.png

Figure 3.3.1-1  Example of object properties

The available properties for different objects are listed in the following subsections.
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Configuring IEC 61850 OPC Server properties3.3.2.

Table 3.3.2-1 lists the configurable IEC 61850 OPC Server properties and value ranges
for them. The actual configuration by using SAB600 is performed as described in
3.3.1, Configuring object properties.

Table 3.3.2-1 IEC 61850 OPC Server properties
DescriptionValue/Value rangeName

Basic

Prog ID for OPC Alarm and Event Server

(Automatically generated by management
function)

AE Prog ID

Prog ID for OPC Data Access ServerDA Prog ID

Specifies whether the d attribute (descrip-
tion) is read from the IED. Normally d is
not reported from the IED. It is only read
if read operation is requested e.g. with
Online Diagnostics. When set to false, the
text of the data object Description property
is used.

True

False

Default: False

Enable reading of d-
attribute (descrip-
tion) from IED

SNTP Client

IP address or node name for SNTP Server
(Primary)

1. Address for
SNTP Server

TCP/IP port number(1..65535)

Default: 123

1. Port Number

Time syncronization interval in seconds.
If value is 0, no time syncronization will be
done.

(0..3600)

Default: 15

1. Synchronization
Interval

IP address or node name for SNTP Server2. Address for
SNTP Server

TCP/IP port number(1...65535)

Default: 123

2. Port Number

Time synchronization interval in seconds.
If value is 0, no time syncronization will be
done.

(0..3600)

Default: 15

2. Synchronization
Interval

IP address or node name for SNTP Server3. Address for
SNTP Server

TCP/IP port number(1...65535)

Default: 123

3. Port Number

Time syncronization interval in seconds.
If value is 0, no time syncronization will be
done.

(0..3600)

Default: 15

3. Synchronization
Interval
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DescriptionValue/Value rangeName

IP address or node name for SNTP Server4. Address for
SNTP Server

TCP/IP port number(1...65535)

Default: 123

4. Port Number

Time syncronization interval in seconds.
If value is 0, no time syncronization will be
done.

(0..3600)

Default: 15

4. Synchronization
Interval

Controls if time synchronization client is
initially in use or not

True

False

Default: True

SNTP Enable Client

SNTP Server

Controls if time synchronization server is
initially in use or not

True

False

Default: True

Enable Time Syn-
chronization server

Port number for time synchronization
server

(1...65535)

Default: 123

Port Number For
Time Synchroniza-
tion Server

Communication
Control

Report Control Identity specifies, which
report control block instance is used by
the OPC Server. The value must match
with the Report Client attribute under the
Report Enabled attribute of the report
control block to be used.

To enable the IEC 61850 OPC Server to
use the specific report control blocks and
therefore receive spontaneous events, the
Report Control Identity field must match
with one of the Report enabled fields on
device’s report control block configura-
tions. This dedicates a report control
block’s specific instance from the device
to be used by the IEC 61850 OPC Server.
If the fields do not match, the configured
report control block is discarded.

Default: Client1Report Control
Identity
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DescriptionValue/Value rangeName

Specifies the default originator category
that is used for changing values and IEC
61850 control services. This can be over-
ride by OPC client for DPC control.

Control operation issued from
an operator using a client loc-
ated at station level

Control operation issued from
an unknown location

Control operation from a
remote operater outside the
substation (for example net-
work control center)

Default: Control operation
issued from an operator using
a client located at station level

Server Originator
Category

Specifies the default originator identifica-
tion that is used for IEC 61850 control
services.

Free string (max length 64
characters). For numeric values
hex code can be used (starting
with "0x" e.g. 0xABB).

Default: ABB

Server Originator
Identification

Level of system event that are sent from
the OPC Server. Amount of events sent
is cumulative, higher level also contains
lower level events. System event level
configuration at OPC Server level over-
rides definitions at subnetwork and device
levels.

Disabled

Level 1 (main operation and
errors)

Level 2 (time synchronization
errors)

Level 3 (time synchronization
done)

Level 4 (reported local updates
from devices)

Level 5 (reported unconfigured
updates from devices)

Default: Disabled

System Event Level

Configuring IEC 61850 Subnetwork properties3.3.3.

The IEC 61850 Subnetwork properties that can be configured and value ranges for them
can be found in Table 3.3.3-1. The actual configuration by using SAB600 is performed
as described in 3.3.1, Configuring object properties.

Each IEC 61850 node of the system must have a unique sub-
net/node address.
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Table 3.3.3-1 IEC 61850 Subnetwork properties
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic

Controls whether the device communica-
tion is initially in use or not

In Use

Not In Use

Default: In Use

In Use

Communication
Port

IP Address for communication channel.
Dotted decimal to be used.

127.0.0.1IP Address

Communication
Control

Level of system event that are sent from
the OPC Server. Amount of events sent
is cumulative, higher level also contains
lower-level events. System event level
configuration at OPC Server level over-
rides definitions at subnetwork and device
levels.

Disabled

Level 1 (main operation and
errors)

Level 2 (time synchronization
errors)

Level 3 (time synchronization
done)

Level 4 (reported local updates
from devices)

Level 5 (reported unconfigured
updates from devices)

Default: Disabled

System Event Level

TCP/IP Keepalive time-out in seconds(1..3600)

Default: 15

TCP/IP Keepalive
Time-out

Configuring IEC 61850 device properties3.3.4.

Table 3.3.4-1 lists the configurable properties for IEC 61850 Devices and value ranges
for these properties. The actual configuration by using SAB600 is performed as described
in 3.3.1, Configuring object properties.

Each IEC 61850 node of the system must have a unique subnet
or node address.
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Table 3.3.4-1 IEC 61850 Device properties
DescriptionValue or Value

range/ Default
Name

Basic

Controls if the device communication is initially
in use or not.

In use

Not in use

Default: In use

In Use

Defines if the device is in simulation mode.True

False

Default: False

Simulation Mode

Level of system events (OPC AE events) can
be viewed with a SAB600 Diagnostic AE client
for OPC Server or with an OPC AE client.
Amount of events sent is cumulative: higher
level also contains lower level events. System
event level configuration at subnetwork over-
rides definitions at device level. The same or
higher event level must be set for Subnetwork
as for IED.

System events can be used for debugging
and event flow monitoring, see Table 3.3.3-1.
Event level can be changed during the run
time by using the Diagnostic events level
attribute.

Level0=Dis-
abled

Level1=Level 1
(main opera-
tion, error
replies, errors)

Level2=Level 2
(information
reports, OK
replies, RCB
initializing)

Level3=Level 3
(sent requests
(connect, read,
write), transpar-
ent SPA mes-
sages)

Level4=Level 4
(reported local
updates)

Level5=Level 5
(reported
unconfigured
updates)

System Event Level

Addresses

IEC 61850 Node Number of the device127.0.0.1IP Address

IEC 61850 Subnet Number of the device23OSI ACSE AE Qualifier

OSI ACSE AP Title Value as defined in IEC
61850-8-1.

1,3,9999,23OSI ACSE AP Title Value

OSI Presentation Selector as defined in IEC
61850-8-1.

00000001OSI Presentation Selector
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DescriptionValue or Value
range/ Default

Name

OSI Session Selector as defined in IEC
61850-8-1.

0001OSI Session Selector

OSI Transport Selector as defined in IEC
61850-8-1.

0001OSI Transport Selector

Communication Control

Automatically set daylight saving time (for
SPAZC-40x only!)

True

False

Default: False

Automatically set daylight saving
time

If enabled, checks configuration revisions from
all logical devices (LDx.LLN0.NamPlt.confi-
gRev). If configuration revisions do not match
between configuration and IED, communica-
tion to the IED is not established.

True

False

Default: False

Configuration Revision Check
Enabled

Specifies whether data sets and reporting are
initialized dynamically.

Using static data sets is recommen-
ded. The IED needs to support this
feature. If enabled, all configured
data sets are created and report
control blocks configured at runtime
to the IED after connecting. The
dynamic data sets must be con-
figured with the Dataset Editor and
designated to available report con-
trol blocks. The report control
blocks must be configured and
dedicated for the IEC 61850 OPC
Server instance. Data sets used
with buffered reporting are created
once when the BRCB is first initial-
ized. Data sets used with unbuf-
fered reporting are created every
time the URCB is initialized.
Dynamic data sets are not
removed.

True

False

Default: False

Dynamically Create Data Sets

Enable reporting EntryID check. Report
EntryIDs are used as sequence numbers for
buffered reporting. A gab in sequence num-
bers caused a restart of reporting starting from
lost sequence number.

True

False

Default: False

Enable EntryID Check

Specifies the time out for MMS Request. If 0
it is not in use.

0...65535

Default: 5000

MMS Request Timeout
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DescriptionValue or Value
range/ Default

Name

Initialize to report control blocks and enable
reporting.

True

False

Default: True

Report Control Block Initialize

Enables or disables usage of 32 bit EntryIDs
for information report sequence.

The IEC 61850 standard defines 64 bit
EntryID, but e.g. SPA-ZC 40x uses 32 bit
EntryID.

True

False

Default: False

Use 32 Bit Entry ID

Enables or disables sequence number
checking information reports for the IEC
61850 OPC server.

True

False

Default: False

Use Sequence Number Check

Polling

Polling Timeout in seconds. If the device does
not support reporting, ST and MX attributes
can be polled with this interval.

(0..3600)

Default: 0 (dis-
abled)

Polling Timeout

Control Authorization

Disables interlockcheck condition check for
all select and operate controls.

True

False

Default: False

Disable Interlockcheck for All
Controls

Disables synchrocheck condition check for all
select and operate controls.

True

False

Default: False

Disable Synchrocheck for All
Controls

Specifies whether Interlock Override is suppor-
ted by this IED.

True

False

Default: False

Interlock Override Supported

OPC path of the station remote switch position
to be used with this device.

The format is #ProgID For OPC
Server#Channel Name\\IED Name\\Logical
Device Name\\Logical Node Name\\Data
Object Name

E.g. #ABB.IEC
61850_OPC_DA_Server.Instance[1]1#Chan-
nel1\\IED1\\LD1\\GGIO1\\loc

Station/Remote Switch OPC
Path
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DescriptionValue or Value
range/ Default

Name

Specifies whether Synchrocheck Override is
supported by this IED.

True

False

Default: False

Synchrocheck Override Suppor-
ted

OPC Alarm and Event

Description of area.Area Description

Specifies which area this IED belongs to.Area Name

Device Connection Status Class definition
used with current device.

Default: Device
Connection
Status

Device Connection Status Class

Specifies whether measurement limit supervi-
sion is performed by the IEC 61850 OPC
Server.

IED Based limit
supervision

OPC Server
based limit
supervision

Measurement Limit Supervision

Authentication

Is Authentication Disabled?True

False

Default: True

Is Authentication Disabled

Is Password used?True

False

Default: False

Is Password used

Password used for authentication.Default: NonePassword

SPA Access

SPA parameter for close Password.SPA parameter for Close Pass-
word

SPA parameter value for open Password.SPA value for Open Password

SPA store parameter name.SPA Store parameter name

SPA store parameter value.0...65536SPA Store parameter value

SPA value for close password.0...65536SPA Value for Close Password

SPA value for open password.0...65536SPA value for Open Password

Disturbance Recording

Specifies whether DRs are deleted from IED
after upload.

Default: FalseDisturbance Recorder Delete
Recordings

Specifies whether DR upload is enabled.Default: FalseDisturbance Recorder Enabled
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DescriptionValue or Value
range/ Default

Name

Specifies the folder where all disturbance
recordings will be stored in COM600 com-
puter. If left empty "C:\COMTRADE\IEDName"
will be used.

Disturbance Recorder Local Dir-
ectory

Specifies maximum size for folder where
uploaded DRs are locally stored for this IED.

0 -
2147483647

0: no limit

Default: 0

Disturbance Recorder Maximum
Total File Size

DR polling period in seconds0 -
2147483647

0: disabled

Default: 120

Disturbance Recorder Polling
Period

Specifies the folder where all disturbance
recordings will be stored in this IED.

Disturbance Recorder Remote
Directory

Disturbance Recording via
FTP

FTP password to be used with DR functional-
ity

Disturbance Recorder FTP
Password

FTP username to be used with DR functional-
ity

Disturbance Recorder FTP User
Name

Specifies whether DRs shall be read using
FTP.

False: MMS
(IEC 61850)

True: FTP

Default: False

Disturbance Recorder Read Via
FTP

Web Server Configuration

Specifies whether IED Web Server is
accessible from COM600 WebHMI.

True

False

Default: False

Web Server Enabled

IP Address for Web Server. Dotted decimal
or DNS name to be used. If omitted and Web
Server is enabled, IED IP Address is used.

Web Server IP Address

Configuring Logical Device properties3.3.5.

The logical devices are already configured when they are imported with IEC 61850
devices. The configurations can be monitored with viewers.
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If SPA Access is configured on the logical device object, the
logical device is shown as an own object in the COM600
WebHMI tree view. This is needed, for example, when mul-
tiple SPACOM modules are connected to a SPA-ZC 402
communication adapter.

Table 3.3.5-1 Logical Device properties
DescriptionValue or Value range/

Default
Name

Transparent SPA

The SPA address of the device connected
via TCP/IP.

By setting value >0 enables the built in
TCP/SPA client, which can be used through
the Transparent SPA attribute.

(0..999)

Default: 0

SPA Address

SPA TCP Port(1..65535)

Default: 7001

SPA TCP Port

SPA TCP Timeout in seconds(1..65535)

Default: 3

SPA TCP Timeout

Control Authoriza-
tion

Station/Remote Switch OPC Path

OPC path of the station remote switch posi-
tion to be used with this device.

The format is #ProgID For OPC
Server#Channel Name\IED Name\Logical
Device Name\Logical Node Name\Data
Object Name

E.g.
#ABB.IEC61850_OPC_DA_Server.Instance[1]#Chan-
nel1\IED1\LD1\GGIO1\loc

Station/Remote
Switch OPC Path

SPA Access

SPA parameter for close Password.SPA parameter for
Close Password

SPA parameter value for open Password.SPA value for
Open Password

SPA store parameter name.SPA Store para-
meter name

SPA store parameter value.0...65536SPA Store para-
meter value
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DescriptionValue or Value range/
Default

Name

SPA value for close password.0...65536SPA Value for
Close Password

SPA value for open password.0...65536SPA value for
Open Password

Measurement limit supervision3.3.6.

Configuring OPC-based measurement limit supervision and
units

3.3.6.1.

Typically measurement limit value supervision is done by the IEC 61850 IED with the
specified LNs. If the IED does not support limit value supervision or does not provide
units for the measurements, it is possible to configure the OPC server instead to handle
the limit value supervision and to publish units for the measurements to realize a common
IEC 61850 substation supervision functionality for the 800xA operator workplaces.
Supervision mode (IED or OPC) can be configured with the Measurement Limit Super-
vision property of the IEC 61850 device for each IED. If the IED based supervision
mode is selected, the limit values can be configured with the properties described in the
following sections.

The data objects MV, CMV, SEQ, DEL and WYE support measurement limit supervision.
MV, CMV, SAV, SEQ, DEL and WYE measurement data objects support overriding
unit and multiplier information.

Configuring MV properties3.3.6.2.

Table 3.3.6.2-1 Configurable limit supervision properties for the MV object
TypeProperty

[060] Limit Value Supervision

floatHigh

floatHigh-High

floatLow

floatLow-Low

floatMax

floatMin

[050] Scale and Unit

EnumSI Unit
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TypeProperty

EnumMultiplier

Configuring CMV properties3.3.6.3.

Table 3.3.6.3-1 Configurable limit supervision properties for the CMV object
TypeProperty

[060] Limit Value Supervision

floatHigh

floatHigh-High

floatLow

floatLow-Low

floatMax

floatMin

[050] Scale and Unit

EnumSI Unit

EnumMultiplier

Configuring SAV properties3.3.6.4.

Table 3.3.6.4-1 Configurable limit supervision properties for the SAV object
TypeProperty

[050] Scale and Unit

EnumSI Unit

EnumMultiplier

Configuring SEQ properties3.3.6.5.

Table 3.3.6.5-1 Configurable limit supervision properties for the SEQ object
TypeProperty

[060] C1 Limit Value Supervision

floatHigh

floatHigh-High

floatLow
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TypeProperty

floatLow-Low

floatMax

floatMin

[060] C2 Limit Value Supervision

floatHigh

floatHigh-High

floatLow

floatLow-Low

floatMax

floatMin

[060] C3 Limit Value Supervision

floatHigh

floatHigh-High

floatLow

floatLow-Low

floatMax

floatMin

[050] Scale and Unit

EnumC1 SI Unit

EnumC1 Multiplier

EnumC2 SI Unit

EnumC2 Multiplier

EnumC3 SI Unit

EnumC3 Multiplier

Configuring DEL properties3.3.6.6.

Table 3.3.6.6-1 Configurable limit supervision properties for the DEL object
TypeProperty

[060] Limit Value Supervision

floatHigh

floatHigh-High

floatLow

floatLow-Low
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TypeProperty

floatMax

floatMin

[050] Scale and Unit

EnumPhase SI Unit

EnumMultiplier

Configuring WYE properties3.3.6.7.

Table 3.3.6.7-1 Configurable limit supervision properties for the WYE object
TypeProperty

[060] Phase Limit Value Supervision

floatHigh

floatHigh-High

floatLow

floatLow-Low

floatMax

floatMin

[060] Net Limit Value Supervision

floatHigh

floatHigh-High

floatLow

floatLow-Low

floatMax

floatMin

[060] Neut Limit Value Supervision

floatHigh

floatHigh-High

floatLow

floatLow-Low

floatMax

floatMin

[060] Res Limit Value Supervision

floatHigh

floatHigh-High
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TypeProperty

floatLow

floatLow-Low

floatMax

floatMin

[050] Scale and Unit

EnumPhase SI Unit

EnumPhase Multiplier

EnumNeut SI Unit

EnumNeut Multiplier

EnumNet SI Unit

EnumNet Multiplier

EnumRes SI Unit

EnumRes Multiplier

Viewing data object configuration3.3.7.

IEC 61850 OPC Server supports data objects for status, measurand, controllable status,
and controllable analog information. IEC 61850 OPC Server supports 28 data object
types for an IEC 61850 device. The data objects are already configured when they are
imported with IEC 61850 devices. The configurations can be monitored with viewers.

Data classes for status information:
• Single point status (SPS)
• Double point status (DPS)
• Enumeration status (ENS)
• Integer status (INS)
• Protection activation information (ACT)
• Directional protection activation information (ACD)
• Security violation counter (SEC)
• Binary counter reading (BCR)

Data classes for measurand information:
• Measured value (MV)
• Complex measured value (CMV)
• Sampled value (SAV)
• WYE
• Delta (DEL)
• Sequence (SEQ)

Data classes for controllable status information:
• Controllable single point (SPC)
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• Controllable double point (DPC)
• Controllable enumerated status (ENC)
• Controllable integer status (INC)
• Binary controlled step position information (BSC)
• Integer controlled step position information (ISC)

Data classes for controllable analog information:
• Analog set point (APC)

Data objects classes for status settings:
• Single setting point (SPG)
• Integer status setting (ING)

Data classes for analogue settings:
• Analogue setting (ASG)
• Setting curve (CURVE)

Data classes for description information:
• Device name plate (DPL)
• Logical Node name plate (LPL)

Data classes for internal status information:
• Integer status (Internal INS)
• Single point status (Internal SPS)
• Controllable single point (Internal SPC)

The parameters are stored in object properties in SAB600. The actual configuration for
data objects is not supported.

Configuring report control blocks3.3.8.

A report control block (RCB) controls the spontaneous event reporting, and the client
can modify report sending behavior by setting RCB attributes. Buffered Report Control
Blocks (BRCB) and Unbuffered Report Control Blocks (URCB) are supported RCBs.

For BRCB, events issue immediate sending of reports or buffer the events for transmis-
sion, such that data values are not lost due to transport flow control constraints or loss
of connection. For URCB, events issue immediate sending of reports on a best efforts
basis. If no association exists or if the transport data flow is not fast enough to support
it, events may be lost.

To allow multiple clients to receive the same data values, multiple instances of the report
control classes must be made available. Report Enabled and Report Client definitions
are used to specify RCB instances to clients. Report Enabled shows the maximum
number of available RCB instances, and Report Client dedicates an instance to a client
(see Report Control Identity in Table 3.3.2-1). All configured RCBs without IEC 61850
OPC Server specified instances are discarded.
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Report Clients’ order specifies the RCB instance used and the RCB name. IEC 61850
OPC Server builts the RCB instance name to type RCBName<xx>. Each RCB instance
takes on the values from 01 to 99 as <xx>, for example the first Report Client uses
RCBName01. The naming convention can also be overridden by removing the Report
Enabled element. Now the RCBName is used as it is.

The control attribute values are received from the imported device configuration. Some
values can be overridden with the IEC 61850 OPC Server configuration.

• Buffer Time
Controls the time interval in milliseconds when the BRCB buffers the events for
inclusion into a single report. Overridable.

• Buffered
Controls RCB to buffered (true) or unbuffered (false). Must be true for BRCB.

• Configuration Revision
Represents the number of times that the configuration of the RCB has changed.

• Data Set
Specifies the data set being monitored and what values are reported.

• Integrity period
If this is set to integrity (>0), it indicates the period in milliseconds used for gener-
ating an integrity report. An integrity report reports the values of all members of the
related data set. Overridable.

• Report ID
Report identifier is the BRCB’s client-specified report identifier. Report identifier
generates the report.

• Option Fields
Client specified optional fields included in the report issued by BRCB. This attribute
defines the optional header fields’ subset of the report that are included in the report.
Refer to IEC 61850-7-2 and IEC 61850-8-1 standards. The IEC 61850 OPC Server
uses a default value for option fields to receive the necessary information for event
updates and event flow control (cannot be overridden): BRCB (Sequence Number,
Reason Code, Buffer Overflow, Entry ID), URCB (Sequence Number, Reason
Code). Overridable.

• Trigger Options
Specifies the trigger conditions which BRCB monitors. The following values are
defined: Data Change(dchg), Quality Change(qchg), Data Update(dupd), Period.

Buffer time and Integrity period are overridable. Option fields are also overridable,
except the default values that IEC 61850 OPC Server uses to receive the necessary
information for event updates and event flow control.
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IEC 61850 data publishing3.4.

About data sets3.4.1.

A data set is an ordered group of data objects and data attributes organized as a single
collection for the convenience of the client. Data sets are used to define the values of
data to be transmitted in case a value of a data set member changes. A data set is used
for reporting and GOOSE messaging.

Configuring data sets3.4.2.

Dataset Editor3.4.2.1.

A data set groups selected data so that a client can access it easily with a single read
operation. A data set is also used for event reporting; data is linked to spontaneous event
sending only via report control blocks (RCB) data set definition. The client reads other
data separately. Data set definitions are located always under the logical device LD0 and
logical node LLN0.

The data set can be modified with the Dataset Editor. Open the Dataset Editor by right-
clicking the Dataset object and selecting Dataset Editor.

The Dataset object has a set of data attributes:
• IdInst: Instance of Logical Device to which the referenced data set belongs.
• Prefix: Freely configurable part of LN caption.
• InInst: Instance of the LN type.
• InClass: Logical node class.
• doName: Name of the data object from which the data set is formed.
• daName: Name of the data attribute from which the data set is formed.

Data attributes are collected to the data set in groups, and the functional constraint
defines the data attributes.

• fc: functional constraint
Functional constraint divides data attributes, which have the same functional con-
straint, to groups under the same data object. For example, functional constraint ST
(status information) groups stVal, q and t data attributes to the data set.

The caption in the object tree consists of Prefix, InClass and InInst values.

About data reporting3.4.2.2.

Data changes are used as a trigger for reporting. This information is grouped using a
data set. The data set is the content basis for reporting. Reporting uses information reports
to transmit data. The data configured in a data set is transmitted in information reports.
Reporting is controlled by report control blocks.
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Report control block3.4.2.3.

Report control describes the conditions for generating information reports based on
parameters set by configuration or by a client. Report Control Blocks control the proced-
ures that are required for reporting values of data from logical nodes to one client.

There are buffered and unbuffered report control blocks:
• In a Buffered Report Control Block (BRCB) internal events issue immediate

sending of reports, or buffer the events for transmission. This way the values of a
data object are not lost due to transport flow control constraints or loss of connection.
BRCB provides sequence-of-events functionality.

• In an Unbuffered Report Control Block (URCB) internal events issue immediate
sending of reports on a best efforts basis. If no association exists, or if the transport
data flow is not fast enough to support it, events may be lost.

SAB600_Proxy_RCB_Properties.png

Figure 3.4.2.3-1 Report control block properties

Table 3.4.2.3-1 Report Control Block object properties
DescriptionValue or value range/DefaultProperty/Parameter

Basic

With this value, RCB can be
configured to wait for other
events after the first change
before sending the report.
Value 0 means that a new
change is immediately reported
to the client. Configurable.

Default: 0 millisecondsBuffer Time
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DescriptionValue or value range/DefaultProperty/Parameter

Controls if the RCB is buffered
or unbuffered.

True

False

Default: True

Buffered

Configuration revision of the
data set referenced by this
RCB. Every modification in the
data set increases the Configur-
ation Revision property by one.

0...2147483647Configuration Revision

The name of the data set to be
sent by the report control block.

Data Set

Indicates if this RCB is con-
figured with indexed naming
convention.

True

False

Default: True

Indexed

Integrity period in milliseconds.
If this attribute has a value > 0
ms, an integrity report with all
data listed in the data set is
sent periodically in this interval.
By default, this feature is not
enabled, because it generates
an unnecessary load to the
server and network. If this fea-
ture is used, the Trigger Option
‘Period’ in RCB needs to be
enabled. Configurable.

0...214748647

Default: 0

Integrity period

Used as identification in
information reports to specify
that the report is from this RCB.
By default report control block
MMS path name is used. Con-
figurable.

Report ID

Defines what information is
sent with the information report.
Configurable.

Option Fields

Config ReferenceTrue

False

Default: False

Config Reference

Data RefTrue

False

Default: False

Data Ref
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DescriptionValue or value range/DefaultProperty/Parameter

Data SetTrue

False

Default: False

Data Set

Entry IDTrue

False

Default: True

Entry ID

Reason CodeTrue

False

Default: True

Reason Code

Sequence NumberTrue

False

Default: True

Sequence Number

Time StampTrue

False

Default: False

Time Stamp

Defines the triggering condi-
tions for creating reports.

Trigger Options

Specifies whether a report
entry shall be generated due to
a change of the value of the
data attribute.

True

False

Default: True

Data change

Specifies whether a report
entry shall be generated due to
freezing the value of an
unfreezable attribute or updat-
ing the value of any other
attribute. An updated value
may have the same value as
the old value.

True

False

Default: False

Data Update

Specifies whether a report
entry shall be generated on the
expiration of the integrity
period.

True

False

Default: False

Period

Specifies whether a report
entry shall be generated due to
a change of the value of the
quality attribute.

True

False

Default: True

Quality Change
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Configuring reporting3.4.2.4.

Some IEDs require that reporting is configured manually.

To configure reporting:
1. Create and configure a Data Set object.

SAB600_DataSet.png

Figure 3.4.2.4-1 Creating a new data set

2. Create a Report Control Block object.
3. Add a Report Enabled object. Add a ReportClient object for each IEC 61850

client. ReportClients create the same amount of instances of the RCB, each dedicated
for one client.

SAB600_ReportClient.png

Figure 3.4.2.4-2 Adding ReportClient objects

4. Configure the report control block.
5. Configure the data set of the report control block.

56

1MRS758689COM600 series 5.1

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



SAB600_RCB_Properties_DataSet.png

Figure 3.4.2.4-3 Configuring data set of the report control block

Configuring GOOSE Analyzer3.5.

Configuring the GOOSE Analyzer using the Configuration Wizard3.5.1.

GOOSE Analyzer must be configured through the Configuration Wizard for the IEC
61850 OPC Server.

Before you start,

• build and configure the object tree as specified in 3.2, Building object tree and
3.3, Configuring objects, and

• open the management tool to connect to the remote COM600 device for accessing
the Network Interface Card (NIC) information of COM600 to the local SAB600
computer for the configuration.
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To configure the GOOSE Analyzer:
1. Right-click the IEC 61850 OPC Server to open its specific context menu (see Fig-

ure 3.5.1-1).

SAB600_GA_Configuration.png

Figure 3.5.1-1  GOOSE Analyzer configuration

2. Select GA Configuration Wizard to open the wizard dialog (see Figure 3.5.1-2).
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SAB600_GA_Configuration_Wizard.png

Figure 3.5.1-2 Wizard dialog

3. Click Next.
4. Configure the properties (see Figure 3.5.1-3). The descriptions for properties are

listed in Table 3.5.2-1.
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SAB600_GA_Configuration_Wizard_Properties.png

Figure 3.5.1-3  Parameter Setting

5. Click Finish to start the analysis and generate the corresponding GOOSE Analyzer
configuration.
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SAB600_GA_Configuration_Wizard_Generate.png

Figure 3.5.1-4 GOOSE Analyzer Generating Configuration

The user must run the GAT Server Config utility in the
COM600 computer after the IP-address is changed.

Configuring GOOSE Analyzer properties3.5.2.

Table 3.5.2-1 lists the configurable GOOSE Analyzer properties and value ranges.

Table 3.5.2-1 GOOSE Analyzer properties
DescriptionValue/Value rangeName

Enable/Disable the analysis of
specific sub-network

Enable/DisableEnable

Duration to do the calculations.1...100 min

Default: 10

Statistic interval

Enable or disable the storing of
analogue GOOSE.

True/FalseStore analogue GOOSE

61

COM600 series 5.11MRS758689

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



DescriptionValue/Value rangeName

Maximum record size for
GOOSE Tester.

100...500 Mb

Default: 300 Mb

Max. record size

Editing GOOSE connection3.5.3.

After the GOOSE Analyzer is configured with the Configuration Wizard, you can
use the GOOSE Connection Editor tool.

To view and edit the GOOSE connections:
1. Right-click the IEC 61850 OPC Server to open its specific context menu (see Fig-

ure 3.5.1-1).
2. Select GOOSE Connection Editor to open the tool (see Figure 3.5.3-1).

GSAB600_GOOSE_Connection_Editor.png

Figure 3.5.3-1 GOOSE Connection Editor

3. Select different connection diagrams using the navigation tree on the left.
4. Make changes to the active diagram including moving the graph, modifying proper-

ties, and adding new graphs and texts. The default IED picture can be replaced from
the properties window.

5. Click Save to save your changes.
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Configuring condition monitoring and protection
related applications

3.6.

3.6.1 Prerequisites3.6.1.

• PCM600 2.8 32-bit with HF1 is needed for configuring condition monitoring and
protection related applications to COM600 device.

• COM600 connectivity package 5.0 is needed for COM600 IED object creation in
PCM600.

• SAB600 5.0 is needed for configuring OPC Server for condition monitoring and
protection related applications.

Condition monitoring and protection related applications are
available only in COM600S IEC product.

Configuring condition monitoring and protection related
applications in PCM600

3.6.2.

PCM600 is used for configuration of condition monitoring and protection related
applications and writing those to COM600 device. Condition monitoring and protection
related applications must be configured through the COM600 IED Configuration Wizard
in PCM600.

1. Create COM600 IED under Substation object.

63

COM600 series 5.11MRS758689

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



COM600_IED_PCM600.png

Figure 3.6.2-1 COM600 IED object creation in PCM600

2. Select Online Configuration or Offline Configuration mode for creating COM600
IED in COM600 IED Configuration Wizard.

COM600_IED_Wizard_ModeSelection.png

Figure 3.6.2-2 COM600 Configuration Wizard Mode Selection Page in PCM600

3. Select IP address for COM600 device.
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COM600_IED_Wizard_Communication.png

Figure 3.6.2-3 COM600 Configuration Wizard Communication Page in PCM600

4. Verify the order code of COM600 device. In online mode order code is read from
COM600 device if a connection to the device is available. In offline mode order
code should be set as it is in COM600 device.
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COM600_IED_Wizard_OrderCode.png

Figure 3.6.2-4 COM600 Configuration Wizard Order Code Page in PCM600

5. Select the applications for the IEDs. If the IED does not support the application, the
table cell is not selectable and mouse-over shows the reason why the application is
not supported.
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COM600_IED_Wizard_ApplicationSelection.png

Figure 3.6.2-5 COM600 Configuration Wizard Application Selection Page in PCM600

6. Select COMTRADE and IEC 61850 inputs for IEDs.
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COM600_IED_Wizard_Inputs.png

Figure 3.6.2-6 COM600 Configuration Wizard IO Configuration Page in PCM600

7. Click Finish to finalize COM600 IED configuration.
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COM600_IED_Wizard_Complete.png

Figure 3.6.2-7 COM600 Configuration Wizard Setup Complete Page in PCM600

8. Right click COM600 and select Write to IED to write the COM600 IED configur-
ation to COM600 device.
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COM600_IED_Write_PCM600.png

Figure 3.6.2-8 COM600 Configuration writing in PCM600

9. To export the SCD file from the Substation object, select Export. The exported
SCD file is used in SAB600 to configure the OPC Server for condition monitoring
and protection related applications.
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COM600_IED_Export_PCM600.png

Figure 3.6.2-9 COM600 Configuration exporting in PCM600

Configuring condition monitoring and protection related
applications in SAB600

3.6.3.

SAB600 is used for configuration of OPC Server for condition monitoring & protection
related applications. This OPC Server configuration must be done through COM600
Configuration Wizard.

SCD file exported in PCM600 for condition monitoring and
protection related applications cannot be imported using OPC
Server object’s SCL Import function because OPC Server
parameters needed for condition monitoring and protection
related applications are set correctly only in COM600 Config-
uration Wizard.

To configure condition monitoring & protection related applications in SAB600:
1. Create new project in SAB600.
2. fill IP address and Port number for COM600 device in COM600 Configuration

Wizard.
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SAB600_Wizard_Communication.png

Figure 3.6.3-1 COM600 Configuration Wizard Communication Page

3. Set order code of COM600 device or read it from COM600 device or from license
file. Notice that the order code defined here should match to license in COM600
device.

72

1MRS758689COM600 series 5.1

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



SAB600_Wizard_OrderCode.png

Figure 3.6.3-2 COM600 Configuration Wizard Product Selection Page

4. Select SCD file exported from PCM600 to be imported as first IEC 61850 OPC
Server.
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SAB600_Wizard_Server.png

Figure 3.6.3-3 COM600 Configuration Wizard Server Page

5. Add Offside OPC server as underneath 61850 OPC server.
6. Select same SCD file exported from PCM600 to be imported as Product Specific

Server.
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SAB600_Wizard_ProductSpecific.png

Figure 3.6.3-4 COM600 Configuration Wizard Product Specific Server Page

7. Click Finish to finalize COM600 configuration.

COM600 Configuration Wizard may contain other pages
also, like other OPC Server and OPC Client pages,
depending on COM600 order code but pages mentioned
here are mandatory for configuring condition monitoring
and protection related applications.
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SAB600_Wizard_Complete.png

Figure 3.6.3-5 COM600 Configuration Wizard Summary Page

8. Upload configuration to COM600 device using Management tool.
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SAB600_Upload_Management.png

Figure 3.6.3-6 COM600 Configuration uploading to COM600 device

Consistency check of condition monitoring and protection
related applications

3.6.4.

The consistency of applications is checked when uploading a condition monitoring and
protection related configuration to COM600 device in SAB600. If applications are not
consistent, the message shown in Figure 3.6.4-1 is shown.
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SAB600_ConsistencyCheck.png

Figure 3.6.4-1 Condition monitoring and protection related applications consistency checking

This means that configuration revisions in SCD file, imported to SAB600, and in COM600
device are not consistent. This can happen for example if SCD file is exported in PCM600
before configuration is written to COM600 device in PCM600, so configuration revision
in COM600 device is higher than in SCD file.

Viewing condition monitoring and protection related applications
reports in COM600

3.6.5.

To view the condition monitoring and protection related application reports in COM600
WebHMI, select Reports in the Substation tree.
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COM600 WebHMI_reports.png

Figure 3.6.5-1 Condition monitoring and protection related applications reports

Click View to view the details of a specific report.

COM600 WebHMI_report_details.png

Figure 3.6.5-2 Condition monitoring and protection related applications report details
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IEC 104 OPC server configuration4.

About this section4.1.

This section guides you in the configuration tasks required before you can start using
the IEC104 OPC Server. For information on the IEC 61850 data modeling, refer to
COM600 User's Manual.

Start SAB600 to open and name a project.

1. Select File > Open/Manage Project....
2. In the Open/Manage Project dialog, select the required location for the project:

• Projects on my computer
• Projects on network

3. Select New Project on the left.
• Enter a Project Name. The Description is optional.

4. Click Create.
5. Click Open Project.

Overview of configuration4.2.

Before you can start using the IEC104 OPC Server, build and configure an object tree
in SAB600 to define the Communication structure.

The possible objects are:

• Gateway
• IEC104 OPC Server
• IEC104 Channel
• IEC104 IED
• Logical Device objects
• Logical Node objects
• Data objects

Figure 4.2-1 shows an example view of SAB600 including an object tree in the commu-
nication structure on the left and Object Properties window displaying the object properties
on the right.

When configuring OPC servers the following characters cannot
be used in object names: \ ` ' ' #
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SAB600_IEC104_Example_View.png

Figure 4.2-1 Example view of SAB600

The configuration work can basically be divided into two separate tasks:
1. building an object tree, and
2. configuring object properties.

First, build an object tree by adding objects to the object tree, see 4.3.1, General
information about building object tree and 4.3.8, Adding data objects. Connectivity
Packages for certain Protection and Control products usually contain preconfigurations
and tools to facilitate the building of the object tree.

Figure 4.2-1 shows an example of how the object tree looks like after it has been built.
In the example tree, you can see the IEC104 OPC Server object and its child objects like
channels, devices, and data objects. Indentation is used to indicate the parent-child rela-
tionship between the objects.

After you have added the necessary objects to the object tree in the communication
structure, configure them. See 4.4.1, General information about configuring objects.

Table 4.2-1 describes the objects shown in the object tree (Figure 4.2-1).

Table 4.2-1 IEC104 Server-related objects
DescriptionObject

An object representing the IEC104 OPC Server.IEC104 OPC Server

An object representing a physical communication
channel. You can define up to three channels per OPC
server.

IEC104 Channel
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An object representing a physical device. You should
not have more than 30 devices per each channel.

IEC104 IED

An object representing a group of functions. Each func-
tion is defined as a Logical Node. A physical device
consists of one or several LDs.

Logical Device (LD)

An object defined by its data and methods. LN is the
smallest part of a function that exchanges data.

Logical Node (LN)

Data object is an instance of one of the IEC 61850 Data
Object Classes such as Single point status and Meas-
ured Value. Depending on the class, each data object
has a set of attributes for monitoring and controlling the
object, for example, value, quality, and control.

Data Object (DO)

Building object tree4.3.

General information about building object tree4.3.1.

The object tree is built in the Communication structure of the SAB600, see Figure 4.2-
1. It is built by adding objects in a logical order starting from the Gateway.

You have several possible ways to add objects to the object tree:
• You can right-click the object to which you want to add a child object. Select New

> Object type group > Object name, for example,  New > IEC104 > IED
• You can right-click the object type and select New > New. A New Object window

appears. Select the object type you want to add and click OK or double-click it.
• You can copy the object.

Add the objects in the following order:
1. Gateway
2. IEC104 OPC Server
3. IEC104 Channel
4. IEC104 Device
5. Logical Device objects
6. Logical Node objects
7. Data objects

For information on building a substation structure, refer to COM600 HMI Configuration
Manual.

Adding Gateway object4.3.2.

To start building the object tree, add a Gateway object in the Communication structure
by selecting the project name, right-click it and select New > Communication > Gate-
way.
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Adding IEC104 OPC Server object4.3.3.

After the Gateway object has successfully been added, you can continue building the
object tree by adding an IEC104 OPC Server object.

To add an IEC104 OPC Server object:
1. Select the Gateway object in the communication structure and right-click it.
2. Add an IEC104 OPC Server object.

By using the SCL Import function, it is possible to import an entire server's or individual
device's configurations without having to insert them manually. To open the SCL Import
function, right-click the desired object, and select SCL Import.

For more information about the SCL Import function, see COM600 User's Manual.

Connectivity Packages for certain protection and control devices can also support other
ways to build this structure, depending on the configuration of an individual device, for
example device-related object types and wizards. Typically, Connectivity Packages
include SCL description files which must be installed. For further information on these
Connectivity Packages, see the Connectivity Package of a certain device in the product
documentation.

Adding IEC104 Channel objects4.3.4.

To add an IEC104 Channel object:
1. Select an IEC104 OPC Server object and right-click it.
2. Add an IEC104 Channel object.
3. Rename the new object. The names of the IEC104 Channels have to be unique.

Adding IEC104 Device objects4.3.5.

To add an IEC104 Device object:
1. Select an IEC104 Channel object and right-click it.
2. Add an IEC104 Device object
3. Rename the new object. The names within IEC104 Devices within an IEC101 OPC

Server have to be unique.

Adding Logical Device objects4.3.6.

To add a Logical Device object:
1. Select an IEC104 Device object and right-click it.
2. Add a Logical Device object.
3. Rename the new object. The names of the Logical Device objects have to be unique.
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You should have at least one Logical Device object as a child
object to each IEC104 physical device.

Adding Logical Node objects4.3.7.

To add a Logical Node:
1. Select a Logical Device object and right-click it.
2. Add a Logical Node object.
3. Rename the new object. The names of the Logical Node objects have to be unique.

You should have only one Logical Node 0 (LLN0) as a child
object to a Logical Device object.

Adding data objects4.3.8.

To add a data object:
1. Select a Logical Node object and right-click it.
2. Add a data object.
3. Rename the new object. The names of the data objects have to be unique.

Configuring objects4.4.

General information about configuring objects4.4.1.

After the objects have been added, configure the object properties. Figure 4.4.1-1 shows
an example of how to use SAB600 to configure the object properties for a IEC104 device.

To configure an object:
1. Select an object in the object tree of the communication structure.

a. The object properties appear now in the Object Properties window. The proper-
ties and their values can be viewed as shown in Figure 4.4.1-1
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SAB600_IEC104_Object_Properties_Example.png

Figure 4.4.1-1 Example of object properties in the Objects Properties window

2. Select the property you want to configure. Depending on the property value type,
configuring is always done either by
• selecting a predefined value from a drop-down menu, or
• entering a text string or a numerical value in a text field.

The available properties for different objects are listed in the following subsections.

IEC104 OPC Server properties4.4.2.

Table 4.4.2-1 lists the IEC104 OPC Server properties, their value ranges, defaults, and
descriptions. These properties are not configurable.
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Table 4.4.2-1 IEC104 OPC Server properties
DescriptionValue or Value range/ DefaultName

Basic

Instance identification of diagnostic OPC
alarm and event server.

Default: NoneProg ID AE

Instance identification of diagnostic OPC
data access server.

Default: NoneProg ID DA

Configuring IEC104 Channel Properties4.4.3.

The IEC104 Channel properties that can be configured and value ranges for them can
be found in Table 4.4.3-1. The actual configuration by using SAB600 is performed as
described in 4.4.1, General information about configuring objects.

Table 4.4.3-1 IEC104 Channel properties
DescriptionValue or Value range/ DefaultProperty / Para-

meter

Basic

Specifies whether the channel is initially
in use or not.

In use

Not in use

Default: In use

In Use

ProtocolIEC60870-5-104 MasterProtocol

Communication
Control

Time interval for communication test
messages in seconds.

0...65535

Default: 20

Communication
Test Interval

Defines the timeout of the TCP Connect
operation in milliseconds. This is meaning-
ful especially in multidrop configurations,
since no other device is served while the
master is connecting to an unconnected
device. The value depends on the network
structure and load, device count, etc. The
value should be defined together with the
value of the IED's Reconnecting Timeout.
Value 0 means that a blocking Connect is
used. In this case, the used timeout value
depends on the TCP/IP stack implement-
ation.

0...65535Connect Timeout

Timeout in seconds for send or test
APDUs. If no response is received within
this timeout, the connection will be closed.

0...255

Default: 15

Response Timeout
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DescriptionValue or Value range/ DefaultProperty / Para-
meter

Communication
Port

The IP Address which is locally used in
COM600.

Default: 127.0.0.1Local Address

Configuring IEC104 Device properties4.4.4.

Table 4.4.4-1 lists the configurable properties for IEC104 Device and value ranges for
these properties. The actual configuration by using SAB600 is performed as described
in 4.4.1, General information about configuring objects.

Table 4.4.4-1 IEC104 Device properties
DescriptionValue/Value rangeName

Basic

Specifies whether diagnostic
AE events are sent for the sta-
tion or not.

True

False

Default: False

Diagnostics Enabled

Controls if station communica-
tion is initially in use or not.

In use

Not in use

Default: In use

In Use

Specifies whether the device is
in simulation mode.

True

False

Default: False

Simulation Mode

Addresses

The IP address or the host
name of the remote host. Port
number can be configured by
using semicolon (GW 4.0 or
newer). For example,
"127.0.0.1;8080".

127.0.0.1Internet Address
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DescriptionValue/Value rangeName

The station address of the IEC
60870-5-104 slave station, the
common address of ASDU in
an IEC message.

0...255 or 0...65535

Default: 1

The maximum value depends
on the corresponding Station
Address Length property value
as follows:

• when Station Address
Length property value is 1,
the value range for the
Information Address is
0...255 and

• when Station Address
Length property value is 2,
the value range for the
Station Address is
0...65535

Station Address

Communication Control

The timeout for sending an
acknowledgement if the
amount of APDUs defined by
the Unacknowledge Receive
property is not received.

0...100

Default: 10

Acknowledge Timeout

The maximum time the IEC
master station waits for an
activation confirmation mes-
sage from the IEC slave.

0...255

Default: 10

Activation Reply Timeout

The maximum time the IEC
master station waits for an
activation termination message
from the IEC slave.

0...255

Default: 60

Activation Termination Timeout

The waiting of the activation
termination message. With
value false, the timer length
defined with the CT attribute is
not started. False is needed
with some IEC60870-5-104
slave implementations, which
do no send activation termina-
tion messages at all.

True

False

Default: True

Activation Termination waited
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DescriptionValue/Value rangeName

Sending of the general interrog-
ation command when the mas-
ter gets the zero (OK) status.
When this is false, a general
interrogation command is
always sent when the object
status of the IEC master station
gets the value zero, e.g. when
set in use or after a suspen-
sion. When this is true, general
interrogation is not sent auto-
matically at zero status.

True

False

Default: False

Disable automatic GI sending
during communication initializa-
tion

Sending of the general interrog-
ation command when the mas-
ter receives ASDU 70. When
this is false, a general interrog-
ation command is always sent
when the end of initialization
message (ASDU 70) is
received from the IEC slave.
When this is true, general
interrogation is not sent auto-
matically when receiving ASDU
70.

True

False

Default: False

Disable Sending GI when
master gets ASDU 70

Private ASDU handling. When
this is true, the private range
ASDUs 146, 148 and 160 are
handled as unknown ASDUs.
Thus, the contents of these
ASDUs are sent to a bitstream
process object if the Unrecog-
nized Command Handling is
set to true.

True

False

Default: False

Enable private ASDU handling

The interval of reconnecting
attempt while communication
is not established.

0...255

Default: 30

Reconnecting Timeout

The maximum number of
APDUs that are received
without acknowledging them to
the remote host.

0...65535

Default: 8

Unacknowledge Receive

The maximum number of
APDUs sent without receiving
acknowledgment from the
remote host.

0...65535

Default: 12

Unacknowledge Send

Command Handling
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DescriptionValue/Value rangeName

Parallel commands. When this
is true, the sending of parallel
commands is possible. The
control is returned immediately
back to application and the
return status of command must
be checked from the command
termination process object.
When this is false, sending
another command is not pos-
sible before the previous com-
mand has been completed or
the confirmation timeout has
occurred.

True

False

Default: False

Enable parallel commands

Lengths

The length of the information
object address in octets.

1 = 0...255,

2 = 0...65535

3 = 0...16777215

1...3

Default: 3

Information Address Length

The length of the Cause Of
Transmission field in an IEC
60870-5-104 message.

1...2

Default: 2

Length of Cause of Transmis-
sion

The maximum length of trans-
mitted message in octets.

20...255

Default: 230

Maximum Message Length

The length of the station
address in octets.

1...2

Default: 2

Station Address Length

Time Handling

The hour transmission method
of the events to the master.
When this is false, the master
gets the year, date, and hour
from the slave as hourly clock
synchronization (ASDU 103).
When this is true, the master
adds the year, date, and hour
from its internal clock to the
events. Minutes and seconds
should be provided in time-
tagged events by the slave.

True

False

Default: False

Disable Hour Change Clock
Message

Time synchronization interval
in seconds.

0...65535

Default: 0

Time Synchronization Interval

OPC Alarm and Event
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DescriptionValue/Value rangeName

Device Connection Status
Class is used for device connec-
tion status conditions.

Device Connection StatusDevice Connection Status
Class

Configuring data objects4.4.5.

Directional protection activation information (ACD)4.4.5.1.

Table 4.4.5.1-1 Configurable ACD properties for OPC servers
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic

Common data class according to IEC
61850.

ACDCommon Data
Class

Addresses

IEC Address for general indication.0...16777215

Default: 0

General Address

IEC Address for neutral (0 = Not in use).0...16777215

Default: 0

Neutral Address

IECAddress for phase A (0 = Not in use).0...16777215

Default: 0

Phase A Address

IEC Address for phase B (0 = Not in use).0...16777215

Default: 0

Phase B Address

IEC Address for phase C (0 = Not in use).0...16777215

Default: 0

Phase C Address

OPC Alarm and
Event

Indication event used with general phase.Indication Event for
General

Indication event used with neutral phase.Indication Event for
Neutral

Indication event used with phase A.Indication Event for
Phase A

Indication event used with phase B.Indication Event for
Phase B

Indication event used with phase C.Indication Event for
Phase C
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Protection activation information (ACT)4.4.5.2.

Table 4.4.5.2-1 Configurable ACT properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

ACTCommon Data
Class

Addresses

General Index0...65535

Default: 0

General Index

Neutral Index0...65535

Default: 0

Neutral Index

Phase A Index0...65535

Default: 0

Phase A Index

Phase B Index0...65535

Default: 0

Phase B Index

Phase C Index0...65535

Default: 0

Phase C Index

Common

Class of ASDU. Data sent from the slave
to the master can be assigned to four
classes. Data in class 1 is sent with higher
priority than data in class 3.

Class 0...3

Default: Class 0

Class

Maximum update rate of signal state
changes between the OPC server and
client in milliseconds. 0 means that the
server sends all the changes to the client.

0...65535

Default: 0

Update Rate

Data Class Spe-
cific

Object number for indication.Binary input (1, 2)

Binary output (10)

Default: Binary input (1, 2)

Indication Object

Defines if all changes in value are sent to
the master.

True

False

Default: False

Send All Updates
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Defines if a value is sent as double point.True

False

Default: False

Send As Double
Point

Defines if the value of a message is
inverse.

True

False

Default: False

Send As Inverse
Value

Specifies the type of the timestamp a
message is sent with.

Send as static data (always
without time)

Event without time

Event with time

Event with relative time (valid
for binary inputs only)

Default: Event with time

Time And Type
Variation

Analogue set point (APC)4.4.5.3.

Table 4.4.5.3-1 Configurable APC properties for OPC servers
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

Common Data Class according to IEC
61850.

APCCommon Data
Class

Addresses

IEC address for command.0...16777215

Default: 0

Command Address

IEC address for indication.0…16777215

Default: 0

Indication Address

OPC Alarm and
Event

Command tracking event used with this
data object.

Default: noneCommand Tracking
Event

Indication event used with this data object.Default: noneIndication Event

Scale and Unit

Scale to be used when issuing command.Default: noneCommand Scale
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Scale to be used with the indication value.Default: noneIndication Scale

Binary counter reading (BCR)4.4.5.4.

Table 4.4.5.4-1 Configurable BCR properties for OPC servers
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

Common Data Class according to IEC
61850.

BCRCommon Data
Class

Addresses

IEC address for indication.0...16777215

Default: 0

Indication Address

Scale and Unit

Multiplier for counter.Default: NoneMultiplier

Unit for counter.Default: DimensionlessUnit

Binary controlled step position information (BSC)4.4.5.5.

Table 4.4.5.5-1 Configurable BSC properties for OPC servers
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

Common Data Class according to IEC
61850.

BSCCommon Data
Class

Addresses

IEC address for command.0...16777215

Default: 0

Command Address

IEC address for position.0...16777215

Default: 0

Position Address

OPC Alarm and
Event

Command tracking event class used with
this data object.

Command Tracking
Event

Indication event used with this data object.Indication Event
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Complex measured value (CMV)4.4.5.6.

Table 4.4.5.6-1 Configurable CMV properties for OPC servers
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

Common Data Class according to IEC
61850.

CMVCommon Data
Class

Sub Type

Sub type description.MV Simple

MV LIMITCHECK

Default: MV Simple

Sub Type

Addresses

IEC address for indication.0...16777215

Default: 0

Indication Address

Scale and Unit

Multiplier for measurement.Default: DekaMultiplier

Scale for measurement.Default: NoneScale

Unit for measurement.Default: DimensionlessUnit

Limit Value Super-
vision

Maximum value for measurement.Default: 20000Max

Minimum value for measurement.Default: 0Min

Delta (DEL)4.4.5.7.

Table 4.4.5.7-1 Configurable DEL properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

DELCommon Data
Class

Sub-Type

Sub Type description.DEL Full

DEL Simple

Default: DEL Simple

Sub Type
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Addresses

IEC Address for phase AB (0 = Not in
use).

0...16777215

Default: 0

Phase AB Address

IEC Address for phase BC (0 = Not in
use).

0...16777215

Default: 0

Phase BC Address

IEC Address for phase CA (0 = Not in
use).

0...16777215

Default: 0

Phase CA Address

Scale and Unit

Multiplier for phase.Default: DekaPhase Multiplier

Scale for phase.Lookup Table Scale

Stepwise Linear Scale

Default: None

Phase Scale

Unit for phase.Default: DimensionlessPhase Unit

Limit Value Super-
vision

Maximum value for measurement.20000Max

Minimum value for measurement.0Min

Controllable double point (DPC)4.4.5.8.

Table 4.4.5.8-1 Configurable DPC properties
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

DPCCommon Data
Class

Sub-Type

Object subtype.IEC style command

Indication only

IEC style command

Sub Type

Addresses

IEC address for command.0...16777215

Default: 8

Command Address
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

DMCD-Type to be used.Single command

Double command

Default: Single command

DMCD-Type

IEC address for indication.0...16777215

Default: 0

Indication Address

IEC Address for selected.0...65535

Default: 0

Selected Address

OPC Alarm and
Event

Command tracking event used with this
data object.

SwitchOperation

TapchangerSingleParallelOper-
ation

Command Tracking
Event

Indication event used with this data object.Indication Event

Scale and Unit

Scale for indication.Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Device Name Plate (DPL)4.4.5.9.

Table 4.4.5.9-1 Configurable DPL properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

DPLCommon Data
Class

Vendor

A simple text string, describing the vendor.ABBVendor

Hardware Revision

A simple text string, describing the hard-
ware revision.

0Hardware Revision

Software Revision

A simple text string, describing the soft-
ware revision.

0Software Revision

Serial Number
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

A simple text string, describing the serial
number.

0Serial Number

Location

A simple text string, describing the loca-
tion.

0Location

Double point status (DPS)4.4.5.10.

Table 4.4.5.10-1 Configurable DPS properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

DPSCommon Data
Class

Addresses

IEC address for indication.0...16777215

Default: 0

Indication Address

OPC Alarm and
Event

Indication event used with this data object.Indication Event

Scale and Unit

Scale for indicationLookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Controllable integer status (INC)4.4.5.11.

Table 4.4.5.11-1 Configurable INC properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

INCCommon Data
Class

Addresses
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

IEC address for command.0...16777215

Default: 0

Command Address

IEC address for indication.0...16777215

Default: 0

Indication Address

OPC Alarm and
Event

Command tracking event used with this
data object.

SwitchOperation

TapchangerSingleParallelOper-
ation

Command Tracking
Event

Indication event used with this data object.Indication Event

Scale and Unit

Scale for indication.Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Integer status (INS)4.4.5.12.

Table 4.4.5.12-1 Configurable INS properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

INSCommon Data
Class

Addresses

IEC address for indication.0...16777215

Default: 0

Indication Address

OPC Alarm and
Event

Indication event used with this data object.Indication Event

Scale and Unit

Scale for indication.Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale
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Integer controlled step position information (ISC)4.4.5.13.

Table 4.4.5.13-1 Configurable ISC properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

ISCCommon Data
Class

Addresses

IEC address for command.0...16777215

Default: 0

Command Address

IEC address for position.0...16777215

Default: 0

Position Address

OPC Alarm and
Event

Command tracking event used with this
data object.

DirectOperate

TapchangerAutoManualOpera-
tion

Default: None

Command Tracking
Event

Indication event used with this data object.Indication Event

Logical Node Name Plate (LPL)4.4.5.14.

Table 4.4.5.14-1 Configurable LPL properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

LPLCommon Data
Class

Vendor

A simple text string, describing the vendor.ABBVendor

Software Revision

A simple text string, describing the soft-
ware revision.

Software Revision

Description

A simple text string, describing the
description for logical node.

Description
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Measured value (MV)4.4.5.15.

Table 4.4.5.15-1 Configurable MV properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

MVCommon Data
Class

Sub-Type

Object subtype.MW LIMITCHECK

MV Simple

Default: MV Simple

Sub Type

Addresses

IEC address for indication.0...16777215

Default: 0

Indication Address

Scale and Unit

Multiplier for measurement.Default: DekaMultiplier

Scale for measurement.Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Unit for measurement.Default: DimensionlessUnit

Limit Value Super-
vision

Maximum value for measurement.Default: 20000Max

Minimum value for measurement.Default: 0Min

Controllable single point (SPC)4.4.5.16.

Table 4.4.5.16-1 Configurable SPC properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

SPCCommon Data
Class

Sub-Type
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Object subtype.Indication only

IEC style command

Default: IEC style command

Sub Type

Addresses

IEC address for command.0...16777215

Default: 0

Command Address

DirectOperate description.True

False

Default: False

DirectOperate

DMCD-Type to be used.Single command

Double command

DMCD-Type

IEC address for indication.Indication Address

OPC Alarm and
Event

Command tracking event used with this
data object.

DirectOperate

TapchangerAutoManualOpera-
tion

Default: None

Command Tracking
Event

Indication event used with this data object.Default: NoneIndication Event

Scale and Unit

Scale for measurement.Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Single point status (SPS)4.4.5.17.

Table 4.4.5.17-1 Configurable SPS properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

SPSCommon Data
Class

Addresses
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

IEC address for indication.0...16777215

Default: 0

Indication Address

OPC Alarm and
Event

Indication event used with this data object.Indication Event

Scale and Unit

Scale for measurement.Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale

WYE4.4.5.18.

Table 4.4.5.18-1 Configurable WYE properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

WYECommon Data
Class

Sub-Type

Object subtype.WYE Full

WYE Simple

Default: WYE Simple

Sub Type

Addresses

NetAddress description.0...16777215

Default: 0

NetAddress

IEC Address for neutral (0 = Not in use).0...16777215

Default: 0

Neutral Address

IEC Address for phase A (0 = Not in use).0...16777215

Default: 0

Phase A Address

IEC Address for phase B (0 = Not in use).0...16777215

Default: 0

Phase B Address

IEC Address for phase C (0 = Not in use).0...16777215

Default: 0

Phase C Address
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

ResAddress description.0...16777215

Default: 0

ResAddress

Scale and Unit

Multiplier for net.Default: DekaNet Multiplier

Scale for net.Default: NoneNet Scale

Unit for net.Default: DimensionlessNet Unit

Multiplier for neutral.Default: DekaNeutral Multiplier

Scale for neutral.Default: NoneNeutral Scale

Unit for neutral.Default: DimensionlessNeutral Unit

Multiplier for phase.Default: DekaPhase Multiplier

Scale for phase.Default: NonePhase Scale

Unit for phase.Default: DimensionlessPhase Unit

Multiplier for res.Default: DekaRes Multiplier

Scale for res.Default: NoneRes Scale

Unit for res.Default: DimensionlessRes Unit

Net Limit Value
Supervision

Max limit for net.Default: 20000Net Max Limit

Min limit for net.Default: 0Net Min Limit

Phase Limit Value
Supervision

Maximum value for measurement.Default: 20000Max

Minimum value for measurement.Default: 0Min

Res Limit Value
Supervision

Max limit for res.Default: 20000Res Max Limit

Min limit for res.Default: 0Res Min Limit

Neutral Limit Value
Supervision

Max limit for neutral.Default: 20000Max Limit

Min limit for neutral.Default: 0Min Limit
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DNP3 LAN/WAN OPC server configuration5.

About this section5.1.

This section guides you in the configuration tasks required before you can start using
the DNP OPC Server. For information on the IEC 61850 data modeling, refer to COM600
User's Manual.

Start Station Automation Builder 600 (later referred to as SAB600). Then either open a
project where at least one DNP OPC server is present, or where a new DNP OPC server
will be added. You can also open and name a new project to include one or more DNP
OPC servers.

1. Select File > Open/Manage Project....
2. In the Open/Manage Project dialog, select the required location for the project:

• Projects on my computer.
• Projects on network.

3. Select New Project on the left.
• Enter a Project Name. The Description is optional.

4. Click Create.
5. Click Open Project.

Overview of configuration5.2.

Before you can start using the DNP OPC Server, build and configure an object tree in
Station Automation Builder 600 (SAB600) to define the Communication structure within
the Gateway object. An object tree contains the following branches:

• Gateway
• DNP LAN OPC Server
• DNP LAN Channel
• Logical Device objects
• Logical Node objects
• Data objects

After you have added the necessary objects to the object tree in the communication
structure, configure them.

The configuration work can basically be divided into two separate tasks:
1. building the object tree, and
2. configuring object properties.

First, build an object tree. This is done by adding objects to the object tree, see
5.3.1, General information about building object tree.
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In the object tree communication view, you can see the DNP OPC Server object and its
child objects such as channels, devices, and data objects. After you have added the
necessary objects to the object tree in the communication structure, configure them, see
5.4.1, General information about configuring objects.

When configuring OPC servers the following characters cannot
be used in object names: \ ` ' ' #

Building object tree5.3.

General information about building object tree5.3.1.

The object tree is built in the Communication structure of SAB600. It is built by adding
objects in a logical order starting from the Gateway.

You have several possible ways to add objects to the object tree in the Communication
structure:
• You can right-click the object to which you want to add a child object. Then select

New > Object type group > Object name, for example
• You can right-click the object type and select New > New. A New Object window

appears. Select the object type you want to add and click OK or double-click it.
• You can copy the object.

Add the objects in the following order:
1. Gateway
2. DNP LAN OPC Server
3. DNP LAN Channel
4. Logical Device objects
5. Logical Node objects
6. Data objects

For information on building a substation structure, see COM600 HMI Configuration
Manual.

Adding Gateway object5.3.2.

To start building the object tree, add a Gateway object in the Communication structure
by selecting the project name, right-click it and select New > Communication > Gate-
way.
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Adding DNP OPC Server object5.3.3.

After the Gateway object has successfully been added, you can continue building the
object tree by adding a DNP OPC Server object.

To add a DNP OPC Server object:
1. Select the Gateway object in the communication structure and right-click it.
2. Add a DNP OPC Server object.

By using the SCL Import function, it is possible to import an entire server’s or individual
device's configurations without having to insert them manually. To open the SCL Import
function, right-click the desired object, and select SCL Import.

For more information about the SCL Import function, see COM600 User's Manual.

Connectivity Packages for certain protection and control devices can also support other
ways to build this structure, depending on the configuration of an individual device, for
example device-related object types and wizards. Typically, Connectivity Packages
include SCL description files which must be installed. For further information on these
Connectivity Packages, see the Connectivity Package of a certain device in the product
documentation.

Adding DNP Channel objects5.3.4.

After the server object has been successfully added, you can continue building the object
tree by adding DNP Channel objects.

To add DNP Channel object:

1. Select DNP OPC Server object.
2. Right-click the DNP OPC Server object.
3. Add DNP Channel object.
4. Rename the new object. The names of the DNP Channel objects have to be unique.

Adding DNP IED objects5.3.5.

After adding a subnetwork you can add device objects.

To add a Device object:
1. Select a Subnetwork object.
2. Add a DNP IED object.
3. Rename the new object. The names of the devices within a DNP channel have to

be unique.

The maximum number of devices per each subnetwork is 30.
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With SCL import function, you can import new objects with configurations from an
existing file. Right-click the device and select SCL Import from the shortcut menu.

To import a new configuration file:
1. Click Select File.
2. Browse to a new configuration file from the appearing dialog.
3. Select the file and click Open.
4. Select the device to import from the drop-down list. You can preview the configur-

ation on the right.
5. Click Import.

The new preconfigured objects appear in the object tree. If the configuration file is large,
the import may take time. To import a configuration file for a different device, right-
click the device, select SCL Import again and repeat the steps above.

Adding Logical Device objects5.3.6.

To add a Logical Device object:
1. Select a DNP IED object and right-click it.
2. Add a Logical Device object.
3. Rename the new object. The names of the Logical Device objects have to be unique.

Each physical device must have at least one Logical Device
object as a child object.

Adding Logical Node objects5.3.7.

To add a Logical Node:
1. Select a Logical Device object and right-click it.
2. Add a Logical Node object.
3. Rename the new object. The names of the Logical Node objects have to be unique.

You should have only one Logical Node 0 (LLN0) as a child
object to a Logical Device object.

Adding data objects5.3.8.

To add a data object:
1. Select a Logical Node object and right-click it.
2. Add a data object.
3. Rename the new object. The names of the data objects have to be unique.
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Configuring objects5.4.

General information about configuring objects5.4.1.

After the objects have been added, configure the object properties. Figure 5.4.1-1 shows
an example of how to use SAB600 to configure the object properties for DNP OPC
Server.

To configure an object:
1. Select an object in the object tree of the communication structure.
2. The object properties appear now in the Object Properties window. The properties

and their values can be viewed as shown in Figure 5.4.1-1.

SAB600_DNP_Object_Properties_Example.png

Figure 5.4.1-1 Example of object properties in the Objects Properties window

3. Select the property you want to configure. Depending on the property value type,
configure by:
• Selecting a predefined value from a drop-down menu, or
• Entering a text string or a numerical value in a text field.

The available properties for different objects are listed in the following subsections.
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Configuring DNP OPC Server LAN Channel properties5.4.2.

The DNP OPC Server LAN Channel properties that can be configured and value ranges
for them can be found in Table 5.4.2-1. The actual configuration by using SAB600 is
performed as described in 5.4.1, General information about configuring objects.

Table 5.4.2-1 DNP LAN Channel properties
DescriptionValue or Value range/DefaultProperty/Parameter

Basic

Specifies if channel is in use or
not.

In Use

Not In Use

Default: In Use

In use

Communication Port

IP address of Ethernet interface
in COM600.

127.0.0.1Local Address

Communication Control

Specifies if incoming connec-
tion requests are checked.

True

False

Default: True

Check Connection Request

Maximum time in milliseconds
of the TCP connect operation.

0 to 65535

Default: 500

Connection timeout

Connection protocol used.TCP/IP

UDP/IP

Default: TCP/IP

Connection Type

Specifies if Reset of the
Remote Link is disabled. Dis-
abling this configuration is use-
ful when the link initialization is
not needed in both directions
or if it is possible that this mes-
sage collides with other trans-
mitted frames from the IEDs
sharing the channel.

True

False

Default: False

Disable Reset of the Remote
Link

Maximum wait time in milli-
seconds within which the first
byte of a link layer response
should have been received.

0 to 65535

Default: 2000

Header Timeout

Specifies whether the link layer
confirmations are in use.

Not In Use

In Use

Default: In Use

Link Layer Confirmations
Enabled
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DescriptionValue or Value range/DefaultProperty/Parameter

Maximum length of a data
fragment.

50 to 249

Default: 230

Maximum Message Length

Delay in milliseconds between
retransmissions.

0 to 65535

Default: 0

Maximum Random Delay for
Retransmission

Specifies if only one application
layer command (e.g. poll) may
be active at any time. Enabling
this configuration is useful
when the communication hard-
ware does not support collision
detection. The poll intervals
defined with the topic configur-
ation tool define the intervals
the IED is tried to be polled.
When multiple IEDs are connec-
ted, the actual polling interval
may be longer. When multiple
simultaneous application layer
commands are allowed, the
command’s transmission is not
related to the state of the other
IEDs connected to the same
communication channel. This
mode of operation can be used
in systems with collision detec-
tion.

True

False

Default: False

Only One Active Application
Layer Command Enabled

Data polling period.0 to 255

Default:10

Polling Period

The time in milliseconds that
DNP3.0 link waits for received
message.

0 to 255

Default: 15

ResponseTimeout

Specifies if 'Test Function for
Link' is enabled.

True

False

Default: False

Test Function for Link

Delay in milliseconds between
test function of link commands.
If value is zero (0), the test
function of link command is not
sent.

0 to 65535

Default: 20

Test Function for Link Interval

Configuring DNP LAN Device5.4.3.

Table 5.4.3-1 lists the configurable properties for DNP Devices and value ranges for
these properties. The actual configuration by using SAB600 is performed as described
in 5.4.1, General information about configuring objects.

111

COM600 series 5.11MRS758689

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



Table 5.4.3-1 DNP LAN IED properties
DescriptionValue or Value range/ DefaultName

Basic

Diagnostics EnabledTrue

False

Default: False

Diagnostics enabled

Controls whether the device communica-
tion is initially in use or not.

In use

Not in use

Default: In use

In Use

Specifies whether the device is in simula-
tion mode or not.

True

False

Default: False

Simulation Mode

If True, then no events are generated for
IED if the new value and quality are the
same as the current value and quality.

True

False

Event only with
changed value

If True, no is event generated when the
item tag is updated for the first time.

True

False

Suppress event on
first update

Addresses

Defines the internet address of this IED.
Port number can be configured by using
semicolon (GW 4.0 or newer). For
example, "127.0.0.1;8080".

127.0.0.1Internet Address

Station address of the master station.0 to 65535

Default: 1

Master Address

Station address of the DNP 3.0 slave sta-
tion.

0 to 65535

Default: 1

Slave Address

Communication
Control

Allocating application of the station.0 to 32

Default: 0

Allocating Applica-
tion

When true, consequent application layer
response timeouts set the station to sus-
pended state and the corresponding pro-
cess objects are set to invalid state.

True

False

Default: False

Automatic Suspen-
sion

Address offset between the process
objects for static data and events with the
same DNP 3.0 address (index).

0 to 65535

Default: 0

Event Offset
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DescriptionValue or Value range/ DefaultName

Then length of pulse in milliseconds used
in the output commands of the control
relay.

0 to 65535

Default: 0

Pulse Length Off
For Control Relay
Output

Then length of pulse in milliseconds used
in the output commands of the control
relay.

0 to 65535

Default: 0

Pulse Length On
For Control Relay
Output

When True, a static data (class 0) poll
request is always sent when the object
status of the DNP master station gets the
value zero (0).

True

False

Default: True

Static Datapoll

Function code for Time Synchronization.Direct time synchronization

Delay compensated

Time Synchroniza-
tion Function

Time in seconds between device time
updates.

0 to 65535

Default: 0

Time Synchroniza-
tion Interval

Command Hand-
ling

Maximum time in seconds that the master
station waits for a response to a command
request from the slave.

0 to 600

Default: 15

Maximum Response
Time

Defines application level confirmation
handling.

Default: DisableProcess Data Con-
firmation

Maximum time in seconds that the DNP
3.0 application layer waits for a reply from
the slave.

0 to 65

Default: 10

Reply Timeout

Lengths

Length of data object address used in DNP
3.0 messages.

1 to 3

Default: 2

Information Address
Length

Control Authoriza-
tion

OPC path of the station remote switch
position used with this device. The format
is Node#ProgID For OPC Server#Channel
Name\IED Name\Logical Device
Name\Logical Node Name\Data Object
Name E.g. GW#ABB.MOD-
BUS_SERIAL_OPC_DA_Server.Instance[1]#Chan-
nel[1\IED1\LD1\GGIO1\loc

User definedStation/Remote
Switch OPC Path
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Configuring Logical Device properties5.4.4.

Table 5.4.4-1 Logical Device properties
DescriptionValue or Value range/

Default
Property/Parameter

Basic

OPC path of the station remote switch
position to be used with this device.

The format is Node#ProgID For OPC
Server#Channel Name\IED
Name\Logical Device Name\Logical
Node Name\Data Object Name e.g.
GW#ABB.Mod-
bus_Serial_OPC_DA_Server.
Instance[1]#Channel1\IED1\LD1
\GGIO1\loc

Station/Remote Switch
OPC Path

Configuring Logical Node properties5.4.5.

Table 5.4.5-1 Configuring Logical Node properties
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic

LLN0

Logical node classLLN0Logical Node Class

GGIO1
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DescriptionValue or Value range/ DefaultProperty/Parameter

Logical node classANCR, ARCO, ATCC, AVCO,
LPHD, CALH, CCGR, CILO,
CPOW, CSWI, GAPC, GGIO,
GSAL, IARC, IHMI, ITCI, ITMI,
MDIF, MHAI, MHAN, MMTR,
MMXN, MMXU, MSQI, MSTA,
PDIF, PDIR, PDIS, PDOP,
PDUP, PFRC, PHAR, PHIZ,
PIOC, PMRI, PMSS, POPF,
PPAM, PSCH, PSEF, PTEF,
PTOC, PTOF, PTOV, PTRC,
PTTR, PTUC, PTUV, PUPF,
PTUF, PVOC, PVPH, PZSU,
RDRE, RADR, RBDR, RDRS,
RBRF, RDIR, RFLO, RPSB,
RREC, RSYN, SARC, SIMG,
SIML, SPDC, XCBR, XSWI,
TCTR, TVTR, YEFN, YLTC,
YPSH, YPTR, ZAXN, ZBAT,
ZBSH, ZCAB, ZCAP, ZCON,
ZGEN, ZGIL, ZLIN, ZMOT,
ZREA, ZRRC, ZSAR, ZTCF,
ZTCR

Default: GGIO

Logical Node Class

Logical node instance numberLN Inst Range is from 1 -
2147483647

Logical Node Instance

Prefix for logical nodeDefault: NoneLogical Node Prefix

Configuring data objects for internal OPC data5.4.6.

General information about configuring data objects for Internal
OPC Data

5.4.6.1.

Internal data objects describe internal status information of an OPC server, for example
whether the connection between the OPC Server and the device (IED) is working or not.
When internal information of an OPC server needs to be transferred, that is information
that does not originate from a device, to an OPC Client, virtual data objects must be
created.

The available properties for different objects are listed in the following subsections.
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Integer status (INS)5.4.6.2.

Table 5.4.6.2-1 Configurable INS properties
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic

Common data class according to IEC
61850

INSCommon Data
Class

Addresses

Item tag path for the internal status
information. The internal server tags that
can be used are located in the Attributes
nodes that are located under the root, line,
and IED nodes. When an attribute tag is
referred to in the internal item definitions
below, it is possible to use either the whole
tag path or just the path relative to the IED
(the internal tags are configured per IED);
for example, Attributes\Diagnostic coun-
ters\Transmitted data messages. When
the whole path is used, it must be pre-
ceded by a slash (/) character, for
example, /Channel Name\Attributes\Dia-
gnostic counters\Transmitted data mes-
sages.

Default: NoneItem Tag Path

Controllable single point (SPC) for OPC internal data5.4.6.3.

Table 5.4.6.3-1 Configurable SPC (for OPC internal data) properties for OPC Servers
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic

61850-TypeSPC61850-Type

Sub-Type

Sub type of objectSub Type

Addresses

Coil address for the control. Coil (0X refer-
ence) address range 1...9999. Address 0
equals to no information available.

0...65535Control Coil

Coil or input address for the indication.
Coil = 0X reference address range
1...9999 or input = 1X reference address
range 10001...19999. Address 0 equals
to no information available.

0...65535Indication Coil/Input
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Single point status (SPS)5.4.6.4.

Table 5.4.6.4-1 Configurable SPS (for OPC internal data) properties for OPC servers
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic

SPSCommon Data Class

Addresses

Item tag path for the internal
status information. The internal
server tags that can be used
are located in the Attributes
nodes that are located under
the root, line, and IED nodes.
When an attribute tag is
referred to in the internal item
definitions below, it is possible
to use either the whole tag path
or just the path relative to the
IED (the internal tags are con-
figured per IED); e.g. Attrib-
utes\Diagnostic counters\Trans-
mitted data messages. When
the whole path is used, it must
be preceded by a slash (/)
character, e.g. /Channel
Name\Attributes\Diagnostic
counters\Transmitted data
messages.

Default: Device connection
status

Item Tag Path

Alarm and Event

Indication event used with this
data object.

Default: Empty stringIndication Event

Configuring data objects5.4.7.

General information about configuring data objects5.4.7.1.

Object properties of the data objects are listed in the following tables.

When configuring address values for DNP IED data objects, the valid address range is
0 - 65535. If the value is -1, then the address is not available.
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Directional protection activation information (ACD)5.4.7.2.

Table 5.4.7.2-1 Configurable ACD properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

ACDCommon Data
Class

Addresses

General Index0...65535

Default: 0

General Index

Neutral Index0...65535

Default: 0

Neutral Index

Phase A Index0...65535

Default: 0

Phase A Index

Phase B Index0...65535

Default: 0

Phase B Index

Phase C Index0...65535

Default: 0

Phase C Index

Common

Class of ASDU. Data sent from the slave
to the master can be assigned to four
classes. Data in class 1 is sent with higher
priority than data in class 3.

Class 0...3

Default: Class 0

Class

Maximum update rate of signal state
changes between the OPC server and
client in milliseconds. 0 means that the
server sends all the changes to the client.

0...65535

Default: 0

Update Rate

Data Class Spe-
cific

Object number for indication.Binary input (1, 2)

Binary output (10)

Default: Binary input (1, 2)

Indication Object

Defines if all changes in value are sent to
the master.

True

False

Default: False

Send All Updates
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Defines if a value is sent as double point.True

False

Default: False

Send As Double
Point

Defines if the value of a message is
inverse.

True

False

Default: False

Send As Inverse
Value

Specifies the type of the timestamp a
message is sent with.

Send as static data (always
without time)

Event without time

Event with time

Event with relative time (valid
for binary inputs only)

Default: Event with time

Time And Type
Variation

Protection activation information (ACT)5.4.7.3.

Table 5.4.7.3-1 Configurable ACT properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

ACTCommon Data
Class

Addresses

General Index0...65535

Default: 0

General Index

Neutral Index0...65535

Default: 0

Neutral Index

Phase A Index0...65535

Default: 0

Phase A Index

Phase B Index0...65535

Default: 0

Phase B Index

Phase C Index0...65535

Default: 0

Phase C Index

119

COM600 series 5.11MRS758689

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Common

Class of ASDU. Data sent from the slave
to the master can be assigned to four
classes. Data in class 1 is sent with higher
priority than data in class 3.

Class 0...3

Default: Class 0

Class

Maximum update rate of signal state
changes between the OPC server and
client in milliseconds. 0 means that the
server sends all the changes to the client.

0...65535

Default: 0

Update Rate

Data Class Spe-
cific

Object number for indication.Binary input (1, 2)

Binary output (10)

Default: Binary input (1, 2)

Indication Object

Defines if all changes in value are sent to
the master.

True

False

Default: False

Send All Updates

Defines if a value is sent as double point.True

False

Default: False

Send As Double
Point

Defines if the value of a message is
inverse.

True

False

Default: False

Send As Inverse
Value

Specifies the type of the timestamp a
message is sent with.

Send as static data (always
without time)

Event without time

Event with time

Event with relative time (valid
for binary inputs only)

Default: Event with time

Time And Type
Variation
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Analog set point (APC)5.4.7.4.

Table 5.4.7.4-1 Configurable APC properties
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

APCCommon Data
Class

Addresses

Control index.-1...65535

Default: -1

Control Index

Indication index.-1…65535

Default: -1

Indication Index

Data Class Spe-
cific

Object number for control.Default: Analog control output
block (41).

Control Object

Variation for control.Default: 2Control Variation

Object number for indication.Analog input (30, 32)

Analog output (40)

Default: Analog input (30, 32)

Indication Object

Scale and Unit

Scale used with the control value.Default: NoneControl Scale

Scale used with the indication value.Default: NoneIndication Scale

Binary counter reading (BCR)5.4.7.5.

Table 5.4.7.5-1 Configurable BCR properties
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

BCRCommon Data
Class

Addresses

Indication index.-1 to 65535

Default: -1

Indication Index
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Data Class Spe-
cific

Object number for counter.Binary counter (20)

Frozen counter (21)

Default: Binary counter (20)

Counter Object

Specifies the multiplier for current SI unit.Default: DekaMultiplier

SI unit for measurement as described in
IEC 61850

Default: DimensionlessUnit

Binary controlled step position information (BSC)5.4.7.6.

Table 5.4.7.6-1 Configurable BSC properties
DescriptionValue or Value range/

Default
Property/ Parameter

Basic

Common data class according to IEC 61850.BSCCommon Data Class

Addresses

Control index.-1 to 65535

Default: -1

Control Index

Indication index.-1 to 65535

Default: -1

Indication Index

Data Class Specific

Qualifier for control.Momentary

Latched

Pulsed

Default: Momentary

Control Code Qualifier

Variation for control0 to 65535Control Variation

Specifies using two-step, select-before-operate
method for issuing control request or not.

Direct Operate

Select Before Operate

Default: Direct Operate

Operate

Scale and Unit

Scale used with this type.Default: NoneScale
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Complex measured value (CMV)5.4.7.7.

Table 5.4.7.7-1 Configurable CMV properties
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

CMVCommon Data
Class

Addresses

Indication index.-1 to 65535

Default: -1

Index

Sub-Type

MV sub-typeSimpleSubtype

Data Class Spe-
cific

Object number for indication.Analog input (30, 32)

Analog output (40)

Default: Analog input (30, 32)

Indication Object

Scale and Unit

Specifies the multiplier for current SI unit.Default: DekaMultiplier

Specifies the number of decimals shown
in HSI. (0 to 9)

Default: 0Phase Number of
Decimals

Scale used with this type.Default: NoneScale

SI unit for measurement as described in
IEC 61850

Default: DimensionlessUnit

Limit Value Super-
vision

Maximum value for measurementMax

Minimum value for measurementMin

Table 5.4.7.7-2 Additional configurable properties for Sub-Type Limit Check
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

MVSubTypeDescriptionLimit CheckSub-Type

Limit Value Super-
vision

High limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0High
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

High-high limit for measurement. Event is
created when value crosses the limit.

Default: 0High-High

Low limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0Low

Low-low limit for measurement. Event is
created when value crosses the limit.

Default: 0Low-Low

Delta (DEL)5.4.7.8.

Table 5.4.7.8-1 Configurable DEL properties
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

DELCommon Data
Class

Addresses

Phase AB Index-1 to 65535

Default: -1

Phase AB Index

Phase BC Index-1 to 65535

Default: -1

Phase BC Index

Phase CA Index-1 to 65535

Default: -1

Phase CA Index

Sub-Type

DEL SubtypeDEL SimpleSubtype

Data Class Spe-
cific

Object number for indication.Analog input (30, 32)

Analog output (40)

Default: Analog input (30, 32)

Indication Object

Scale and Unit

Specifies the multiplier for current SI unit.Default: DekaPhase Multiplier

Specifies the number of decimals shown
in HSI.

0 to 9

Default: 0

Phase Number of
Decimals

Scale used with this type.Default: NoneScale
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

SI unit for measurement as described in
IEC 61850

Default: DimensionlessUnit

Table 5.4.7.8-2 Additional configurable properties for Sub-Type Limit Check
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Sub-type of current data objectDEL FullSub-Type

Limit Value Super-
vision

High limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0High

High-high limit for measurement. Event is
created when value crosses the limit.

Default: 0High-High

Low limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0Low

Low-low limit for measurement. Event is
created when value crosses the limit.

Default: 0Low-Low

Controllable double point (DPC)5.4.7.9.

Table 5.4.7.9-1 Configurable DPC properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

DPCCommon Data
Class

Addresses

Control index.0...65535

Default: 0

Control Index

Indication index.0...65535

Default: 0

Indication Index

Common

Class of ASDU. Data sent from the slave
to the master can be assigned to four
classes. Data in class 1 is sent with higher
priority than data in class 3.

Class 0...3

Default: Class 0

Class
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Maximum update rate of signal state
changes between the OPC server and
client in milliseconds. 0 means that the
server sends all the changes to the client.

0...65535

Default: 0

Update Rate

Data Class Spe-
cific

Object number for control.Default: Binary control output
block (12).

Control Object

Object number for indication.Binary input (1, 2)

Binary output (10)

Default: Binary input (1, 2)

Indication Object

Defines if all changes in value are sent to
the master.

True

False

Default: False

Send All Updates

Defines if the value of a message is
inverse.

True

False

Default: False

Send As Inverse
Value

Defines if a value is sent as single point.True

False

Default: False

Send As Single
Point

Specifies the type of the timestamp a
message is sent with.

Send as static data (always
without time)

Event without time

Event with time

Event with relative time (valid
for binary inputs only)

Default: Event with time

Time And Type
Variation

Device Name Plate (DPL)5.4.7.10.

Table 5.4.7.10-1 Configurable LPL properties
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

61850 Data ObjectDPL61850 Data Object
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Data Class Spe-
cific

Text string describing hardware revision.1.0Hardware revision

Text string describing location.User defined

Default: Vaasa

Location

Text string describing serial number.User defined.

Default: ABB123456789

Serial number

Text string describing software revision.Default: 1.0Software Revision

Text string describing vendor.ABBVendor

Double point status (DPS)5.4.7.11.

Table 5.4.7.11-1 Configurable DPS properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

DPSCommon Data
Class

Addresses

Indication index.0...65535

Default: 0

Indication Index

Common

Class of ASDU. Data sent from the slave
to the master can be assigned to four
classes. Data in class 1 is sent with higher
priority than data in class 3.

Class 0...3

Default: Class 0

Class

Maximum update rate of signal state
changes between the OPC server and
client in milliseconds. 0 means that the
server sends all the changes to the client.

0...65535

Default: 0

Update Rate

Data Class Spe-
cific

Object number for indication.Binary input (1, 2)

Binary output (10)

Default: Binary input (1, 2)

Indication Object
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Defines if all changes in value are sent to
the master.

True

False

Default: False

Send All Updates

Defines if the value of a message is
inverse.

True

False

Default: False

Send As Inverse
Value

Defines if a value is sent as single point.True

False

Default: False

Send As Single
Point

Specifies the type of the timestamp a
message is sent with.

Send as static data (always
without time)

Event without time

Event with time

Event with relative time (valid
for binary inputs only)

Default: Event with time

Time And Type
Variation

Controllable integer status (INC)5.4.7.12.

Table 5.4.7.12-1 Configurable INC properties
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850

INCCommon Data
Class

Addresses

Control index.-1 to 65535

Default: -1

Control Index

Index.-1 to 65535

Default: -1

Index

Data Class Spe-
cific

Object number for control.Default: Analog control output
block (41).

Control Object
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Variation for control.0 to 65535

Default: 2

Control Variation

Object number for indication.Analog input (30, 32)

Analog output (40)

Default: Analog input (30, 32)

Indication Object

Scale and Unit

Scale used with this type.Default: NoneScale

Integer status (INS)5.4.7.13.

Table 5.4.7.13-1 Configurable INS properties
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

INSCommon Data
Class

Addresses

Index.-1 to 65535

Default: -1

Index

Data Class Spe-
cific

Object number for indication.Analog input (30, 32)

Analog output (40)

Default: Analog input (30, 32)

Indication Object

Scale and Unit

Scale used with this type.Default: NoneScale

Integer controlled step position information (ISC)5.4.7.14.

Table 5.4.7.14-1 Configurable ISC properties
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Common data class according to IEC
61850.

ISCCommon Data
Class

Addresses

Control index.-1 to 65535

Default: -1

Control Index

Indication index.-1 to 65535

Default: -1

Indication Index

Data Class Spe-
cific

Object number for control.Default: Analog control output
block (41).

Control Object

Variation for control.0 to 65535

Default: 2

Control Variation

Object number for indication.Analog input (30, 32)

Analog output (40)

Default: Analog input (30, 32)

Indication Object

Scale and Unit

Scale used with this type.Default: NoneScale

Logical Node Name Plate (LPL)5.4.7.15.

Table 5.4.7.15-1 Configurable LPL properties
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

61850 Data ObjectLPL61850 Data Object

Data Class Spe-
cific

Text string describing serial number.User defined.

Default: ABB123456789

Serial number

Text string describing software revision.Default: 1.0Software Revision

Text string describing vendor.ABBVendor
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Measured value (MV)5.4.7.16.

Table 5.4.7.16-1 Configurable MV properties
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

MVCommon Data
Class

Addresses

Indication index.-1 to 65535

Default: -1

Index

Sub-Type

MV Sub-typeSimpleSubtype

Data Class Spe-
cific

Data object number for indication.Analog input (30, 32)

Analog output (40)

Default: Analog input (30, 32)

Indication Object

Scale and Unit

Specifies the multiplier for current SI unit.Default: DekaMultiplier

Specifies the number of decimals shown
in HSI. (0..9)

Default: 0Phase Number of
Decimals

Scale used with this typeDefault: NoneScale

SI unit for measurement as described in
IEC 61850

Default: DimensionlessUnit

Limit Value Super-
vision

Maximum value for measurementMax

Minimum value for measurementMin

Table 5.4.7.16-2 Additional configurable properties for Sub-Type MV Limit Check
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

MVSubTypeDescriptionMV Limit CheckSub-Type

Limit Value Super-
vision

High limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0High
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

High-high limit for measurement. Event is
created when value crosses the limit.

Default: 0High-High

Low limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0Low

Low-low limit for measurement. Event is
created when value crosses the limit.

Default: 0Low-Low

Controllable single point (SPC)5.4.7.17.

Table 5.4.7.17-1 Configurable SPC properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

SPCCommon Data
Class

Addresses

Control index.0...65535

Default: 0

Control Index

Indication index.0...65535

Default: 0

Indication Index

Common

Class of ASDU. Data sent from the slave
to the master can be assigned to four
classes. Data in class 1 is sent with higher
priority than data in class 3.

Class 0...3

Default: Class 0

Class

Maximum update rate of signal state
changes between the OPC server and
client in milliseconds. 0 means that the
server sends all the changes to the client.

0...65535

Default: 0

Update Rate

Data Class Spe-
cific

Object number for control.Default: Binary control output
block (12).

Control Object

Object number for indication.Binary input (1, 2)

Binary output (10)

Default: Binary input (1, 2)

Indication Object
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Defines if all changes in value are sent to
the master.

True

False

Default: False

Send All Updates

Defines if a value is sent as double point.True

False

Default: False

Send As Double
Point

Defines if the value of a message is
inverse.

True

False

Default: False

Send As Inverse
Value

Specifies the type of the timestamp a
message is sent with.

Send as static data (always
without time)

Event without time

Event with time

Event with relative time (valid
for binary inputs only)

Default: Event with time

Time And Type
Variation

Single point status (SPS)5.4.7.18.

Table 5.4.7.18-1 Configurable SPS properties for OPC client
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850

SPSCommon Data
Class

Addresses

Indication index.0...65535

Default: 0

Indication Index

Common

Class of ASDU. Data sent from the slave
to the master can be assigned to four
classes. Data in class 1 is sent with higher
priority than data in class 3.

Class 0...3

Default: Class 0

Class
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Maximum update rate of signal state
changes between the OPC server and
client in milliseconds. 0 means that the
server sends all the changes to the client.

0...65535

Default: 0

Update Rate

Data Class Spe-
cific

Object number for indication.Binary input (1, 2)

Binary output (10)

Default: Binary input (1, 2)

Indication Object

Defines if all changes in value are sent to
the master.

True

False

Default: False

Send All Updates

Defines if a value is sent as double point.True

False

Default: False

Send As Double
Point

Defines if the value of a message is
inverse.

True

False

Default: False

Send As Inverse
Value

Specifies the type of the timestamp a
message is sent with.

Send as static data (always
without time)

Event without time

Event with time

Event with relative time (valid
for binary inputs only)

Default: Event with time

Time And Type
Variation

WYE5.4.7.19.

Table 5.4.7.19-1 Configurable WYE properties
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850.

WYECommon Data
Class

Sub-Type
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Subtype of WYEWYE SimpleSubtype

Addresses

Neutral Index-1 to 65535

Default: -1

Neutral Index

Phase A Index-1 to 65535

Default: -1

Phase A Index

Phase B Index-1 to 65535

Default: -1

Phase B Index

Phase C Index-1 to 65535

Default: -1

Phase C Index

Net Index-1 to 65535

Default -1

Net Index

Res Index-1 to 65535

Default -1

Res Index

Data Class Spe-
cific

Object number for indication.Analog input (30, 32)

Analog output (40)

Default: Analog input (30, 32)

Indication Object

Scale and Unit

Specifies the multiplier for the current SI
unit.

Default: DekaNeutral Multiplier

Scale for neutral used with this data object.Default: NoneNeutral Scale

Unit for Neutral phase.Default: DimensionlessNeutral Unit

Specifies the number of decimals shown
in HSI.

0 to 9

Default: 0

Neutral Number of
Decimals

Specifies the multiplier for the current SI
unit.

Default: DekaPhase Multiplier

Scale for phases used with this data
object.

Default: NonePhase Scale

Unit for phases.Default: DimensionlessPhase Unit

Specifies the number of decimals shown
in HSI.

0 to 9

Default: 0

Phase Number of
Decimals
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Specifies the multiplier for the current SI
unit.

Default: DekaNet Multiplier

Scale for Net used with this data object.Default: NoneNet Scale

Unit for Net.Default: DimensionlessNet Unit

Specified the number of decimals shown
in HSI.

0 to 9Net Number of
Decimals

Specifies the multiplier for the current SI
unit.

Default: DekaRes Multiplier

Scale for Res used with this data object.Default: NoneRes Scale

Unit for Res.Default: DimensionlessRes Unit

Specified the number of decimals shown
in HSI.

0 to 9Res Number of
Decimals

Phase Limit Value
Supervision

Maximum value for measurement.Default: 20000Max

Minimum value for measurement.Default: 0Min

Neutral Limit Value
Supervision

Maximum value for measurement.Default: 20000Max

Minimum value for measurement.Default: 0Min

Table 5.4.7.19-2 Additional configurable properties for Sub-Type WYE Full
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Subtype of WYE.WYE FullSub-Type

Phase Limit Value
Supervision

High limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0High

High-high limit for measurement. Event is
created when value crosses the limit.

Default: 0High-High

Low limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0Low

Low-low limit for measurement. Event is
created when value crosses the limit.

Default: 0Low-Low

Neutral Limit Value
Supervision

High limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0High
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

High-high limit for measurement. Event is
created when value crosses the limit.

Default: 0High-High

Low limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0Low

Low-low limit for measurement. Event is
created when value crosses the limit.

Default: 0Low-Low

Table 5.4.7.19-3 Additional configurable properties for Sub-Type WYE Full
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Subtype of WYEWYE FullSub-Type

Net Limit Value
Supervision

High limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0High

High-high limit for measurement. Event is
created when value crosses the limit.

Default: 0High-High

Low limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0Low

Low-low limit for measurement. Event is
created when value crosses the limit.

Default: 0Low-Low

Res Limit Value
Supervision

High limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0High

High-high limit for measurement. Event is
created when value crosses the limit.

Default: 0High-High

Low limit for measurement. Event is cre-
ated when value crosses the limit.

Default: 0Low

Low-low limit for measurement. Event is
created when value crosses the limit.

Default: 0Low-Low

Event definitions5.4.8.

For information on event definitions, refer to COM600 User’s Manual.

Using scales5.4.9.

For information on using scales, refer to COM600 User’s Manual.
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Controllable Enumerated Status (ENC)5.4.10.

Table 5.4.10-1 Configurable ENC properties
DescriptionValue or Value range/DefaultProperty/Parameter

Basic

Common data class according
to IEC 61850.

ENCCommon Data Class

Addresses

Control index.-1..65535

Default: -1

Control Index

Indication Index.-1..65535

Default: -1

Indication Index

Data Class Specific

Object number for control.Default: Analog control output
block (41).

Control Object

Variation for control.Default: 2Control Variation

Object number for indication.Analog input (30, 32)

Analog output (40)

Default: Analog input (30, 32)

Indication Object

Scale and Unit

Scale used with the control
value.

Default: NoneScale

Enumerated Status (ENS)5.4.11.

Table 5.4.11-1 Configurable ENS properties
DescriptionValue or Value range/DefaultProperty/Parameter

Basic

Common data class according
to IEC 61850.

ENSCommon Data Class

Addresses

Indication Index.-1 to 65535

Default: -1

Indication Index

Data Class Specific
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Object number for indication.Analog input (30, 32)

Analog output (40)

Default: Analog input (30, 32)

Indication Object

Scale and Unit

Scale used with the control
value.

Default: NoneScale
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MODBUS TCP server configuration6.

About this section6.1.

This section guides you in the configuration tasks required before you can start using
the Modbus OPC Server. For information on the IEC 61850 data modeling, refer to
COM600 User's Manual.

Start SAB600 to open and name a project.

1. Select File > Open/Manage Project....
2. In the Open/Manage Project dialog, select the required location for the project:

• Projects on my computer
• Projects on network

3. Select New Project on the left.
• Enter a Project Name. The Description is optional.

4. Click Create.
5. Click Open Project.

Overview of configuration6.2.

Before you can start using the Modbus OPC Server, you need to build and configure an
object tree in SAB600 to define the Communication structure.

The possible objects are:
• Gateway
• Modbus OPC Server
• Modbus Subnetwork
• Modbus IED
• Logical Device objects
• Logical Node objects
• Data objects

Figure 6.2-1 shows an example view of SAB600 including an object tree in the commu-
nication structure on the left and Object Properties window displaying the object properties
on the right.

When configuring OPC servers the following characters cannot
be used in object names: \ ` ' ' #

For information about configuring parameters for Parameter Setting in WebHMI, see
COM600 HMI Configuration Manual.
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SAB600_ModbusTCP_Example_View.png

Figure 6.2-1 Example view of SAB600

The configuration work can basically be divided into two separate tasks:
1. building an object tree, and
2. configuring object properties.

First, you need to build an object tree. This is done by adding objects to the object tree,
see 6.3.1, General information about building object tree.

Figure 6.2-1 shows an example of how the object tree may look like after it has been
built. In the example tree you can see the Modbus OPC Server object and its child objects
like channels, devices, and data objects. Indentation is used to indicate the parent-child
relationship between the objects.

After you have added the necessary objects to the object tree in the communication
structure, you need to configure them, see 6.4.1, General information about configuring
objects.

Table 6.2-1 describes the objects shown in the object tree (Figure 6.2-1).

Table 6.2-1 Modbus OPC Server related objects
DescriptionObject

An object representing the Modbus OPC Server.Modbus OPC Server

Object representing a physical subnetwork.Modbus Subnetwork

An object representing a physical device. You should not
have more than 30 devices per each channel.

Modbus IED

An object representing a physical device that connects
several protection and control devices together.

LON Star Coupler

An object representing a physical device that is used for
synchronization of the LON network.

LON Clock Master
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An object representing a physical device that connects
SPA Devices to the LON Network.

LSG Device (LON SPA Gateway)

An object representing a physical SPA protection and
control device.

LON SPA Device (with LSG Device
object only)

Collection of SPA modules in one physical rack.LON SPA Rack (with LSG Device
object only)

An object representing a physical SPA protection and
control module.

LON SPA Module (with LON SPA
Rack object only)

Collection of SPA modules in one physical rack.SPA Rack

An object representing a physical SPA protection and
control module placed in a relay rack, for example,
SPACOM modules.

SPA Module (with SPA Rack object
only)

An object representing a group of functions. Each function
is defined as a Logical Node. A physical device consists
of one or several LDs.

Logical Device (LD)

An object defined by its data and methods. LN is the
smallest part of a function that exchanges data.

Logical Node (LN)

Data object is an instance of one of the IEC 61850 Data
Object Classes such as Single point status and Measured
Value. Depending on the class, each data object has a
set of attributes for monitoring and controlling the object,
e.g. value, quality, and control.

Data Object (DO)

Building object tree6.3.

General information about building object tree6.3.1.

The object tree is built in the Communication structure of SAB600, see Figure 6.2-1. It
is built by adding objects in a logical order starting from the Gateway.

You have several possible ways to add objects to the object tree in the Communication
structure:
• You can right-click the object to which you want to add a child object. Then select

New > Object type group > Object name, for example New > Modbus Serial >
Modbus Serial OPC Server.

• You can right-click the object type and select New > New. A New Object window
appears. Select the object type you want to add and click OK or double-click it.

• You can copy the object.

Add the objects in the following order:
1. Gateway
2. Modbus TCP OPC Server
3. Modbus TCP Subnetwork
4. Modbus TCP IED
5. Logical Device objects
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6. Logical Node objects
7. Data objects

For information on building a substation structure, refer to COM600 HMI Configuration
Manual.

Adding Gateway object6.3.2.

To start building the object tree, add a Gateway object in the Communication structure
by selecting the project name, right-click it and select New > Communication > Gate-
way.

Adding Modbus OPC Server object6.3.3.

After the Gateway object has successfully been added, you can continue building the
object tree by adding a Modbus OPC Server object.

To add a Modbus OPC Server object:
1. Select the Gateway object in the communication structure and right-click it.
2. Add a Modbus OPC Server object.

By using the SCL Import function, it is possible to import an entire server’s or individual
device's configurations without having to insert them manually. To open the SCL Import
function, right-click the desired object, and select SCL Import.

For more information about the SCL Import function, see COM600 User's Manual.

Connectivity Packages for certain protection and control devices can also support other
ways to build this structure, depending on the configuration of an individual device, for
example device-related object types and wizards. Typically, Connectivity Packages
include SCL description files which must be installed. For further information on these
Connectivity Packages, see the Connectivity Package of a certain device in the product
documentation.

Adding Modbus Subnetwork objects6.3.4.

After the server object has been successfully added, you can continue building the object
tree by adding Modbus subnetwork objects.

To add a Modbus subnetwork object:
1. Select a Modbus OPC Server object.
2. Right-click the Modbus OPC Server object.
3. Add a Modbus subnetwork object.
4. Rename the new object. The names of the Modbus subnetwork objects have to be

unique.
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Adding Modbus IED objects6.3.5.

After adding a subnetwork you can add device objects.

To add a Device object:
1. Select a Subnetwork object.
2. Add a Modbus IED object.
3. Rename the new object. The names of the devices within a Modbus channel have

to be unique.

The maximum number of devices per each subnetwork is 30.

With SCL import function, you can import new objects with configurations from an
existing file. Right-click the device and select SCL Import from the shortcut menu.

To import a new configuration file:
1. Click Select File.
2. Browse to a new configuration file from the appearing dialog.
3. Select the file and click Open.
4. Select the device to import from the drop-down list. You can preview the configur-

ation on the right.
5. Click Import.

The new preconfigured objects appear in the object tree. If the configuration file is large,
the import may take time. To import a configuration file for a different device, right-
click the device, select SCL Import again and repeat the steps above.

Adding Logical Device objects6.3.6.

To add a Logical Device object:
1. Add a Modbus TCP IED object and right-click it.
2. Add a Logical Device object.
3. Rename the new object. The names of the Logical Device objects have to be unique.

Each TCP physical device must have at least one Logical
Device object as a child object.

Adding Logical Node objects6.3.7.

To add a Logical Node:
1. Select a Logical Device object and right-click it.
2. Add a Logical Node object.
3. Rename the new object. The names of the Logical Node objects have to be unique.
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You should have only one Logical Node 0 (LLN0) as a child
object to a Logical Device object.

Adding data objects6.3.8.

To add a data object:
1. Select a Logical Node object and right-click it.
2. Add a data object.
3. Rename the new object. The names of the data objects have to be unique.

Configuring objects6.4.

General information about configuring objects6.4.1.

After the objects have been added, configure the object properties. Figure 6.4.1-1 shows
an example of how to use SAB600 to configure the object properties for Modbus OPC
Server.

To configure an object:
1. Select an object in the object tree of the communication structure.

• The object properties appear now in the Object Properties window. The proper-
ties and their values can be viewed as shown in Figure 6.4.1-1
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SAB600_ModbusTCP_Object_Properties_Example.png

Figure 6.4.1-1 Example of object properties in the Objects Properties window

2. Select the property you want to configure. Depending on the property value type,
configuring is always done either by
• selecting a predefined value from a drop-down menu, or
• entering a text string or a numerical value in a text field.

The available properties for different objects are listed in the following subsections.

Configuring Modbus TCP OPC Server properties6.4.2.

Table 6.4.2-1 OPC Server properties
DescriptionValue or Value range/DefaultProperty/Parameter

Basic

Instance identification of dia-
gnostic OPC alarm and event
server.

AE Prog ID
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DescriptionValue or Value range/DefaultProperty/Parameter

Instance identification of dia-
gnostic OPC data access
server.

DA Prog ID

Configuring Modbus OPC Server Subnetwork properties6.4.3.

The Modbus OPC Server subnetwork properties that can be configured and value ranges
for them can be found in Table 6.4.3-1. The actual configuration by using SAB600 is
performed as described in 6.4.1, General information about configuring objects.

Each Modbus OPC Server node of the system must have a
unique subnet/node address.

Table 6.4.3-1 Modbus Subnetwork properties
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic

Specifies if channel is in use or
not.

In Use

Not In Use

Default: In Use

In use

Specifies the IP address used
by communication line.

127.0.0.1Local Address

Communication Control

Specifies the number of mes-
sage buffers reserved for the
line.

0..255

Default: 12

Buffer Pool Size

Specifies the time (in seconds)
that the Modbus 3.0 link waits
for the end of the received
message.

0..65535

Default: 2

Response Timeout

Specifies the maximum waiting
time (in milliseconds within
which the first byte of a link
layer response should have
been received).

0..65535

Default: 700

Header Timeout

Polling

Delay between polling mes-
sages in milliseconds.

0..65535

Default: 40

Poll Delay
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DescriptionValue or Value range/ DefaultProperty/Parameter

The polling frequency of sus-
pended stations.

1 = each polling cycle, 2 =
Every 2nd polling cycle, etc.

0..255

Default: 3

Polling Period

Configuring Modbus TCP Device6.4.4.

Table 6.4.4-1 lists the configurable properties for Modbus Devices and value ranges for
these properties. The actual configuration by using SAB600 is performed as described
in 6.4.1, General information about configuring objects.

Table 6.4.4-1 Modbus TCP IED properties
DescriptionValue or Value range/ DefaultName

Basic

Diagnostics EnabledTrue

False

Default: False

Diagnostics enabled

Controls whether the device communica-
tions initially in use or not.

In use

Not in use

Default: In use

In Use

The maximum length of address between
first and last address index in one Topic.

1..1000

Default: 10

Maximum Topic
Range

Specifies whether the device is insimula-
tion mode or not.

True

False

Default: False

Simulation Mode

Addresses

Defines the internet address of this IED.
Port number can be configured by using
semicolon (GW 4.0 or newer). For
example, "127.0.0.1;8080".

127.0.0.1Internet Address

Modbus address of the device.0..255

Default: 1

Station Address

Timeouts

Defines the timeout.0..3600

Default: 500

Connection Timeout
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DescriptionValue or Value range/ DefaultName

Defines the timeout before attempting
reconnection.

0..3600

Default: 30

Reconnecting
Timeout

Specifies the maximum time (in
seconds)for waiting a reply to a command.
If the time is exceeded, the command is
considered as failed.

0..3600

Default: 15

Reply Timeout

Control Authoriza-
tion

OPC path of the station remote switch
position used with this device. The format
is Node#ProgID For OPC Server#Channel
Name\IED Name\Logical Device
Name\Logical Node Name\Data Object
Name E.g. GW#ABB.MOD-
BUS_LAN_OPC_DA_Server.Instance[1]#Chan-
nel[1\IED1\LD1\GGIO1\loc

Station/Remote
Switch OPC Path

OPC Alarm and
Event

Device Connection Status ClassDevice Connection StatusDevice Connection
Status Class

Table 6.4.4-2 Modbus Serial IED REF542+ properties
DescriptionValue or Value range/ DefaultName

Basic

Diagnostics EnabledTrue

False

Default: False

Diagnostic Enabled

In UseIn use

Not in use

Default: In use

In Use

The maximum length of
address range between first
and last address index in one
Topic.

1..1000

Default: 10

Maximum Topic Range
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DescriptionValue or Value range/ DefaultName

If the value of this property is
0, the topics which are con-
figured to have polling interval
= 0, are not requested in any
situation. This is the default
mode. If this bit is 1, the topics
which are configured to have
polling interval = 0, are reques-
ted in communication startup
situation and when the GI
command is issued.

0..65535

Default: 0

Running Mode

Defines if this device is in simu-
lation mode or not.

True

False

Default: False

Simulation Mode

Addresses

The station address of the
master station.

0..255

Default: 1

Station Address

Timeouts

The maximum time (in milli-
seconds) that the station waits
for a reply.

0..3600

Default: 15

Reply Timeout

Control Authorization

OPC path of the station remote
switch position used with this
device. The format is
Node#ProgID For OPC
Server#Channel Name\IED
Name\Logical Device
Name\Logical Node
Name\Data Object Name E.g.
GW#ABB.MOD-
BUS_SERIAL_OPC_DA_Server.
Instance[1]#Chan-
nel[1\IED1\LD1\GGIO1\loc

Station/Remote Switch OPC
Path

Alarm and Event

Device Connection Status
Class

Device Connection StatusDevice Connection Status
Class

SPAEvent Topic

SPA Event Deadband0..65535

Default: 0

Deadband
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DescriptionValue or Value range/ DefaultName

First index of addresses.RCEFileNumber2

RCEFileNumber5

RCEFileNumber11

RCEFileNumber12

Default: RCEFileNumber2

First Index

Interval in milliseconds.0..65535

Default: 100

Interval

Disturbance Recording

Disturbance Recorder DirectoryDisturbanceRecorderDirectory

Disturbance Recorder EnabledTrue

False

Default: True

DisturbanceRecorderEnabled

Disturbance Recorder Max
Total File Size

0..65535

Default: 1024

DisturbanceRecorderMaxTotal-
FileSize

Disturbance Recorder Notifica-
tion Address

0..65535

Default: 0

DisturbanceRecorderNotifica-
tionAddr

Disturbance Recorder Polling
Period

0..65535

Default: 0

DisturbanceRecorderPolling-
Period

TimeSynch Topic

Deadband in milliseconds.0..65535

Deafault: 100

Deadband

First index of address.RCEFileNumber7First Index

Interval in milliseconds.0..65535

Default: 100

Interval

Configuring Logical Device properties6.4.5.

Table 6.4.5-1 Logical Device properties
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic
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OPC path of the station remote
switch position to be used with
this device.

The format is Node#ProgID For
OPC Server#Channel
Name\IED Name\Logical
Device Name\Logical Node
Name\Data Object Name e.g.
GW#ABB.Mod-
bus_LAN_OPC_DA_Server.
Instance[1]#Chan-
nel1\IED1\LD1\GGIO1\loc

Station/Remote Switch OPC
Path

Configuring Logical Node properties6.4.6.

Table 6.4.6-1 Configuring Logical Node properties
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic

LLN0

Logical node classLLN0Logical Node Class

GGIO1

Logical node classANCR, ARCO, ATCC, AVCO,
LPHD, CALH, CCGR, CILO,
CPOW, CSWI, GAPC, GGIO,
GSAL, IARC, IHMI, ITCI, ITMI,
MDIF, MHAI, MHAN, MMTR,
MMXN, MMXU, MSQI, MSTA,
PDIF, PDIR, PDIS, PDOP,
PDUP, PFRC, PHAR, PHIZ,
PIOC, PMRI, PMSS, POPF,
PPAM, PSCH, PSEF, PTEF,
PTOC, PTOF, PTOV, PTRC,
PTTR, PTUC, PTUV, PUPF,
PTUF, PVOC, PVPH, PZSU,
RDRE, RADR, RBDR, RDRS,
RBRF, RDIR, RFLO, RPSB,
RREC, RSYN, SARC, SIMG,
SIML, SPDC, XCBR, XSWI,
TCTR, TVTR, YEFN, YLTC,
YPSH, YPTR, ZAXN, ZBAT,
ZBSH, ZCAB, ZCAP, ZCON,
ZGEN, ZGIL, ZLIN, ZMOT,
ZREA, ZRRC, ZSAR, ZTCF,
ZTCR

Default: GGIO

Logical Node Class

Logical node instance numberLN Inst Range is from 1 -
2147483647

Logical Node Instance
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DescriptionValue or Value range/ DefaultProperty/Parameter

Prefix for logical nodeDefault: NoneLogical Node Prefix

Configuring data objects for internal OPC data6.4.7.

General information about configuring data objects for Internal
OPC Data

6.4.7.1.

Internal data objects describe internal status information of an OPC server, for example
whether the connection between the Modbus OPC Server and the device (IED) is
working or not. When internal information of an OPC server needs to be transferred,
that is information that does not originate from a device, to an OPC Client, virtual data
objects must be created.

The available properties for different objects are listed in the following subsections.

Integer status (INS)6.4.7.2.

Table 6.4.7.2-1 Configurable INS (for OPC internal data) properties for OPC Servers
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic

Common data class according to IEC
61850

INSCommon Data
Class

Addresses

Item tag path for the internal status
information. The internal server tags that
can be used are located in the Attributes
nodes that are located under the root, line,
and IED nodes. When an attribute tag is
referred to in the internal item definitions
below, it is possible to use either the whole
tag path or just the path relative to the IED
(the internal tags are configured per IED);
for example, Attributes\Diagnostic coun-
ters\Transmitted data messages. When
the whole path is used, it must be pre-
ceded by a slash (/) character, for
example, /Channel Name\Attributes\Dia-
gnostic counters\Transmitted data mes-
sages.

Default: NoneItem Tag Path
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Controllable single point (SPC) for OPC internal data6.4.7.3.

Table 6.4.7.3-1 Configurable SPC (for OPC internal data) properties for OPC Servers
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic

61850-TypeSPC61850-Type

Sub-Type

Sub type of objectSub Type

Addresses

Coil address for the control. Coil (0X refer-
ence) address range 1...9999. Address 0
equals to no information available.

0...65535Control Coil

Coil or input address for the indication.
Coil = 0X reference address range
1...9999 or input = 1X reference address
range 10001...19999. Address 0 equals
to no information available.

0...65535Indication Coil/Input

Single point status (SPS)6.4.7.4.

Table 6.4.7.4-1 Configurable SPS (for OPC internal data) properties for OPC servers
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic

SPSCommon Data Class

Addresses
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Item tag path for the internal
status information. The internal
server tags that can be used
are located in the Attributes
nodes that are located under
the root, line, and IED nodes.
When an attribute tag is
referred to in the internal item
definitions below, it is possible
to use either the whole tag path
or just the path relative to the
IED (the internal tags are con-
figured per IED); e.g. Attrib-
utes\Diagnostic counters\Trans-
mitted data messages. When
the whole path is used, it must
be preceded by a slash (/)
character, e.g. /Channel
Name\Attributes\Diagnostic
counters\Transmitted data
messages.

Default: Device connection
status

Item Tag Path

Alarm and Event

Indication event used with this
data object.

Default: Empty stringIndication Event

Configuring data objects6.4.8.

Directional protection activation information6.4.8.1.

Table 6.4.8.1-1 Configurable ACD properties for OPC Servers with Modbus IED
Device

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeACD61850-Type

Sub type for the objectBITSub Type

Addresses

Coil or input address for General informa-
tion. Coil (0X reference) address range 1
to 9999 or input (1X reference) address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

General Coil/Input
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Coil or input address for Neutral informa-
tion. Coil (0X reference) address range 1
to 9999 or input (1X reference) address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Neutral Coil/Input

Coil or input address for Phase A informa-
tion. Coil (0X reference) address range 1
to 9999 or input (1X reference) address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase A Coil/Input

Coil or input address for Phase B informa-
tion. Coil (0X reference) address range 1
to 9999 or input (1X reference) address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase B Coil/Input

Coil or input address for Phase C informa-
tion. Coil (0X reference) address range 1
to 9999 or input (1X reference) address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase C Coil/Input

Protection activation information (ACT)6.4.8.2.

Table 6.4.8.2-1 Configurable ACT properties for OPC Servers with Modbus IED
Device

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeACT61850-Type

Sub Type for the objectBITSub Type

Addresses

Coil or input address for General informa-
tion. Coil (0X reference) address range 1
to 9999 or input (1X reference) address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Neutral Coil/Input

Coil or input address for Neutral informa-
tion. Coil (0X reference) address range 1
to 9999 or input (1X reference) address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Neutral Coil/Input
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Coil or input address for Phase A informa-
tion. Coil (0X reference) address range 1
to 9999 or input (1X reference) address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase A Coil/Input

Coil or input address for Phase B informa-
tion. Coil (0X reference) address range 1
to 9999 or input (1X reference) address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase B Coil/Input

Coil or input address for Phase C informa-
tion. Coil (0X reference) address range 1
to 9999 or input (1X reference) address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase C Coil/Input

Analog set point (APC)6.4.8.3.

Analog set point (APC) for OPC server with Modbus IED supports the following subtypes:

• REGISTER_BASED_CONTROL
• DPU_REGISTER_BASED_CONTROL

Table 6.4.8.3-1 Configurable APC properties for OPC servers with Modbus device,
subtype REGISTER_BASED_CONTROL

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeAPC61850-Type

REGISTERED_BASE_CON-
TROL

Subtype

Addresses

Data format of the control and the indica-
tion.

Float MSW first

Float MSW last

Default: Float MSW first

Format

Holding register address for indication.
Holding register (4X reference) address
range 40001-49999. Address 0 equals no
information available.

0-65535

Default: 0

Indication Register

Holding register address for the set point.
Holding register (4X reference) address
range 40001-49999. Address 0 equals no
information available.

0-65535

Default: 0

Set Point Register
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Scale and unit

Scale to be used with the control value.Default: None.Control Scale

Scale to be used with the indication value.Default: None.Indication Scale

Table 6.4.8.3-2 Configurable APC properties for OPC servers with Modbus device,
subtype DPU_REGISTER_BASED_CONTROL

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeAPC61850-Type

REGISTER_BASE_CONTROLSubtype

Addresses

6x register address for execute command.
Extended register (6X reference) address
range 60001…65535. Address 0 equals
to no information available.

0…65535

Default: 0

Execute Register

Data format of the control and the indica-
tion.

Float MSW first

Float MSW last

Default: Float MSW first

Format

6x register address for indication register.
Extended register (6X reference) address
range 60001…65535. Address 0 equals
to no information available.

0-65535

Default: 0

Indication Register

6x register address for set point register.
Extended register (6X reference) address
range 60001…65535. Address 0 equals
to no information available.

0-65535

Default: 0

Set Point Register

Password

6x register address for password 1.
Extended register (6X reference) address
range 60001…65535. Address 0 equals
to no information available.

0-65535

Default: 0

Address for pass-
word 1

6x register address for password 2.
Extended register (6X reference) address
range 60001…65535. Address 0 equals
to no information available.

0-65535

Default: 0

Address for pass-
word 2

Four character password. Default is empty
string.

Password

Scale and Unit

Scale to be used with the control value.Default: None.Control Scale

Scale to be used with the indication value.Default: None.Indication Scale
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Binary counter reading (BCR)6.4.8.4.

Table 6.4.8.4-1 Configurable BCR properties for OPC servers with Modbus IED
device

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeBCR61850-Type

Addresses

Holding or input register address for the
counter value. Holding register (4X refer-
ence) address range 40001..49999 or
input register (3X reference) address
range 30001..39999. Address 0 equals to
no information available. If format requiring
two registers is used, then the lower
address must be entered.

0 to 65535

Default: 0

Counter Register

Data format of the value.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Format

Scale and Unit

MultiplierDefault: No multiplierMultiplier

SI unit for measurement as described in
IEC 61850.

Default: DimensionlessUnit

Binary controlled step position information (BSC)6.4.8.5.

Binary Controlled Step Position Information (BSC) for OPC server with Modbus IED
supports two subtypes:

• COILED_BASE_CONTROL
• DPU_REGISTER_BASE_CONTROL
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Table 6.4.8.5-1 Configurable BSC properties for OPC servers with Modbus device,
subtype COILED_BASE_CONTROL

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeBSC61850-Type

COILED_BASE_CONTROLSubtype

Addresses

Coil address for the higher command. Coil
(0X reference) address range 1 to 9999.
Address 0 equals to no information avail-
able.

0 to 65535

Default: 0

Higher Coil

Coil address for the lower command. Coil
(0X reference) address range 1 to 9999.
Address 0 equals to no information avail-
able.

0 to 65535

Default: 0

Lower Coil

Data format for the value.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Position Format

Holding or input register address for the
position. Holding register (4X reference)
address range 40001 to 49999 or input
register (3X reference) address range
30001 to 39999. Address 0 equals to no
information available.

0 to 65535

Default: 0

Position Register

Coil address for the stop command. Coil
(0X reference) address range 1 to 9999.
0 equals to no information available.

0 to 65535

Default: 0

Stop Coil

Scale and Unit

Scale used with position information.Default: NoneScale for position
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Table 6.4.8.5-2 Configurable BSC properties for OPC servers with Modbus device,
subtype DPU_REGISTER_BASE_CONTROL

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeBSC61850-Type

DPU_REGISTER_BASE_CON-
TROL

Subtype

Addresses

6x extended register. Extended register
(6x reference) address range 60001 to
65535. Address 0 equals to no information
available(0 to 65535).

0 to 65535Execute Register

6x extended register. Extended register
(6x reference) address range 60001 to
65535. Address 0 equals to no information
available(0 to 65535).

0 to 65535Higher register

6x extended register. Extended register
(6x reference) address range 60001 to
65535. Address 0 equals to no information
available(0 to 65535).

0 to 65535Lower register

6x extended register. Extended register
(6x reference) address range 60001 to
65535. Address 0 equals to no information
available(0 to 65535).

0 to 65535

ASCII – 2 Characters rightmost
Digits

Address for pass-
word 1

6x extended register. Extended register
(6x reference) address range 60001 to
65535. Address 0 equals to no information
available(0 to 65535).

0 to 65535

ASCII – 2 Characters rightmost
Digits

Address for pass-
word 2

IED device 4 character password. Default
is empty string.

Default: empty string

Length: 4 characters

Password

Complex measured value (CMV)6.4.8.6.

Table 6.4.8.6-1 Configurable CMV properties for OPC servers with Modbus device
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

61850-TypeCMV61850-Type

Sub Type
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Sub type for MV/CMV.MV/CMV simple

MV_LIMIT_CHECK

Default: MV/CMV simple

Sub Type

Addresses

Data format of the value.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Measurement
Format

Holding or input register address for the
measurement. Holding register (4X refer-
ence) address range 40001 to 49999 or
input register (3X reference) address
range 30001 to 39999. Address 0 equals
to no information available. If format
requiring two registers is used, then the
lower address must be entered.

0 to 65535

Default: 0

Measurement
Register

Scale and Unit

Specifies the multiplier for current SI unit.Default: DekaMultiplier

Scale used with this type.Default: NoneScale

SI unit for measurement as described in
IEC 61850.

Default: DimensionlessUnit

Limit Value Super-
vision

Maximum value for measurement.20000Max

Minimum value for measurement.0Min
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Delta (DEL)6.4.8.7.

Table 6.4.8.7-1 Configurable DEL properties for OPC servers with Modbus device
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

61850-TypeDEL61850-Type

Sub-Type

Sub type for DEL.DEL full

DEL simple

Default: DEL full

Sub Type

Phase AB
Addresses

Holding or input register address for the
phase AB angle. Holding register (4X ref-
erence) address range 40001 to 49999 or
input register (3X reference) address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase AB Angle

Data format for phase AB angle.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Phase AB Angle
Format

Holding or input register address for the
phase AB Magnitude. Holding register (4X
reference) address range 40001 to 49999
or input register (3X reference) address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase AB Mag-
nitude
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Data format for phase AB magnitude.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Phase AB Mag-
nitude Format

Phase BC
Addresses

Holding or input register address for the
phase BC angle. Holding register (4X ref-
erence) address range 40001 to 49999 or
input register (3X reference) address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase BC Angle

Data format for phase BC angle.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Phase BC Angle
Format

Holding or input register address for the
phase BC magnitude. Holding register (4X
reference) address range 40001 to 49999
or input register (3X reference) address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase BC Mag-
nitude
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Data format for phase BC magnitude.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Phase BC Mag-
nitude Format

Phase CA
Addresses

Holding or input register address for the
phase CA angle. Holding register (4X ref-
erence) address range 40001 to 49999 or
input register (3X reference) address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase CA Angle

Data format for phase CA angle.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Phase CA Angle
Format

Holding or input register address for the
phase CA magnitude. Holding register (4X
reference) address range 40001 to 49999
or input register (3X reference) address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase CA Mag-
nitude
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Data format for phase CA magnitude.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Phase CA Mag-
nitude Format

Scale and Unit

Specifies the multiplier for current SI unit.Default: KiloMultiplier

Scale used for the measurements.Default: NoneScale

SI unit for measurement as described in
IEC 61850.

Default: VoltUnit

Phase Limit Value
Supervision

High limit for measurement. Event is cre-
ated, when value crosses the limit.

Default: 0High

High-high limit for measurement. Event is
created, when value crosses the limit.

Default: 0High-High

Low limit for measurement. Event is cre-
ated, when value crosses the limit.

Default: 0Low

Low-low limit for measurement. Event is
created, when value crosses the limit.

Default: 0Low-Low

Maximum value for measurement.20000Max

Minimum value for measurement.0Min

Controllable double point (DPC)6.4.8.8.

Controllable Double Point (DPC) for OPC servers with Modbus IED supports the fol-
lowing subtypes:

• BIT_DO
• SACE
• GENERIC_CONTROL
• BIT_DPU_SBO
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• BIT_DPU_MCD_SBO
• BIT_DPU_IN_REGISTER_SBO

Table 6.4.8.8-1 Configurable DPC properties for OPC servers with Modbus device
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

61850-TypeDPC61850-Type

Sub-Type

Sub type for command.BIT_DO

SACE

Sub Type

Addresses

Holding register address for the control.
Holding register (4x reference) address
range 40001 to 49999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Address For Com-
mand

Holding or input register address for the
open, close, and intermediate indication.
Holding register = 4x reference address
range 40001 to 49999 or input register =
3x reference address range 30001 to
39999. Address 0 equals to no information
available.

0 to 65535

Default: 0

Address For Status
and Intermediate

Bit mask for intermediate status.0 to 65535

Default: 0

Bit Mask For Inter-
mediate Status

Bit mask for status.0 to 65535

Default: 0

Bit Mask For Status

Close command type.0 to 65535

Default: 0

Close Command
Type

Coil address for the close control. Coil (0X
reference) address range 1 to 9999.
Address 0 equals to no information avail-
able.

0 to 65535

Default: 0

Close Control Coil

Coil or input address for the close indica-
tion. Coil (0X reference) address range 1
to 9999 or input (1X reference) address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Close Indication
Coil/Input

Command parameter.0 to 65535

Default: 0

Command Para-
meter
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Coil or input address for the fail indication
(optional). Coil (0X reference) address
range 1 to 9999 or input (1X reference)
address range 10001 to 19999. Address
0 equals to no information available.

0 to 65535

Default: 0

Fail Indication
Coil/Input

Open command type.0 to 65535

Default: 0

Open Command
Type

Coil address for the open control. Coil (0X
reference) address range 1 to 9999.
Address 0 equals to no information avail-
able.

0 to 655359

Default: 0

Open Control Coil

Coil or input address for the open indica-
tion. Coil (0X reference) address range 1
to 9999 or input (1X reference) address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Open Indication
Coil/Input

Table 6.4.8.8-2 Configurable DPC properties for OPC servers with Modbus device,
subtype GENERIC_CONTROL

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeDPC61850-Type

GENERIC_CONTROLSubtype

Addresses

starting address of password 10 to 65535

Up to 4 ASCII Characters Left-
most Digits

Address for pass-
word 1

Starting address of password 20 to 65535

Up to 4 ASCII Characters
rightmost Digits

Address for pass-
word 2

IED device password. Default is empty
string. This password is written to up to 2
register starting from the one specified
from Address for password 1.

Example: 1234

Default: empty string.Password 1

IED device password. Default is empty
string. This password is written to up to 2
register starting from the one specified
from Address for password 2.

Example: 1234

Default: empty string.Password 2
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Change initiate input mask for open com-
mand. Coil/Holding/Extend register.

Address 0 equals to no information avail-
able (0 to 65535)

0 to 65535Open Control
Address

Value written to open control address.

Example:

1 = Control bit state

0 = No Control

0 to 65535

Default: 1

Open Control Value

Confirm initiate input mask for open com-
mand. Coil/Holding/Extend register.

Address 0 equals to no information avail-
able (0 to 65535)

0 to 65535Open Confirm
Address

Value written to open confirms address.

Example:

1 = Control bit state

0 = No Control

0 to 65535

Default: 1

Open Confirm Value

Execute register for open command.

Coil/Holding/Extend register.

Address 0 equals to no information avail-
able (0 to 65535)

0 to 65535Open Execute
Address

Value written to open executes address.

Example:

1 = Execute

0 = No Action

0 to 65535

Default: 1

Open Execute
Value

Initiate input mask for open command.
Coil/Holding/Extend register.

Address 0 equals to no information avail-
able (0 to 65535)

0 to 65535

Default: 0

Open Control 4

Value to write to control 4 address0 to 65535

Default: 1

Open Control 4

Initiate input mask for open command.
Coil/Holding/Extend register.

Address 0 equals to no information avail-
able (0 to 65535)

0 to 65535

Default: 0

Open Control 5
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Value to write to control 5 address0 to 65535

Default: 1

Open Control 5
value

Change initiate input mask for close com-
mand. Coil/Holding/Extend register.

Address 0 equals to no information avail-
able (0 to 65535)

0 to 65535Close Control
Address

Value written to Close control address.

Example:

1 = Control bit state

0 = No Control

0 to 65535

Default: 1

Close Control Value

Confirm initiate input mask for Close
command. Coil/Holding/Extend register.

Address 0 equals to no information avail-
able (0 to 65535)

0 to 65535Close Confirm
Address

Value written to Close confirms address.

Example:

1 = Control bit state

0 = No Control

0 to 65535

Default: 1

Close Confirm Vale

Execute register for Close command.
Coil/Holding/Extend register.

Address 0 equals to no information avail-
able (0 to 65535)

0 to 65535Close Execute
Address

Value written to Close executes address.

Example:

1 = Execute

0 = No Action

0 to 65535

Default: 1

Close Execute
Value

Address 0 equals to no information avail-
able (0 to 65535)

0 to 65535

Default: 0

Close Control 4

Value to write to control 4 address0 to 65535

Default: 1

Close Control 4
value

Initiate input mask for open command.
Coil/Holding/Extend register.

Address 0 equals to no information avail-
able (0 to 65535)

0 to 65535

Default: 0

Close Control 5
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Value to write to control 5 address0 to 65535

Default: 1

Close Control 5
value

7 = Last Order of execution in a command
chain (Password, Control, Confirm,
Execute, Command 4, Command 5)

0 = Not in use. (When this value is 0,
password 2 is not used)

1 = First in command chain

2 = Second

3 = Third

4 = Forth

5 = Fifth

6 = Sixth

0 to 7

Default: 1

Password 1 ordinal

7 = Last Order of execution in a command
chain (Password, Control, Confirm,
Execute, Command 4, Command 5)

0 = Not in use. (When this value is 0,
password 2 is not used)

1 = First in command chain

2 = Second

3 = Third

4 = Forth

5 = Fifth

6 = Sixth

0 to 7

Default: 2

Password 2 ordinal
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

7 = Last Order of execution in a command
chain (Password, Control, Confirm,
Execute, Command 4, Command 5)

0 = Not in use. (When this value is 0, initi-
ate input mask is not used)

1 = First in command chain

2 = Second

3 = Third

4 = Forth

5 = Fifth

6 = Sixth

0 to 7

Default: 3

Control ordinal

7 = Last Order of execution in a command
chain (Password, Control, Confirm,
Execute, Command 4, Command 5)

0 = Not in use. (When this value is 0, initi-
ate input mask is not used)

1 = First in command chain

2 = Second

3 = Third

4 = Forth

5 = Fifth

6 = Sixth

0 to 7

Default: 4

Confirm ordinal

7 = Last Order of execution in a command
chain (Password, Control, Confirm,
Execute, Command 4, Command 5)

0 = Not in use. (When this value is 0, initi-
ate input mask is not used)

1 = First in command chain

2 = Second

3 = Third

4 = Forth

5 = Fifth

6 = Sixth

0 to 7

Default: 5

Execute ordinal
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

7 = Last Order of execution in a command
chain (Password, Control, Confirm,
Execute, Command 4, Command 5)

0 = Not in use. (When this value is 0,
command 4 initiate input mask is not used)

1 = First in command chain

2 = Second

3 = Third

4 = Forth

5 = Fifth

6 = Sixth

0 to 7

Default: 0

Command 4 ordinal

7 = Last Order of execution in a command
chain (Password, Control, Confirm,
Execute, Command 4, Command 5)

0 = Not in use. (When this value is 0,
command 5 initiate input mask is not used)

1 = First in command chain

2 = Second

3 = Third

4 = Forth

5 = Fifth

6 = Sixth

0 to 7

Default: 0

Command 5 ordinal

Coil/Input/Holding register address. Coil
= 0x reference address range 1 to 9999
Or input = 1x reference address range
10001 to 19999 Or holding register = 4x
reference range 40001 to 49999 or Input
register = 3x reference address range
30001 to 39999. Address 0 equals to no
information available (0 to 65535)

0 to 65535

Default: 0

Address For Fail
Alarm

Coil/Input/Holding register address. Coil
= 0x reference address range 1 to 9999
Or input = 1x reference address range
10001 to 19999 Or holding register = 4x
reference range 40001 to 49999 or Input
register = 3x reference address range
30001 to 39999. Address 0 equals to no
information available (0 to 65535)

0 to 65535

Default

Address For Inverse
Status

173

COM600 series 5.11MRS758689

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Coil/Input/Holding register address. Coil
= 0x reference address range 1 to 9999
Or input = 1x reference address range
10001 to 19999 Or holding register = 4x
reference range 40001 to 49999 or Input
register = 3x reference address range
30001 to 39999. Address 0 equals to no
information available (0 to 65535)

0 to 65535

Default

Address For Status

Bit mask for fail alarm0 to 65535

Default

Bit Mask for Fail
Alarm

Bit mask for inverse status0 to 65535

Default

Bit Mask for Inverse
status

Bit mask for status0 to 65535

Default

Bit Mask for status

Table 6.4.8.8-3 Configurable DPC properties for OPC servers with Modbus device,
subtype BIT_DPU_SBO/ BIT_DPU_MCD_SBO

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeDPC61850-Type

BIT_DPU_SBO

BIT_DPU_MCD_SBO

Subtype

Addresses

Holding address for the Vendor name.
Holding register = 4x reference address
range 40001 to 49999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Address For Control
Register

Holding address for the Vendor name.
Holding register = 4x reference address
range 40001 to 49999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Address For Con-
firm Register

Holding address for the Vendor name.
Holding register = 4x reference address
range 40001 to 49999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Address For
Execute Register

Open command type0 to 65535

Default: 0

Open command
value

Close command type0 to 65535

Default: 0

Close command
value
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Coil or input address for the indication.
Coil = 0X reference address range 1 to
9999 or input = 1X reference address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Status Coil/Input

Coil or input address for the indication.
Coil = 0X reference address range 1 to
9999 or input = 1X reference address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Inverse status
Coil/Input

Coil or input address for the indication.
Coil = 0X reference address range 1 to
9999 or input = 1X reference address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Fail alarm Coil/Input

Holding address for indication. Holding
register = 4x reference address range
40001 to 49999. Address 0 equals to no
information available.

0 to 65535

Default: 0

Address for status

Status bit mask0 to 65535

Default: 0

Bit mask of status

Bit mask0 to 65535

Default: 0

Bit mask

Holding address for password 1. Holding
register = 4x reference address range
40001 to 49999. Address 0 equals to no
information available.

0 to 65535

Default: 0

Address for Pass-
word 1

Holding address for password 2. Holding
register = 4x reference address range
40001 to 49999. Address 0 equals to no
information available.

0 to 65535

Default: 0

Address for Pass-
word 2

IED device 4 character password. Default
is empty string.

Default: empty string.

Length: 4 characters

Password

Table 6.4.8.8-4 Configurable DPC properties for OPC servers with Modbus device,
subtype BIT_DPU_IN_REGISTER_SBO

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeDPC61850-Type

BIT_DPU_IN_REGISTER_SBOSubtype

Addresses
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Holding address for the Vendor name.
Holding register = 4x reference address
range 40001 to 49999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Address For Control
Register

Holding address for the Vendor name.
Holding register = 4x reference address
range 40001 to 49999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Address For Con-
firm Register

Holding address for the Vendor name.
Holding register = 4x reference address
range 40001 to 49999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Address For
Execute Register

Open command type0 to 65535

Default: 1

Open command
value

Close command type0 to 65535

Default: 2

Close command
value

Coil or input address for the indication.
Coil = 0X reference address range 1 to
9999 or input = 1X reference address
range 10001 to 19999. Address 0 equals
to no information available

0 to 65535

Default: 0

Status Coil/Input

Coil or input address for the indication.
Coil = 0X reference address range 1 to
9999 or input = 1X reference address
range 10001 to 19999. Address 0 equals
to no information available

0 to 65535

Default: 0

Inverse status
Coil/Input

Coil or input address for the indication.
Coil = 0X reference address range 1 to
9999 or input = 1X reference address
range 10001 to 19999. Address 0 equals
to no information available

0 to 65535

Default: 0

Fail alarm Coil/Input

Bit mask for status0 to 65535

Default: 0

Bit mask for status

Bit mask for inverse status0 to 65535

Default: 0

Bit mask for inverse
status

Bit mask for fail alarms0 to 65535

Default: 0

Bit mask for fail
alarms

Holding address for indication. Holding
register = 4x reference address range
40001 to 49999. Address 0 equals to no
information available

0 to 65535

Default: 0

Address for status

176

1MRS758689COM600 series 5.1

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Status bit mask0 to 65535

Default: 0

Bit mask of status

0 to 65535

Default: 0

Bit mask

Holding address for in password 1. Holding
register = 4x reference address Range
40001 to 49999. Address 0 equals to no
information available.

0 to 65535

Default: 0

Address for Pass-
word 1

Holding address for in password 2. Holding
register = 4x reference address Range
40001 to 49999. Address 0 equals to no
information available.

0 to 65535

Default: 0

Address for Pass-
word 2

IED device 4 character password. Default
is empty string.

Default: empty string.

Length: 4 characters

Password

Device name plate (DPL)6.4.8.9.

Device Name Plate (DPL) for OPC server with Modbus IED supports two subtypes:

• PLATE_FIXED
• PLATE_IED_DPU

Table 6.4.8.9-1 Configurable DPL properties for OPC servers with Modbus device,
subtype PLATE_FIXED

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeDPL61850-Type

PLATE_FIXEDSub Type

Vendor

Vendor as text.Vendor

Hardware revision

Hardware revision as text.Hardware Revision

Software Revision

Software revision as text.0Software Revision

Serial Number

Serial number as text.0Serial Number

Location
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Location as text.Location

Table 6.4.8.9-2 Configurable DPL properties for OPC servers with Modbus device,
subtype PLATE_FIXED

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeDPL61850-Type

PLATE_IED_DPUSub Type

Address

Holding address for the Serial number.
Holding register = 4x reference address
range 40001 - 49999 . Address 0 equals
to no information available.

40001 - 49999Leftmost Register
for Vendor name

Holding address for the Serial number.
Holding register = 4x reference address
range 40001 - 49999 . Address 0 equals
to no information available.

40001 - 49999Rightmost Register
for Vendor name

Holding address for the Serial number.
Holding register = 4x reference address
range 40001 - 49999 . Address 0 equals
to no information available.

40001 - 49999Hardware Revision
Address

Holding address for the Serial number.
Holding register = 4x reference address
range 40001 - 49999 . Address 0 equals
to no information available.

40001 - 49999Software Revision
Address

Holding address for the Serial number.
Holding register = 4x reference address
range 40001 - 49999 . Address 0 equals
to no information available.

40001 - 49999Serial Number
Address

Data format for the indicationWord

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Topic format
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Holding address for the Serial number.
Holding register = 4x reference address
range 40001 - 49999 . Address 0 equals
to no information available.

40001 - 49999Leftmost register for
Vendor location

Holding address for the Serial number.
Holding register = 4x reference address
range 40001 - 49999 . Address 0 equals
to no information available.

40001 - 49999Rightmost register
for Vendor location

Scale to be used with the indication valueLookup table scale

Stepwise Linear scale

Default: NONE

Indication scale

Double point status (DPS)6.4.8.10.

Double Point Status (DPS) for OPC server with Modbus IED supports the following
subtypes:

• BIT
• BIT_IN_REGISTER_WITH_INTERMEDIATE_BIT
• BIT_DPU
• BIT_DPU_MCD
• BIT_DPU_INREGISTER

Table 6.4.8.10-1 Configurable DPS properties for OPC servers with Modbus device,
subtype BIT, BIT_IN_REGISTER_WITH_INTERMEDIATE_BIT, BIT_DPU,
BIT_DPU_MCD

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeDPS61850-Type

BIT

BIT_DPU

BIT_DPU_MCD

BIT_IN_REGISTER_WITH_INTER-
MEDIATE_BIT

BIT_DPU_INREGISTER

Subtype

Addresses

Address for status and intermediate.0 - 65535

Default: 0

Address For Status
and Intermediate
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Bit mask for fail alarm0 - 65535

Default 0

Bit Mask for Fail
Alarm

Bit mask for inverse status0 - 65535

Default 0

Bit Mask for Inverse
status

Bit mask for intermediate status.0 - 65535

Default: 0

Bit Mask For Inter-
mediate Status

Bit mask for status.0 - 65535

Default: 0

Bit Mask For Status

Coil or input address for the close indica-
tion. Coil (0X reference) address range 1
- 9999 or input (1X reference) address
range 10001 - 19999 . Address 0 equals
to no information available.

0 - 65535

Default: 0

Close Indication
Coil/Input

Holding address for the Fail alarm. Holding
register = 4x reference address range
40001 - 49999 .

Address 0 equals to no information avail-
able.

0 - 65535

Default 0

Fail Alarm register

Coil or input address for the fail indication
(optional). Coil (0X reference) address
range 1 - 9999 or input (1X reference)
address range 10001 - 19999 . Address
0 equals to no information available.

0 - 65535

Default: 0

Fail Indication
Coil/Input

Holding address for the Fail alarm. Holding
register = 4x reference address range
40001 - 49999 .

Address 0 equals to no information avail-
able.

0 - 65535

Default 0

Indication Register

Holding address for the Fail alarm. Holding
register = 4x reference address range
40001 - 49999 .

Address 0 equals to no information avail-
able.

0 - 65535Inverse status
register

Coil or input address for the open indica-
tion. Coil (0X reference) address range 1
- 9999 or input (1X reference) address
range 10001 - 19999 . Address 0 equals
to no information available.

0 - 65535

Default: 0

Open indication
Coil/Input
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Table 6.4.8.10-2 Configurable DPS properties for OPC servers with Modbus device,
subtype BIT_DPU_IN_REGISTER

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeDPS61850-Type

BIT_DPU_IN_REGISTERSubtype

Addresses

Bit mask for fail alarm0 - 65535

Default 0

Bit Mask for Fail
Alarm

Bit mask for inverse status0 - 65535

Default 0

Bit Mask for Inverse
status

Bit mask for status.0 - 65535

Default: 0

Bit Mask For Status

Holding address for the Fail alarm. Holding
register = 4x reference address range
40001 - 49999 .

Address 0 equals to no information avail-
able.

0 - 65535

Default 0

Fail Alarm register

Holding address for the Fail alarm. Holding
register = 4x reference address range
40001 - 49999 .

Address 0 equals to no information avail-
able.

0 - 65535

Default 0

Indication Register

Holding address for the Fail alarm. Holding
register = 4x reference address range
40001 - 49999 .

Address 0 equals to no information avail-
able.

0 - 65535Inverse status
register

Controllable integer status (INC)6.4.8.11.

Controllable Integer Status (INC) for OPC server with Modbus IED supports the following
subtypes:

• REGISTER_BASED_CONTROL
• DPU_REGISTER_BASED_CONTROL

181

COM600 series 5.11MRS758689

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



Table 6.4.8.11-1 Configurable INC properties for OPC servers with Modbus device,
subtype REGISTER_BASED_CONTROL

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeINC61850-Type

REGISTER_BASED_CON-
TROL

Subtype

Addresses

Holding register address for the control.
Holding register (4X reference) address
range 40001 - 49999 . Address 0 equals
to no information available.

0 - 65535

Default: 0

Control Register

Data format of the control and the indica-
tion.

Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Format

Holding or input register address for the
indication. Holding register (4X reference)
address range 40001 - 49999 or input
register (3X reference) address range
30001 - 39999 . Address 0 equals to no
information available.

0 - 65535

Default: 0

Indication Register

Scale and Unit

Scale to be used with the indication value.Default: NoneIndication Scale

Table 6.4.8.11-2 Configurable INC properties for OPC servers with Modbus device,
subtype DPU_REGISTER_BASED_CONTROL

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeINC61850-Type

DPU_REGISTER_BASED_CON-
TROL

Subtype

Addresses
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

6x extended control register. Extended
register (6x reference) address range
60001 - 65535 . Address 0 equals to no
information available (0 - 65535 )

0 - 65535

Default: 0

Control register

6x extended control register. Extended
register (6x reference) address range
60001 - 65535 . Address 0 equals to no
information available (0 - 65535 )

0 - 65535

Default: 0

Execute register

6x extended control register. Extended
register (6x reference) address range
60001 - 65535 . Address 0 equals to no
information available (0 - 65535 )

0 - 65535

Default: 0

Indication register

Data format for the indicationWord

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Format

6x extended register. Extended register
(6x reference) address range 60001 -
65535 . Address 0 equals to no information
available (0 - 65535 )

60001 – 65535

ASCII – 2 Characters Leftmost
Digits

Address for pass-
word 1

6x extended register. Extended register
(6x reference) address range 60001 -
65535 . Address 0 equals to no information
available (0 - 65535 )

60001 – 65535

ASCII – 2 Characters Leftmost
Digits

Address for pass-
word 2

IED device 4 character password. Default
is empty string.

Default: empty string.

Length: 4 characters

Password

Integer status (INS)6.4.8.12.

Table 6.4.8.12-1 Configurable INS properties for OPC servers with Modbus device
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

61850-TypeINS61850-Type
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Addresses

Data format of the indication.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Format

Holding or input register address for the
indication. Holding register (4X reference)
address range 40001 - 49999 or input
register (3X reference) address range
30001 - 39999 . Address 0 equals to no
information available.

0 - 65535

Default: 0

Indication Register

Scale and Unit

Scale to be used with the indication value.Default: NoneScale

Integer controlled step position information (ISC)6.4.8.13.

Integer controlled step position information (ISC) for OPC server with Modbus IED
supports the following subtypes:

• REGISTER_BASED_CONTROL
• DPU_REGISTER_BASED_CONTROL

Table 6.4.8.13-1 Configurable ISC properties for OPC servers with Modbus device,
subtype REGISTER_BASED_CONTROL

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeISC61850-Type

REGISTER_BASED_CON-
TROL

Subtype

Addresses
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Holding register address for the control.
Holding register (4X reference) address
range 40001 - 49999 . Address 0 equals
to no information available.

0 - 65535

Default: 0

Control Register

Data format of the control and the indica-
tion.

Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Format

Holding or input register address for the
indication. Holding register (4X reference)
address range 40001 - 49999 or input
register (3X reference) address range
30001 - 39999 . Address 0 equals to no
information available.

0 - 65535

Default: 0

Indication Register

Scale and Unit

Scale to be used with the indication.Default: NoneIndication Scale

Table 6.4.8.13-2 Configurable ISC properties for OPC servers with Modbus device,
subtype DPU_REGISTER_BASED_CONTROL

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeISC61850-Type

DPU_REGISTER_BASED_CON-
TROL

Subtype

Addresses

6x extended control register. Extended
register (6x reference) address range
60001 - 65535 . Address 0 equals to no
information available (0 - 65535 )

0 - 65535

Default: 0

Control register

6x extended control register. Extended
register (6x reference) address range
60001 - 65535 . Address 0 equals to no
information available (0 - 65535 )

0 - 65535

Default: 0

Execute register
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

6x extended control register. Extended
register (6x reference) address range
60001 - 65535 . Address 0 equals to no
information available (0 - 65535 )

0 - 65535

Default: 0

Indication register

Data format for the indicationWord

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Format

6x extended register. Extended register
(6x reference) address range 60001 -
65535. Address 0 equals to no information
available (0 - 65535 )

60001 – 65535

ASCII – 2 Characters Leftmost
Digits

Address for pass-
word 1

6x extended register. Extended register
(6x reference) address range 60001 -
65535 . Address 0 equals to no information
available (0 - 65535 )

60001 – 65535

ASCII – 2 Characters Leftmost
Digits

Address for pass-
word 2

IED device 4 character password. Default
is empty string.

Default: empty string.

Length: 4 characters

Password

Logical node name plate (LPL)6.4.8.14.

Table 6.4.8.14-1 Configurable LPL properties for OPC servers with Modbus device
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

61850-TypeLPL61850-Type

PLATE_FIXEDSub Type

Vendor

Vendor as text.Vendor

Software Revision

Software revision as textDefault: 0Software Revision
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Table 6.4.8.14-2 Configurable LPL properties for OPC servers with Modbus device,
subtype PLATE_IED_DPU

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeLPL61850-Type

PLATE_IED_DPUSub Type

Addresses

Holding address for the Serial number.
Holding register = 4x reference address
range 40001 - 49999 .

Address 0 equals to no information avail-
able.

40001 - 49999Leftmost register for
Vendor location

Holding address for the Serial number.
Holding register = 4x reference address
range 40001 - 49999 .

Address 0 equals to no information avail-
able.

40001 - 49999Rightmost register
for Vendor location

Holding address for the Serial number.
Holding register = 4x reference address
range 40001 - 49999 .

Address 0 equals to no information avail-
able.

40001 to 49999Software Revision
Address

Scale to be used with the indication valueDefault: noneIndication scale

Measured value (MV)6.4.8.15.

Table 6.4.8.15-1 Configurable MV properties for OPC servers with Modbus device
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

61850-TypeMV61850-Type

Sub-Type

Sub type for MV/CMV.MV/CMV simple

MV_LIMIT_CHECK

Default: MV/CMV simple

Sub Type

Addresses
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Data format of the value.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Measurement
Format

Holding or input register address for the
measurement. Holding register (4X refer-
ence) address range 40001 to 49999 or
input register (3X reference) address
range 30001 to 39999. Address 0 equals
to no information available. If format
requiring two registers is used, then the
lower address must be entered.

0 to 65535

Default: 0

Measurement
Register

Scale and Unit

Specifies the multiplier for current SI unit.Default: DekaMultiplier

Scale used with this type.Default: NoneScale

SI unit for measurement as described in
IEC 61850.

Default: DimensionlessUnit

Limit Value Super-
vision

Maximum value for measurement.20000Max

Minimum value for measurement.0Min

Controllable single point (SPC)6.4.8.16.

Controllable single point (SPC) for OPC server with Modbus IED supports the following
subtypes:

• BIT_DO
• SACE
• BIT_DPU_SBO
• BIT_DPU_MCD_SBO
• BIT_DPU_IN_REGISTER_SBO
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Table 6.4.8.16-1 Configurable SPC properties for OPC servers with Modbus device,
subtype BIT_DO, and SACE

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeSPC61850-Type

Sub-Type

Sub type of object.BIT_DO

SACE

Sub Type

Addresses

Address for command.0 to 65535

Default: 0

Address For Com-
mand

Address for status.0 to 65535

Default: 0

Address For Status

Bit mask for status.0 to 65535

Default: 0

Bit Mask For Status

Command parameter.0 to 65535

Default: 0

Command Para-
meter

Coil address for the control. Coil (0X refer-
ence) address range 1 to 9999. Address
0 equals to no information available.

0 to 65535

Default: 0

Control Coil

Coil or input address for the indication.
Coil = 0X reference address range 1 to
9999 or input = 1X reference address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Indication Coil/Input

Command type for OFF command.0 to 65535

Default: 0

Off Command Type

Command type for ON command.0 to 65535

Default: 0

On Command Type

Table 6.4.8.16-2 Configurable SPC properties for OPC servers with Modbus device,
subtype BIT_DPU_SBO, BIT_DPU_MCD_SBO, and BIT_DPU_IN_REGISTER_SBO

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeSPC61850-Type
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

BIT_DPU_SBO

BIT_DPU_MCD_SBO

BIT_DPU_IN_REGISTER_SBO

SACE

Subtype

Holding address for the Vendor name.
Holding register = 4x reference address
range 40001 to 49999.

Address 0 equals to no information avail-
able

0 to 65535

Default: 0

Address For Control
Register

Holding address for the Vendor name.
Holding register = 4x reference address
range 40001 to 49999.

Address 0 equals to no information avail-
able

0 to 65535

Default: 0

Address For Con-
firm Register

Holding address for the Vendor name.
Holding register = 4x reference address
range 40001 to 49999.

Address 0 equals to no information avail-
able

0 to 65535

Default: 0

Address For
Execute Register

Open command type0 to 65535

Default: 1

Open command
value

Close command type0 to 65535

Default: 2

Close command
value

Coil or input address for the indication.
Coil = 0X reference address range 1 to
9999 or input = 1X reference address
range 10001 to 19999.

Address 0 equals to no information avail-
able

0 to 65535

Default: 0

Indication Coil/Input

Holding address for indication. Holding
register = 4x reference address range
40001 to 49999.

Address 0 equals to no information avail-
able

0 to 65535

Default: 0

Address for status

Status bit mask0 to 65535

Default: 0

Bit mask of status

0 to 65535

Default: 0

Bit mask
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Holding address for password 1. Holding
register = 4x reference address range
40001 to 49999.

Address 0 equals to no information avail-
able

0 to 65535

Default: 0

Address for Pass-
word 1

Holding address for password 2. Holding
register = 4x reference address range
40001 to 49999.

Address 0 equals to no information avail-
able

0 to 65535

Default: 0

Address for Pass-
word 2

IED device 4 character password. Default
is empty string.

Default: empty string.

Length: 4 characters

Password

Single point status (SPS)6.4.8.17.

Single Point Status (SPS) for OPC server with Modbus IED supports the following
subtypes:

• BIT
• BIT_DPU_MCD
• BIT_IN_REGISTER

Table 6.4.8.17-1 Configurable SPS properties for OPC servers with Modbus device,
subtype BIT AND BIT_IN_REGISTER

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeSPS61850-Type

Sub type for SPS.BIT

BIT_IN_REGISTER

Default: BIT

Sub-Type

Addresses

Coil or input address for the indication.
Coil (0X reference) address range 1 to
9999 or input (1X reference) address
range 10001 to 19999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Indication Coil/Input
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Table 6.4.8.17-2 Configurable SPS properties for OPC servers with Modbus device,
subtype BIT_DPU_MCD

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeSPS61850-Type

BIT

BIT_DPU_MCD

Subtype

Coil or input address for the indication.
Coil = 0X reference address range 1 to
9999 or input = 1X reference address
range 10001 to 19999

Address 0 equals to no information avail-
able

0 to 65535

Default: 0

Indication Coil/Input

Bit mask for indication0 to 65535Bit mask

WYE6.4.8.18.

Table 6.4.8.18-1 Configurable WYE properties for OPC servers with Modbus device
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

61850-TypeWYE61850-Type

Sub Type

Sub type for WYE.WYE full

WYE simple

Default: WYE full

Sub Type

Phase A
Addresses

Holding or input register address for the
phase A angle. Holding register = 4X ref-
erence address range 40001 to 49999 or
input register = 3X reference address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase A Angle
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Data format for Phase A angle.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Phase A Angle
Format

Holding or input register address for the
Phase A magnitude. Holding register = 4X
reference address range 40001 to 49999
or input register = 3X reference address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase A Magnitude

Data format for Phase A Magnitude.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Phase A Magnitude
Topic Format

Phase B
Addresses

Holding or input register address for the
Phase B angle. Holding register = 4X ref-
erence address range 40001 to 49999 or
input register = 3X reference address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase B Angle
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Data format for Phase B angle.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Phase B Angle
Format

Holding or input register address for the
Phase B magnitude. Holding register = 4X
reference address range 40001 to 49999
or input register = 3X reference address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase B Magnitude

Data format for Ib magnitude.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Phase B Magnitude
Topic Format

Phase C
Addresses

Holding or input register address for the
Phase C angle. Holding register = 4X ref-
erence address range 40001 to 49999 or
input register = 3X reference address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase B Angle
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Data format for phase C angle.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Phase C Angle
Format

Holding or input register address for the
Phase C magnitude. Holding register = 4X
reference address range 40001 to 49999
or input register = 3X reference address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Phase C Magnitude

Data format for Ic magnitude.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Phase C Magnitude
Topic Format

Neural Addresses

Holding or input register address for the
neutral angle. Holding register = 4X refer-
ence address range 40001 to 49999 or
input register = 3X reference address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Neutral Angle
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Data format for neutral angle.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Neutral Angle
Format

Holding or input register address for the
Neutral magnitude. Holding register = 4X
reference address range 40001 to 49999
or input register = 3X reference address
range 30001 to 39999. Address 0 equals
to no information available.

0 to 65535

Default: 0

Neutral Magnitude

Data format for In magnitude.Default

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Neutral Magnitude
Topic Format

Scale and Unit

Specifies the multiplier for current SI unit.Default: DekaNeutral Multiplier

Scale for neutral to be used with this data
object.

Default: NoneNeutral Scale

Unit for neutral.Default: DimensionlessNeutral Unit

Scale used with ABC phases.Default: NonePhase ABC Scale

Unit for ABC phases.Default: DimensionlessPhase ABC Unit

Specifies the multiplier for current SI unit.Default: DekaPhase Multiplier

Phase Limit Value
Supervision
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

High limit measurement. Event is created,
when value crosses the limit.

0High

High-high limit for measurement. Event is
created, when value crosses the limit.

0High-High

Low limit for measurement. Event is cre-
ated, when value crosses the limit.

0Low

Low-low limit for measurement. Event is
created, when value crosses the limit.

0Low-Low

Maximum value for measurement.20000Max

Minimum value for measurement.0Min

Neutral Limit Value
Supervision

High limit for measurement. Event is cre-
ated, when value crosses the limit.

0Neutral High

High-high limit for measurement. Event is
created, when value crosses the limit.

0Neutral High-High

Low limit for measurement. Event is cre-
ated, when value crosses the limit.

0Neutral Low

Low-low limit for measurement. Event is
created, when value crosses the limit.

0Neutral Low-Low

Maximum value for measurement.20000Neutral Max

Minimum value for measurement.0Neutral Min

Controllable Enumerated Status (ENC)6.4.8.19.

Controllable Enumerated Status (ENC) for OPC server with Modbus IED supports the
following subtypes:

• REGISTER_BASED_CONTROL
• DPU_REGISTER_BASED_CONTROL

Table 6.4.8.19-1 Configurable ENC properties for OPC servers with Modbus device,
subtype REGSITER_BASED_CONTROL

DescriptionValue or Value range/ DefaultProperty/Para-
meter

Basic

61850-TypeENC61850-Type

REGISTER_BASE_CONTROLSubtype

Addresses
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DescriptionValue or Value range/ DefaultProperty/Para-
meter

Holding register address for the control.
Holding register (4X reference) address
range 40001-49999. Address 0 equals no
information available.

0-65535

Default: 0

Control Register

Data format of the control and the indica-
tion.

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Format

Holding register address for indication.
Holding register (4X reference) address
range 40001-49999. Address 0 equals no
information available.

0-65535

Default: 0

Indication Register

Scale and unit

Scale to be used with the indication value.Default: None.Indication Scale

Table 6.4.8.19-2 Configurable ENC properties for OPC servers with Modbus device,
subtype DPU_REGISTER_BASED_CONTROL

DescriptionValue or Value range/ DefaultProperty/Para-
meter

Basic

61850-TypeENC61850-Type

REGISTER_BASE_CONTROLSubtype

Addresses

6x register address for control command.
Extended register (6X reference) address
range 60001…65535. Address 0 equals
to no information available.

0…65535

Default: 0

Control Register

6x register address for execute command.
Extended register (6X reference) address
range 60001…65535. Address 0 equals
to no information available.

0…65535

Default: 0

Execute Register
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DescriptionValue or Value range/ DefaultProperty/Para-
meter

Data format of the control and the indica-
tion.

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Format

6x register address for indication register.
Extended register (6X reference) address
range 60001…65535. Address 0 equals
to no information available.

0-65535

Default: 0

Indication Register

Password

6x register address for password 1.
Extended register (6X reference) address
range 60001…65535. Address 0 equals
to no information available.

0-65535

Default: 0

Address for pass-
word 1

6x register address for password 2.
Extended register (6X reference) address
range 60001…65535. Address 0 equals
to no information available.

0-65535

Default: 0

Address for pass-
word 2

Four character password. Default is empty
string.

Password

Scale and Unit

Scale to be used with the indication value.Default: None.Indication Scale

Enumerated Status (ENS)6.4.8.20.

Table 6.4.8.20-1 Configurable ENS properties for OPC servers with Modbus device
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic

61850-TypeENS61850-Type

Addresses
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DescriptionValue or Value range/ DefaultProperty/Para-
meter

Data format of the control and the indica-
tion.

Word

Integer

Long MSW first

Long MSW last

Float MSW first

Float MSW last

Bit

Default: Word

Format

Holding register address for indication.
Holding register (4X reference) address
range 40001-49999. Address 0 equals no
information available.

0-65535

Default: 0

Indication Register

Scale and unit

Scale to be used with the indication value.Default: None.Indication Scale

Topic Generator6.4.9.

When data objects have been configured with Modbus addresses, use the Topic Generator
function to specify how data is requested from Modbus devices. A topic definition for
an indication address specifies start and end of address, data format, deadband, and
polling interval in milliseconds. However, a topic definition for a controllable point only
specifies address range and its data format.

To generate topic definitions:
1. Select the Communication tab on the Project Explore window.
2. Right-click a Modbus OPC Server node or a Modbus IED node and select the Topic

Generator function on the context menu.
3. Click the Generate button to make the Topic Generator function browse through

all data objects configurations and create topic definitions for the data request. If
the Topic Generator is opened from a Modbus OPC Server node, topics are generated
for all IEDs connecting to the selected server.

In most cases, modifications to the automatically generated topics are not required.
However, some topic definitions may need to be changed, polling interval for example,
for some devices to work properly.

To add a new topic:
1. Open the Topic Generator from a Modbus OPC Server node or a Modbus IED node.
2. Click the Add Topic button.
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3. Click the Add button to add the new topic to the data grid. New topic is added to
the data table and the dialog is closed.

4. Click Apply to save.

Each time a change is made to data object Modbus addresses
or a new address is added, use the Topic Generator to update
the topic definitions.

SAB600_ModbusTCP_Topic_Generator.png

Figure 6.4.9-1 Topic generator
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External OPC server configuration7.

About this section7.1.

This section guides you in the configuration tasks required before you can start using
the External OPC Server. For information on the IEC 61850 data modeling, refer to
COM600 User's Manual.

Start SAB600 to open a project. You can also open and name a new project.

1. Select File > Open/Manage Project....
2. In the Open/Manage Project dialog, select the required location for the project:

• Projects on my computer
• Projects on network

3. Select New Project on the left.
• Enter a Project Name. The Description is optional.

4. Click Create.
5. Click Open Project.

Overview of configuration7.2.

Before you can start using the External OPC Server, you need to build and configure an
object tree in SAB600 to define the Communication structure within the Gateway object.

The possible objects are:
• Gateway
• External OPC Server
• External OPC Subnetwork
• External OPC IED
• Logical Device objects
• Logical Node objects
• Data objects

When configuring OPC servers the following characters cannot
be used in object names: \ ` ' ' #
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SAB600_ExternalOPC_Example_View.png

Figure 7.2-1 Example view of SAB600

The configuration work can basically be divided into two separate tasks:
1. building an object tree, and
2. configuring object properties.

For information on how to enable configuring of OPC item paths in the data objects with
SAB600 with the OPC Browser tool, see 7.4, OPC Browser tool.

First, you need to build an object tree. This is done by adding objects to the object tree,
see 7.3.1, General information about building object tree.

Figure 7.2-1 shows an example of how the object tree may look like after it has been
built. In the example tree you can see the External OPC Server object and its child objects
like subnetworks, devices, and data objects. Indentation is used to indicate the parent-
child relationship between the objects.

After you have added the necessary objects to the object tree in the communication
structure, you need to configure them, see 7.5.1, General information about configuring
objects.

Table 7.2-1 External OPC Server related objects
DescriptionObject

An object representing the External OPC
Server.

External OP Server

Object representing a physical subnetwork.External OPC Subnetwork

The IED object presents a physical device in
the 3rd party system.

External OPC IED

An object representing a group of functions.
Each function is defined as a Logical Node. A
device consists of one or several LDs.

External OPC Logical Device (LD)
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An object defined by its data and methods. LN
is the smallest part of a function that exchanges
data.

Logical Node (LN)

Data object is an instance of one of the IEC
61850 Data Object Classes such as Single point
status and Measured Value. Depending on the
class, each data object has a set of attributes
for monitoring and controlling the object, e.g.
value, quality, and control.

Data Object (DO)

Building object tree7.3.

General information about building object tree7.3.1.

The object tree is built in the Communication structure of SAB600, see Figure 7.2-1. It
is built by adding objects in a logical order starting from the Gateway.

You have several possible ways to add objects to the object tree in the Communication
structure:
• You can right-click the object to which you want to add a child object. Then select

New > Object type group > Object name, for example New > OPC > External
OPC Server.

• You can right-click the object type and select New > New. A New Object window
appears. Select the object type you want to add and click OK or double-click it.

• You can copy the object.

Add the objects in the following order:
1. Gateway
2. External OPC Server
3. External OPC Subnetwork
4. External OPC IED
5. Logical Device objects
6. Logical Node objects
7. Data objects

Adding Gateway object7.3.2.

To start building the object tree, add a Gateway object in the Communication structure
by selecting the project name, right-click it and select New > Communication > Gate-
way.
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Adding External OPC Server object7.3.3.

After the Gateway object has successfully been added, you can continue building the
object tree by adding an External OPC Server object.

To add External OPC Server object:
1. Select the Gateway object in the communication structure and right-click it.
2. Select New > OPC > External OPC Server.

By using the SCL Import function, it is possible to import an entire server’s or individual
device's configurations without having to insert them manually. To open the SCL Import
function, right-click the desired object, and select SCL Import.

For more information about the SCL Import function, see COM600 User's Manual.

Adding External OPC subnetwork objects7.3.4.

After the server object has been successfully added, you can continue building the object
tree by adding External OPC subnetwork objects.

To add External OPC subnetwork object:
1. Select the External OPC Server object.
2. Right-click the External OPC Server object.
3. Select New > New or New > OPC > External OPC Subnetwork.

Adding external OPC IED objects7.3.5.

After adding a subnetwork you can add device objects.

To add an external subnetwork object:
1. Select a Subnetwork object.
2. Right-click on the Subnetwork object and select New > OPC > External OPC IED.

With SCL import function, you can import new objects with configurations from an
existing file. Right-click the device and select SCL Import from the shortcut menu.

To import a new configuration file:
1. Click Select File.
2. Browse to a new configuration file from the appearing dialog.
3. Select the file and click Open.
4. Select the device to import from the drop-down list. You can preview the configur-

ation on the right.
5. Click Import.

The new preconfigured objects appear in the object tree. If the configuration file is large,
the import may take time. To import a configuration file for a different device, right-
click the device, select SCL Import again and repeat the steps above.
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For more information about the SCL Import function, see COM600 User's Manual.

Adding Logical Device objects7.3.6.

To add a Logical Device object:
1. Select an External OPC IED object and right-click it.
2. Select New > New or New > Communication > External OPC LD.

Each External OPC IED must have at least one Logical Device
object as a child object.

Adding Logical Node objects7.3.7.

To add a Logical Node:
1. Select a Logical Device object and right-click it.
2. Add a Logical Node object.
3. Rename the new object. The names of the Logical Node objects have to be unique.

You should have only one Logical Node 0 (LLN0) as a child
object to a Logical Device object.

Adding data objects7.3.8.

To add a data object:
1. Select a Logical Node object and right-click it.
2. Add a data object.
3. Rename the new object. The names of the data objects have to be unique. However,

you can have a data object with same name under a different Logical Node.

OPC Browser tool7.4.

The OPC Browser tool is a standalone software that can be used to read and save the
OPC namespace of the external OPC Server that is connected to COM600. The saved
namespace information can be later used to configure the OPC item paths in the data
objects with SAB600.

1. Copy the OPC Browser tool to the computer, where the OPC Server is running. The
OPC Browser software can be found from the Utilities folder of the installation
DVD.

2. Start the OPC Browser software.
3. Click Select Server and select the OPC server from the list, see Figure 7.4-1.
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OPC_Browser_Select_Server.png

Figure 7.4-1 Select Server dialog

4. Select the items to be added to the namespace file, see Figure 7.4-2. Select All
selects all nodes in the tree. Unselect All clears all selections.

OPC_Browser_Attributes.png

Figure 7.4-2 Selecting items to the namespace file

5. In SAB600, right-click the External OPC Server object and select the External
OPC Server Ini Import, see Figure 7.4-3.
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SAB600_External_OPCServer_Ini_Import.png

Figure 7.4-3  External OPC Server Ini Import tool

6. Click Select File in the External OPC Server Ini Import tool to select the file created
with the OPC Browser.

7. Click Apply.
8. In the Data Object properties, click the button with three dots in the Control OPC

Item Path property, see Figure 7.4-4.
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SAB600_External_OPCServer_Control_OPC_Item_Path.png

Figure 7.4-4 Control OPC Item Path properties

9. A new dialog showing the namespace created with the OPC Browser opens, see
Figure 7.4-5. Select the correct OPC item from the tree view and click OK. The
path of the selected OPC item will be updated to the property.

SAB600_External_OPCServer_Path.png

Figure 7.4-5 External OCP server path
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Configuring objects7.5.

General information about configuring objects7.5.1.

After the objects have been added, configure the object properties. Figure 7.5.1-1 shows
an example of how to use SAB600 to configure the object properties for External OPC
Server.

To configure an object:
1. Select an object in the object tree of the communication structure.

• The object properties appear now in the Object Properties window. The proper-
ties and their values can be viewed as shown in Figure 7.5.1-1

SAB600_External_OPCServer_Object_Properties.png

Figure 7.5.1-1 Example of object properties in the Objects Properties window

2. Select the property you want to configure. Depending on the property value type,
configuring is always done either by
• selecting a predefined value from a drop-down menu, or
• entering a text string or a numerical value in a text field.

The available properties for different objects are listed in the following subsections.

210

1MRS758689COM600 series 5.1

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



Configuring External OPC Server properties7.5.2.

Table 7.5.2-1 External OPC Server properties
DescriptionValue or Value range/DefaultProperty/Parameter

Source OPC Server

Defines the ProgID of the
mapped server.

ProgID

Defines the remote node name
of the mapped server (IP
address).

localhostRemote Node Name

Defines the tree delimiter
mapped server uses.

Default value is "." character.Tree Delimiter

Enables the use of remote
node names.

True

False

Default: True

Use Remote Node Names

Configuring External OPC Server Subnetwork properties7.5.3.

There are no configurable subnetwork properties in the External OPC Server.

Configuring External OPC IED Device7.5.4.

Table 7.5.4-1 lists the configurable properties for virtual object presenting the possible
physical devices on the 3rd party system, and value ranges for these properties. The
actual configuration by using SAB600 is performed as described in 7.5.1, General
information about configuring objects.

Table 7.5.4-1 External OPC IED properties
DescriptionValue or Value range/

Default
Name

Basic

Specifies whether IED is in use or not.In use

Not in use

Default: In use

In Use

Defines whether IED is used in simulation mode.True

False

Default: False

Simulation
Mode
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DescriptionValue or Value range/
Default

Name

OPC path of the station remote switch position to
be used with this logical device.

The format is Node#ProgID For OPC
Server#Channel Name\IED Name\Logical Device
Name\Logical Node Name\Data Object Name

For example:

GW#ABB.conn_OPC_DA_Server.Instance[1]#Chan-
nel1\IED1\LD1\GGIO1\loc

Station/Remote
Switch OPC
Path

Defines whether device is in simulation mode.Simulation
Mode

Configuring Logical Device properties7.5.5.

Table 7.5.5-1 Logical Device properties
DescriptionValue or Value range/

Default
Property/Parameter

Basic

OPC path of the station remote switch position
to be used with this logical device.

The format is Node#ProgID For OPC
Server#Channel Name\IED Name\Logical
Device Name\Logical Node Name\Data Object
Name

For example:

GW#ABB.conn_OPC_DA_Server.Instance[1]#Chan-
nel1\IED1\LD1\GGIO1\loc

Station/Remote Switch
OPC Path

Configuring Logical Node properties7.5.6.

Table 7.5.6-1 Configuring Logical Node properties
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic

LLN0

Logical node classLLN0Logical Node Class

GGIO1
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DescriptionValue or Value range/ DefaultProperty/Parameter

Logical node classANCR, ARCO, ATCC, AVCO,
LPHD, CALH, CCGR, CILO,
CPOW, CSWI, GAPC, GGIO,
GSAL, IARC, IHMI, ITCI, ITMI,
MDIF, MHAI, MHAN, MMTR,
MMXN, MMXU, MSQI, MSTA,
PDIF, PDIR, PDIS, PDOP,
PDUP, PFRC, PHAR, PHIZ,
PIOC, PMRI, PMSS, POPF,
PPAM, PSCH, PSEF, PTEF,
PTOC, PTOF, PTOV, PTRC,
PTTR, PTUC, PTUV, PUPF,
PTUF, PVOC, PVPH, PZSU,
RDRE, RADR, RBDR, RDRS,
RBRF, RDIR, RFLO, RPSB,
RREC, RSYN, SARC, SIMG,
SIML, SPDC, XCBR, XSWI,
TCTR, TVTR, YEFN, YLTC,
YPSH, YPTR, ZAXN, ZBAT,
ZBSH, ZCAB, ZCAP, ZCON,
ZGEN, ZGIL, ZLIN, ZMOT,
ZREA, ZRRC, ZSAR, ZTCF,
ZTCR

Default: GGIO

Logical Node Class

Logical node instance numberLN Inst Range is from 1 -
2147483647

Logical Node Instance

Prefix for logical nodeDefault: NoneLogical Node Prefix

Configuring data objects for Internal OPC Data7.5.7.

General information about configuring data objects for Internal
OPC Data

7.5.7.1.

Internal data objects describe internal status information of an OPC server, for example
whether the connection between the External OPC Server and the device (IED) is
working or not. When internal information of an OPC server needs to be transferred,
that is information that does not originate from a device, to an OPC Client, virtual data
objects must be created.

The available properties for different objects are listed in the following subsections.
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Integer status (INS)7.5.7.2.

DescriptionValue or Value range/ DefaultProperty/Para-
meter

Basic

Common data class according to IEC
61850

INSCommon Data
Class

Addresses

Item tag path for the internal status
information. The internal server tags that
can be used are located in the Attributes
nodes that are located under the root, line,
and IED nodes. When an attribute tag is
referred to in the internal item definitions
below, it is possible to use either the whole
tag path or just the path relative to the IED
(the internal tags are configured per IED);
for example, Attributes\Diagnostic coun-
ters\Transmitted data messages. When
the whole path is used, it must be pre-
ceded by a slash (/) character, for
example, /Channel Name\Attributes\Dia-
gnostic counters\Transmitted data mes-
sages.

Default: NoneItem Tag Path

Single point status (SPS)7.5.7.3.

Table 7.5.7.3-1 Configurable SPS (for OPC internal data) properties for OPC servers
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic

SPSCommon Data Class

Addresses
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Item tag path for the internal
status information. The internal
server tags that can be used
are located in the Attributes
nodes that are located under
the root, line, and IED nodes.
When an attribute tag is
referred to in the internal item
definitions below, it is possible
to use either the whole tag path
or just the path relative to the
IED (the internal tags are con-
figured per IED); e.g. Attrib-
utes\Diagnostic counters\Trans-
mitted data messages. When
the whole path is used, it must
be preceded by a slash (/)
character, e.g. /Channel
Name\Attributes\Diagnostic
counters\Transmitted data
messages.

Default: Device connection
status

Item Tag Path

Alarm and Event

Indication event used with this
data object.

Default: Empty stringIndication Event

Controllable single point (SPC) for OPC internal data7.5.7.4.

Table 7.5.7.4-1 Configurable SPC (for OPC internal data) properties for OPC Servers
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic

Common data class according to IEC
61850.

SPCCommon Data
Class

Addresses

Item tag path for the internal status
information. The internal server tags that
can be used are located in the Attributes
nodes that are located under the root, line
and IED nodes. When an attribute tag is
referred to in the internal item definitions
below it is possible to use either the whole
tag path or just the path relative to the IED
(the internal tags are configured per IED)
e.g. Attributes\Diagnostic counters\Trans-
mitted data messages. When the whole
path is used it must be preceded by a
slash (/) character e.g. /Channel
Name\Attributes\Diagnostic counters\Trans-
mitted data messages.

Default: NoneItem Tag Path
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Configuring data objects for External OPC Client7.5.8.

General information about configuring data objects for External
OPC Device

7.5.8.1.

Use the OPC Browser tool to configure the OPC item paths
in the data objects with SAB600. For more information, see
7.4, OPC Browser tool.

The available properties for different objects are listed in the following subsections. The
parameters are stored in Object Properties in SAB600.

The actual configuration by using SAB600 is performed as described in 7.5.1, General
information about configuring objects.

Directional protection activation information7.5.8.2.

Table 7.5.8.2-1 Configurable ACD properties for External OPC Clients, subtype
Basic

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeACD61850-Type

Object subtypeBasicSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Paths

OPC item path for general phaseGeneral OPC Item
Path

OPC item path for neutral phaseNeutral OPC Item
Path

OPC item path fo phase APhase A OPC Item
Path

OPC item path for phase BPhase B OPC Item
Path

OPC item path for phase CPhase C OPC Item
Path
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Table 7.5.8.2-2 Configurable ACD properties for External OPC Clients, subtype
BIT_MASK

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeACD61850-Type

Object subtypeBIT_MASKSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Bitmask for general phase0 to 65535

Default: 0

General Bitmask

Defines the type if used bitmask for Gen-
eral

BITMASK_OR

BITMASK_AND

BITMASK_XOR

BITMASK_BOOL_ALL

BITMASK_BOOL_NONE

BITMASK_BOOL_ANY

BITMASK_BOOL_ANYNOT-
SET

BITMASK_BOOL_SOMENOT-
SET

BITMASK_BOOL_ONLY

BITMASK_BOOL_EXACTLY

Default: BITMASK_OR

General Bitmask
Type

OPC item path for general phaseGeneral OPC Item
Path

Bitmask for neutral0 to 65535

Default: 0

Neutral Bitmask
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Defines the type if used bitmask for Neut-
ral

BITMASK_OR

BITMASK_AND

BITMASK_XOR

BITMASK_BOOL_ALL

BITMASK_BOOL_NONE

BITMASK_BOOL_ANY

BITMASK_BOOL_ANYNOT-
SET

BITMASK_BOOL_SOMENOT-
SET

BITMASK_BOOL_ONLY

BITMASK_BOOL_EXACTLY

Default: BITMASK_OR

Neutral Bitmask
Type

OPC item path for neutral phaseNeutral OPC Item
Path

Bitmask for phase A0 to 65535

Default: 0

Phase A Bitmask

Defines the type of bitmask used for Phase
A

BITMASK_OR

BITMASK_AND

BITMASK_XOR

BITMASK_BOOL_ALL

BITMASK_BOOL_NONE

BITMASK_BOOL_ANY

BITMASK_BOOL_ANYNOT-
SET

BITMASK_BOOL_SOMENOT-
SET

BITMASK_BOOL_ONLY

BITMASK_BOOL_EXACTLY

Default: BITMASK_OR

Phase A Bitmask
Type

OPC item path fo phase APhase A OPC Item
Path
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Bitmask for phase B0 to 65535

Default: 0

Phase B Bitmask

Defines the type of bitmask used for Phase
B

BITMASK_OR

BITMASK_AND

BITMASK_XOR

BITMASK_BOOL_ALL

BITMASK_BOOL_NONE

BITMASK_BOOL_ANY

BITMASK_BOOL_ANYNOT-
SET

BITMASK_BOOL_SOMENOT-
SET

BITMASK_BOOL_ONLY

BITMASK_BOOL_EXACTLY

Default: BITMASK_OR

Phase B Bitmask
Type

OPC item path for phase BPhase B OPC Item
Path

Bitmask for phase C0 to 65535

Default: 0

Phase C Bitmask

Defines the type of used bitmask for Phase
C

BITMASK_OR

BITMASK_AND

BITMASK_XOR

BITMASK_BOOL_ALL

BITMASK_BOOL_NONE

BITMASK_BOOL_ANY

BITMASK_BOOL_ANYNOT-
SET

BITMASK_BOOL_SOMENOT-
SET

BITMASK_BOOL_ONLY

BITMASK_BOOL_EXACTLY

Default: BITMASK_OR

Phase C Bitmask
Type
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

OPC item path for phase CPhase C OPC Item
Path

Protection activation information (ACT)7.5.8.3.

Table 7.5.8.3-1 Configurable ACT properties for External OPC Clients, subtype
Basic

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeACT61850-Type

Object subtypeBasicSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Paths

OPC item path for general phaseGeneral OPC Item
Path

OPC item path for neutral phaseNeutral OPC Item
Path

OPC item path fo phase APhase A OPC Item
Path

OPC item path for phase BPhase B OPC Item
Path

OPC item path for phase CPhase C OPC Item
Path

Table 7.5.8.3-2 Configurable ACT properties for External OPC Clients, subtype
BIT_MASK

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeACT61850-Type

Object subtypeBIT_MASKSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Bitmask for general phase0 to 65535

Default: 0

General Bitmask

Defines the type if used bitmask for Gen-
eral

BITMASK_OR

BITMASK_AND

BITMASK_XOR

BITMASK_BOOL_ALL

BITMASK_BOOL_NONE

BITMASK_BOOL_ANY

BITMASK_BOOL_ANYNOT-
SET

BITMASK_BOOL_SOMENOT-
SET

BITMASK_BOOL_ONLY

BITMASK_BOOL_EXACTLY

Default: BITMASK_OR

General Bitmask
Type

OPC item path for general phaseGeneral OPC Item
Path

Bitmask for neutral0 to 65535

Default: 0

Neutral Bitmask

Defines the type if used bitmask for Neut-
ral

BITMASK_OR

BITMASK_AND

BITMASK_XOR

BITMASK_BOOL_ALL

BITMASK_BOOL_NONE

BITMASK_BOOL_ANY

BITMASK_BOOL_ANYNOT-
SET

BITMASK_BOOL_SOMENOT-
SET

BITMASK_BOOL_ONLY

BITMASK_BOOL_EXACTLY

Default: BITMASK_OR

Neutral Bitmask
Type
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

OPC item path for neutral phaseNeutral OPC Item
Path

Bitmask for phase A0 to 65535

Default: 0

Phase A Bitmask

Defines the type of bitmask used for Phase
A

BITMASK_OR

BITMASK_AND

BITMASK_XOR

BITMASK_BOOL_ALL

BITMASK_BOOL_NONE

BITMASK_BOOL_ANY

BITMASK_BOOL_ANYNOT-
SET

BITMASK_BOOL_SOMENOT-
SET

BITMASK_BOOL_ONLY

BITMASK_BOOL_EXACTLY

Default: BITMASK_OR

Phase A Bitmask
Type

OPC item path fo phase APhase A OPC Item
Path

Bitmask for phase B0 to 65535

Default: 0

Phase B Bitmask
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Defines the type of bitmask used for Phase
B

BITMASK_OR

BITMASK_AND

BITMASK_XOR

BITMASK_BOOL_ALL

BITMASK_BOOL_NONE

BITMASK_BOOL_ANY

BITMASK_BOOL_ANYNOT-
SET

BITMASK_BOOL_SOMENOT-
SET

BITMASK_BOOL_ONLY

BITMASK_BOOL_EXACTLY

Default: BITMASK_OR

Phase B Bitmask
Type

OPC item path for phase BPhase B OPC Item
Path

Bitmask for phase C0 to 65535

Default: 0

Phase C Bitmask

Defines the type of used bitmask for Phase
C

BITMASK_OR

BITMASK_AND

BITMASK_XOR

BITMASK_BOOL_ALL

BITMASK_BOOL_NONE

BITMASK_BOOL_ANY

BITMASK_BOOL_ANYNOT-
SET

BITMASK_BOOL_SOMENOT-
SET

BITMASK_BOOL_ONLY

BITMASK_BOOL_EXACTLY

Default: BITMASK_OR

Phase C Bitmask
Type

OPC item path for phase CPhase C OPC Item
Path
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Analogue set point (APC)7.5.8.4.

Table 7.5.8.4-1 Configurable ACP properties for External OPC client
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

61850-TypeAPC61850-Type

OPC item path for controlControl OPC Item
Path

OPC item path for positionPosition OPC Item
Path

Objct subtypeBasicSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Scale for input signalLookup Table Scale

Stepwise Linear Scale

Default: None

Input Scale

Binary counter reading (BCR)7.5.8.5.

Table 7.5.8.5-1 Configurable BCR properties for External OPC clients
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

61850-TypeBCR61850-Type

OPC item path for stateState OPC Item
Path

Object subtypeBasicSub type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update rate

Scale and Unit
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

ScaleLookup Table Scale

Stepwise Linear Scale

Default: 0

Scale

Binary controlled step position information (BSC)7.5.8.6.

Table 7.5.8.6-1 Configurable BSC properties for External OPC clients, subtype
Basic

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeBSC61850-Type

OPC item path for controlControl OPC Item
Path

OPC item path for positionPosition OPC Item
Path

Object subtypeBasicSubtype

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Scale for control signalLookup Table Scale

Stepwise Linear Scale

Default: None

Control Scale

Scale for indication signalLookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Table 7.5.8.6-2 Configurable BSC properties for External OPC clients, subtype
MULTI_ITEM

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeBSC61850-Type
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

OPC item path for higher controlHigher Control OPC
Item Path

OPC item path for lower controlLower Control OPC
Item Path

OPC item path for positionPosition OPC Item
Path

OPC item path for stop controlStop Control OPC
Item Path

Object subtypeMULTI_ITEMSubtype

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Scale for higher controlLookup Table Scale

Stepwise Linear Scale

Default: None

Higher Control
Scale

Scale for lower controlLookup Table Scale

Stepwise Linear Scale

Default: None

Lower Control Scale

Scale for indication signalLookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Scale for stop controlLookup Table Scale

Stepwise Linear Scale

Default: None

Stop Control Scale

Complex measured value (CMV)7.5.8.7.

Table 7.5.8.7-1 Configurable CMV properties for External OPC clients, subtype
Basic

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeCMV61850-Type
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

OPC item path for angleAngle OPC Item
Path

OPC item path for magnitudeMagnitude OPC
Item Path

Object subtypeBasicSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Multiplier for measurementyocto, zepto, atto, femto, pico,
nano, micro, milli, centi, deci,
deka, hecto, kilo, mega, giga,
tera, peta, exa, zetta, yotta

Default: No multiplier

Multiplier

Number of decimals0 to 9

Default: 0

Number of Decimals

Scale for angleLookup Table Scale

Stepwise Linear Scale

Default: None

Scale Ang

Scale for magnitudeLookup Table Scale

Stepwise Linear Scale

Default: None

Scale Mag
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Unit for measurementmeter, kilogram, second,
ampere, kelvin, mole, candela,
degrees, radian, steradian,
gray (J/Kg), becquerel (l/s),
degrees Celsius), sievert
(J/Kg), farad, coulomb,
siemens, henry, volt, ohm, joule
(Nm), newton (kg m/s^2), hertz,
lux (lm/m^2)lx, lumen (cd sr),
weber (V s), tesla (Wb / m^2),
watt (J/s), pascal (N/m^2),
square meter (m^2), cubic
meter (m^3), meters per
second (m/s), meters per
second^2 (m/s^2), cubic meters
per second (m^3/s), mass per
cubic meter (kg/m^3), kilogram
meter (kg m), kilogram per
cubic meter (kg/m^3), meter
square / second (m^2/s), watt
per meter kelvin (W / m K),
joule per kelvin (J / K), parts
per million, rotations per
second (1 / s), radian per
second (rad / s), volt ampere
(VA), watts (I^2R), volt ampere
reactive (VISin), degrees,
(dimensionless) Cos, volt
seconds (Ws / A), volt square
(W^2 / A^2), amp second (As),
amp square (A^2), amp square
second (A^2s), volt ampere
hours, watt hours, volt ampere
reactive hours, volts per hertz

Default: Dimensionless

Unit

Limit Value Super-
vision

Maximum limit for measurement.20000Max Limit

Minimum limit for measurement.0Min Limit

Table 7.5.8.7-2 Configurable CMV properties for External OPC clients, subtype
LIMIT_CHECK

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeCMV61850-Type

OPC item path for angleAngle OPC Item
Path
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

OPC item path for magnitudeMagnitude OPC
Item Path

Object subtypeLIMIT_CHECKSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Multiplier for measurementyocto, zepto, atto, femto, pico,
nano, micro, milli, centi, deci,
deka, hecto, kilo, mega, giga,
tera, peta, exa, zetta, yotta

Default: No multiplier

Multiplier

Number of decimals0 to 9

Default: 0

Number of Decimals

Scale for angleLookup Table Scale

Stepwise Linear Scale

Default: None

Scale Ang

Scale for magnitudeLookup Table Scale

Stepwise Linear Scale

Default: None

Scale Mag
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Unit for measurementmeter, kilogram, second,
ampere, kelvin, mole, candela,
degrees, radian, steradian,
gray (J/Kg), becquerel (l/s),
degrees Celsius), sievert
(J/Kg), farad, coulomb,
siemens, henry, volt, ohm, joule
(Nm), newton (kg m/s^2), hertz,
lux (lm/m^2)lx, lumen (cd sr),
weber (V s), tesla (Wb / m^2),
watt (J/s), pascal (N/m^2),
square meter (m^2), cubic
meter (m^3), meters per
second (m/s), meters per
second^2 (m/s^2), cubic meters
per second (m^3/s), mass per
cubic meter (kg/m^3), kilogram
meter (kg m), kilogram per
cubic meter (kg/m^3), meter
square / second (m^2/s), watt
per meter kelvin (W / m K),
joule per kelvin (J / K), parts
per million, rotations per
second (1 / s), radian per
second (rad / s), volt ampere
(VA), watts (I^2R), volt ampere
reactive (VISin), degrees,
(dimensionless) Cos, volt
seconds (Ws / A), volt square
(W^2 / A^2), amp second (As),
amp square (A^2), amp square
second (A^2s), volt ampere
hours, watt hours, volt ampere
reactive hours, volts per hertz

Unit

Limit Value Super-
vision

Hi limit for measurement0Hi Limit

HiHi limit for measurement0HiHi Limit

Lo limit for measurement0Lo Limit

LoLo limit for measurement0LoLo Limit

Maximum limit for measurement.20000Max Limit

Minimum limit for measurement.0Min Limit
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Delta (DEL)7.5.8.8.

Table 7.5.8.8-1 Configurable DEL properties for External OPC clients, subtype
Basic

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeDEL61850-Type

OPC item path for ab V angleV ab Angle OPC
Item Path

OPC item path for ab V magnitudeV ab Magnitude
OPC Item Path

OPC item path for bc V angleV bc Angle OPC
Item

OPC item path for bc V magnitudeV bc Magnitude
OPC Item

OPC item path for ca V angleV ca Angle OPC
Item Path

OPC item path for ca V magnitudeV ca Magnitude
OPC Item

Object subtypeBasicSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Scale for angleLookup Table Scale

Stepwise Linear Scale

Default: None

Angle Scale

Multiplier for measurementyocto, zepto, atto, femto, pico,
nano, micro, milli, centi, deci,
deka, hecto, kilo, mega, giga,
tera, peta, exa, zetta, yotta

Default: No multiplier

Multiplier

Number of decimals0 to 9

Default: 0

Number of Decimals

Scale for measurementLookup Table Scale

Stepwise Linear Scale

Default: None

Scale
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Unit for measurementmeter, kilogram, second,
ampere, kelvin, mole, candela,
degrees, radian, steradian,
gray (J/Kg), becquerel (l/s),
degrees Celsius), sievert
(J/Kg), farad, coulomb,
siemens, henry, volt, ohm, joule
(Nm), newton (kg m/s^2), hertz,
lux (lm/m^2)lx, lumen (cd sr),
weber (V s), tesla (Wb / m^2),
watt (J/s), pascal (N/m^2),
square meter (m^2), cubic
meter (m^3), meters per
second (m/s), meters per
second^2 (m/s^2), cubic meters
per second (m^3/s), mass per
cubic meter (kg/m^3), kilogram
meter (kg m), kilogram per
cubic meter (kg/m^3), meter
square / second (m^2/s), watt
per meter kelvin (W / m K),
joule per kelvin (J / K), parts
per million, rotations per
second (1 / s), radian per
second (rad / s), volt ampere
(VA), watts (I^2R), volt ampere
reactive (VISin), degrees,
(dimensionless) Cos, volt
seconds (Ws / A), volt square
(W^2 / A^2), amp second (As),
amp square (A^2), amp square
second (A^2s), volt ampere
hours, watt hours, volt ampere
reactive hours, volts per hertz

Default: Dimensionless

Unit

Limit Value Super-
vision

Maximum limit for measurement.20000Max Limit

Minimum limit for measurement.0Min Limit

Table 7.5.8.8-2 Configurable DEL properties for External OPC clients, subtype
LIMIT_CHECK

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeDEL61850-Type

OPC item path for ab V angleV ab Angle OPC
Item Path
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

OPC item path for ab V magnitudeV ab Magnitude
OPC Item Path

OPC item path for bc V angleV bc Angle OPC
Item

OPC item path for bc V magnitudeV bc Magnitude
OPC Item

OPC item path for ca V angleV ca Angle OPC
Item Path

OPC item path for ca V magnitudeV ca Magnitude
OPC Item

Object subtypeLIMIT_CHECKSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Scale for angleLookup Table Scale

Stepwise Linear Scale

Default: None

Angle Scale

Multiplier for measurementyocto, zepto, atto, femto, pico,
nano, micro, milli, centi, deci,
deka, hecto, kilo, mega, giga,
tera, peta, exa, zetta, yotta

Default: No multiplier

Multiplier

Number of decimals0 to 9

Default: 0

Number of Decimals

Scale for measurementLookup Table Scale

Stepwise Linear Scale

Default: None

Scale
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Unit for measurementmeter, kilogram, second,
ampere, kelvin, mole, candela,
degrees, radian, steradian,
gray (J/Kg), becquerel (l/s),
degrees Celsius), sievert
(J/Kg), farad, coulomb,
siemens, henry, volt, ohm, joule
(Nm), newton (kg m/s^2), hertz,
lux (lm/m^2)lx, lumen (cd sr),
weber (V s), tesla (Wb / m^2),
watt (J/s), pascal (N/m^2),
square meter (m^2), cubic
meter (m^3), meters per
second (m/s), meters per
second^2 (m/s^2), cubic meters
per second (m^3/s), mass per
cubic meter (kg/m^3), kilogram
meter (kg m), kilogram per
cubic meter (kg/m^3), meter
square / second (m^2/s), watt
per meter kelvin (W / m K),
joule per kelvin (J / K), parts
per million, rotations per
second (1 / s), radian per
second (rad / s), volt ampere
(VA), watts (I^2R), volt ampere
reactive (VISin), degrees,
(dimensionless) Cos, volt
seconds (Ws / A), volt square
(W^2 / A^2), amp second (As),
amp square (A^2), amp square
second (A^2s), volt ampere
hours, watt hours, volt ampere
reactive hours, volts per hertz

Default: Dimensionless

Unit

Limit Value Super-
vision

Hi limit for measurement0Hi Limit

HiHi limit for measurement0HiHi Limit

Lo limit for measurement0Lo Limit

LoLo limit for measurement0LoLo Limit

Maximum limit for measurement.20000Max Limit

Minimum limit for measurement.0Min Limit
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Controllable double point (DPC)7.5.8.9.

Table 7.5.8.9-1 Configurable DPC properties for External OPC Clients, subtype
Basic

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeDPC61850-Type

OPC item path for cancelCancel OPC Item
Path

OPC item path for close executeClose Execute OPC
Item Path

OPC item path for close selectClose Select OPC
Item Path

OPC item path for faultyFaulty OPC Item
Path

OPC item path for intermediateIntermediate OPC
Item Path

OPC item path for open executeOpen Execute OPC
Item Path

OPC item path for open selectOpen Select OPC
Item Path

OPC item path for stateState OPC Item
Path

Object subtypeBasicSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Scale for cancel signalLookup Table Scale

Stepwise Linear Scale

Default: None

Cancel Scale

Scale fo close executeLookup Table Scale

Stepwise Linear Scale

Default: None

Close Execute
Scale

Scale for close selectLookup Table Scale

Stepwise Linear Scale

Default: None

Close Select Scale
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Scale for open executeLookup Table Scale

Stepwise Linear Scale

Default: None

Open Execute Scale

Scale for open selectLookup Table Scale

Stepwise Linear Scale

Default: None

Open Select Scale

Scale for stateLookup Table Scale

Stepwise Linear Scale

Default: None

State Scale

Table 7.5.8.9-2 Configurable DPC properties for External OPC clients, subtype
OPEN_CLOSED_ITEMS

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeDPC61850-Type

OPC item path for cancelCancel OPC Item
Path

OPC item path for close executeClose Execute OPC
Item Path

OPC item path for close selectClose Select OPC
Item Path

OPC item path for closedClosed OPC Item
Path

OPC item path for faultyFaulty OPC Item
Path

OPC item path for intermediateIntermediate OPC
Item Path

OPC item path for open executeOpen Execute OPC
Item Path

OPC item path for openOpen OPC Item
Path

OPC item path for open selectOpen Select OPC
Item Path

Object subtypeOPEN_CLOSED_ITEMSSub Type
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Scale for cancel signalLookup Table Scale

Stepwise Linear Scale

Default: None

Cancel Scale

Scale for close executeLookup Table Scale

Stepwise Linear Scale

Default: None

Close Execute
Scale

Scale for close signalLookup Table Scale

Stepwise Linear Scale

Default: None

Close Scale

Scale for close selectLookup Table Scale

Stepwise Linear Scale

Default: None

Close Select Scale

Scale for open executeLookup Table Scale

Stepwise Linear Scale

Default: None

Open Execute Scale

Scale for open signalLookup Table Scale

Stepwise Linear Scale

Default: None

Open Scale

Scale for open selectLookup Table Scale

Stepwise Linear Scale

Default: None

Open Select Scale

Device name plate (DPL)7.5.8.10.

Table 7.5.8.10-1 Configurable DPL properties for External OPC clients
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

61850-TypeDPL61850-Type

OPC item path for HW revisionHW Revision OPC
Item Path

OPC item path for locationLocation OPC Item
Path

OPC item path for serial number registerSerial Number
Register OPC Item
Path

Object subtypeBasicSub type

OPC item path for SW revisionSW Revision OPC
Item Path

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

OPC item path for vendor registerVendor Register
OPC Item Path

Double point status (DPS)7.5.8.11.

Table 7.5.8.11-1 Configurable DPS properties for External OPC clients, subtype
Basic

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeDPS61850-Type

OPC item path for stateState OPC Item
Path

Object subtypeBasicSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 - 65535

Default: 0

Update Rate

Scale and Unit

Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale
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Table 7.5.8.11-2 Configurable DPS properties for External OPC clients, subtype
OPEN_CLOSED_ITEMS

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeDPS61850-Type

OPC item path for closedClosed OPC Item
Path

OPC tem path for openOpen OPC Item
Path

Object subtypeOPEN_CLOSED_ITEMSSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 - 65535

Default: 0

Update Rate

Scale and Unit

Lookup Table Scale

Stepwise Linear Scale

Default: None

ClosedScale

Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Controllable integer status (INC)7.5.8.12.

Table 7.5.8.12-1 Configurable INC properties for External OPC client
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

61850-TypeINC61850-Type

OPC item path for controlControl OPC Item
Path

OPC item path for stateState OPC Item
Path

Object subtypeBasicSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 - 65535

Default: 0

Update Rate
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Scale and Unit

Scale for control signalLookup Table Scale

Stepwise Linear Scale

Default: None

Control Scale

Scale for indication signalLookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Integer status (INS)7.5.8.13.

Table 7.5.8.13-1 Configurable INS properties for External OPC clients
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

61850-TypeINS61850-Type

OPC item path for scaleState OPC Item
Path

Object subtypeBasicSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 - 65535

Default: 0

Update Rate

Scale and Unit

Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Integer controlled step position information (ISC)7.5.8.14.

Table 7.5.8.14-1 Configurable ISC properties for External OPC clients
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

61850-TypeISC61850-Type
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

OPC item path for controlControl OPC Item
Path

OPC item path for stateState OPC Item
Path

Object subtypeBasicSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 - 65535

Default: 0

Update Rate

Scale and Unit

Scale for control signalLookup Table Scale

Stepwise Linear Scale

Default: None

Control Scale

Scale for indication signalLookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Logical node name plate (LPL)7.5.8.15.

Table 7.5.8.15-1 Configurable LPL properties for OPC servers with External device
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

61850-TypeLPL61850-Type

Object SubtypeBasicSub Type

OPC item path for SW revisionSW Revision OPC
Item Path

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

OPC item path for vendorVendor OPC Item
Path
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Measured value (MV)7.5.8.16.

Table 7.5.8.16-1 Configurable MV properties for External OPC clients, subtype
Basic

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeMV61850-Type

OPC item path for magnitudeMagnitude OPC
Item Path

Object subtypeBasicSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Multiplier for measurementyocto, zepto, atto, femto, pico,
nano, micro, milli, centi, deci,
deka, hecto, kilo, mega, giga,
tera, peta, exa, zetta, yotta

Default: No multiplier

Multiplier

Number of decimals0 to 9

Default: 0

Number of Decimals

Scale for measurementLookup Table Scale

Stepwise Linear Scale

Default: None

Scale
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Unit for measurementmeter, kilogram, second,
ampere, kelvin, mole, candela,
degrees, radian, steradian,
gray (J/Kg), becquerel (l/s),
degrees Celsius), sievert
(J/Kg), farad, coulomb,
siemens, henry, volt, ohm, joule
(Nm), newton (kg m/s^2), hertz,
lux (lm/m^2)lx, lumen (cd sr),
weber (V s), tesla (Wb / m^2),
watt (J/s), pascal (N/m^2),
square meter (m^2), cubic
meter (m^3), meters per
second (m/s), meters per
second^2 (m/s^2), cubic meters
per second (m^3/s), mass per
cubic meter (kg/m^3), kilogram
meter (kg m), kilogram per
cubic meter (kg/m^3), meter
square / second (m^2/s), watt
per meter kelvin (W / m K),
joule per kelvin (J / K), parts
per million, rotations per
second (1 / s), radian per
second (rad / s), volt ampere
(VA), watts (I^2R), volt ampere
reactive (VISin), degrees,
(dimensionless) Cos, volt
seconds (Ws / A), volt square
(W^2 / A^2), amp second (As),
amp square (A^2), amp square
second (A^2s), volt ampere
hours, watt hours, volt ampere
reactive hours, volts per hertz

Default: Dimensionless

Unit

Limit Value Super-
vision

Maximum limit for measurement.20000Max Limit

Minimum limit for measurement.0Min Limit

Table 7.5.8.16-2 Configurable MV properties for External OPC clients, subtype
LIMIT_CHECK

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeMV61850-Type

OPC item path for magnitudeMagnitude OPC
Item Path
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Object subtypeLIMIT_CHECKSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Multiplier for measurementyocto, zepto, atto, femto, pico,
nano, micro, milli, centi, deci,
deka, hecto, kilo, mega, giga,
tera, peta, exa, zetta, yotta

Default: No multiplier

Multiplier

Number of decimals0 to 9

Default: 0

Number of Decimals

Scale for measurementLookup Table Scale

Stepwise Linear Scale

Default: None

Scale
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Unit for measurementmeter, kilogram, second,
ampere, kelvin, mole, candela,
degrees, radian, steradian,
gray (J/Kg), becquerel (l/s),
degrees Celsius), sievert
(J/Kg), farad, coulomb,
siemens, henry, volt, ohm, joule
(Nm), newton (kg m/s^2), hertz,
lux (lm/m^2)lx, lumen (cd sr),
weber (V s), tesla (Wb / m^2),
watt (J/s), pascal (N/m^2),
square meter (m^2), cubic
meter (m^3), meters per
second (m/s), meters per
second^2 (m/s^2), cubic meters
per second (m^3/s), mass per
cubic meter (kg/m^3), kilogram
meter (kg m), kilogram per
cubic meter (kg/m^3), meter
square / second (m^2/s), watt
per meter kelvin (W / m K),
joule per kelvin (J / K), parts
per million, rotations per
second (1 / s), radian per
second (rad / s), volt ampere
(VA), watts (I^2R), volt ampere
reactive (VISin), degrees,
(dimensionless) Cos, volt
seconds (Ws / A), volt square
(W^2 / A^2), amp second (As),
amp square (A^2), amp square
second (A^2s), volt ampere
hours, watt hours, volt ampere
reactive hours, volts per hertz

Default: Dimensionless

Unit

Limit Value Super-
vision

Hi limit for measurement0Hi Limit

HiHi limit for measurement0HiHi Limit

Lo limit for measurement0Lo Limit

LoLo limit for measurement0LoLo Limit

Maximum limit for measurement.20000Max Limit

Minimum limit for measurement.0Min Limit
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Controllable single point (SPC)7.5.8.17.

Table 7.5.8.17-1 Configurable SPC properties for External OPC clients, subtype
Basic

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeSPC61850-Type

OPC item path for controlControl OPC Item
Path

OPC item path for stateState OPC Item
Path

Object subtypeBasicSub Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Scale for control signalLookup Table Scale

Stepwise Linear Scale

Default: None

Control Scale

Scale for indication signalLookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Table 7.5.8.17-2 Configurable SPC properties for External OPC clients, subtype
TWO_CONTROL_TAGS

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeSPC61850-Type

OPC item path for off controlOff Control OPC
Item Path

OPC item path for on controlOn Control OPC
Item Path

OPC item path for stateState OPC Item
Path

Object subtypeTWO_CONTROL_TAGSSub Type
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Scale for control signalLookup Table Scale

Stepwise Linear Scale

Default: None

Control Scale

Scale for indication signalLookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Single point status (SPS)7.5.8.18.

Table 7.5.8.18-1 Configurable SPS properties for External OPC clients, subtype
Basic

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeSPS61850-Type

OPC item path for stateState OPC Item
path

Object subtypeBasicSub-Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Table 7.5.8.18-2 Configurable SPS properties for External OPC clients, subtype
Bit Mask

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

61850-TypeSPS61850-Type

Defines the type of used bitmaskBITMASK_OR

BITMASK_AND

BITMASK_XOR

BITMASK_BOOL_ALL

BITMASK_BOOL_NONE

BITMASK_BOOL_ANY

BITMASK_BOOL_ANYNOT-
SET

BITMASK_BOOL_SOMENOT-
SET

BITMASK_BOOL_ONLY

BITMASK_BOOL_EXACTLY

Default: BITMASK_OR

Bitmask Type

OPC item path for stateState OPC Item
Path

0 to 65535

Default: 0

StateBitMaskValue

Object subtypeBit MaskSub-Type

Defines the requested shortest interval in
milliseconds at which the source OPC
server should report that an OPC item’s
value has changed.

0 to 65535

Default: 0

Update Rate

Scale and Unit

Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale
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WYE7.5.8.19.

Table 7.5.8.19-1 Configurable WYE properties for External OPC clients, subtype
Basic

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeWYE61850-Type

OPC item path for a I angleI a Angle OPC Item
Path

OPC item path for a I magnitudeI a Magnitude OPC
Item Path

OPC item path for b I angleI b Angle OPC Item
Path

OPC item path for b I magnitudeI b Magnitude OPC
Item Path

OPC item path for c I angleI c Angle OPC Item
Path

OPC item path for c I magnitudeI c Magnitude OPC
Item Path

OPC item path for n I angleI n Angle OPC Item
Path

OPC item path for n I magnitudeI n Magnitude OPC
Item Path

I net angle OPC item pathI net Angle OPC
Item Path

I net magnitude OPC item pathI net Magnitude
OPC Item Path

I res angle OPC item pathI res Angle OPC
Item Path

I res magnitude OPC item pathI res Magnitude
OPC Item Path

ID of the connected OPC ServerDefaultOPC Server ID

Object subtypeBASIC

LIMIT_CHECK

Default: BASIC

Sub Type

Defines how often the value is updated.0 to 65535

Default: 0

Update Rate

Scale and Unit
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Multiplier for netyocto, zepto, atto, femto, pico,
nano, micro, milli, centi, deci,
deka, hecto, kilo, mega, giga,
tera, peta, exa, zetta, yotta

Default: No multiplier

Net Multiplier

Number of decimals for net0 to 9

Default: 0

Net Number Of
Decimals

Scale for net angleLookup Table Scale

Stepwise Linear Scale

Default: None

Net Scale Ang

Scale for net magnitudeLookup Table Scale

Stepwise Linear Scale

Default: None

Net Scale Mag
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Unit for netdimensioless, meter, kilogram,
second, ampere, kelvin, mole,
candela, degrees, radian,
steradian, gray (J/Kg),
becquerel (l/s), degrees
Celsius), sievert (J/Kg), farad,
coulomb, siemens, henry, volt,
ohm, joule (Nm), newton (kg
m/s^2), hertz, lux (lm/m^2)lx,
lumen (cd sr), weber (V s),
tesla (Wb / m^2), watt (J/s),
pascal (N/m^2), square meter
(m^2), cubic meter (m^3),
meters per second (m/s),
meters per second^2 (m/s^2),
cubic meters per second
(m^3/s), mass per cubic meter
(kg/m^3), kilogram meter (kg
m), kilogram per cubic meter
(kg/m^3), meter square /
second (m^2/s), watt per meter
kelvin (W / m K), joule per
kelvin (J / K), parts per million,
rotations per second (1 / s),
radian per second (rad / s), volt
ampere (VA), watts (I^2R), volt
ampere reactive (VISin),
degrees, (dimensionless) Cos,
volt seconds (Ws / A), volt
square (W^2 / A^2), amp
second (As), amp square (A^2),
amp square second (A^2s), volt
ampere hours, watt hours, volt
ampere reactive hours, volts
per hertz

Default: Dimensioless

Net Unit

Multiplier for neutralyocto, zepto, atto, femto, pico,
nano, micro, milli, centi, deci,
deka, hecto, kilo, mega, giga,
tera, peta, exa, zetta, yotta

Default: No multiplier

Neutral Multiplier

Number of decimals for neutral0 to 9

Default: 0

Neutral Number Of
Decimals

Scale for neutral angleLookup Table Scale

Stepwise Linear Scale

Default: None

Neutral Scale Ang
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Scale for neutral magnitudeLookup Table Scale

Stepwise Linear Scale

Default: None

Neutral Scale Mag

Unit for neutralSee Net UnitNeutral Unit

Multiplier for phaseSee Net MultiplierPhase Multiplier

Number of decimals for phase0 to 9

Default: 0

Phase Number Of
Decimals

Scale for phase angleLookup Table Scale

Stepwise Linear Scale

Default: None

Phase Scale Ang

Scale for phase magnitudeLookup Table Scale

Stepwise Linear Scale

Default: None

Phase Scale Mag

Unit for phaseSee Net UnitPhase Unit

Multiplier for resSee Net MultiplierRes Multiplier

Number of decimals for res0 to 9

Default: 0

Res Number Of
Decimals

Scale for res angleLookup Table Scale

Stepwise Linear Scale

Default: None

Res Scale Ang

Scale for res magnitudeLookup Table Scale

Stepwise Linear Scale

Default: None

Res Scale Mag

Unit for resSee Net UnitRes Unit

Limit Value Super-
vision

Max limit for net20000Net Max Limit

Min limit for net0Net Min Limit

Max limit for neutral20000Neutral Max Limit

Min limit for neutral0Neutral Min Limit

Max limit for phase20000Phase Max Limit

Min limit for phase0Phase Min Limit
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Max limit for res20000Res Max Limit

Min limit for res0Res Min Limit

Table 7.5.8.19-2 Configurable WYE properties for External OPC clients, subtype
LIMIT_CHECK

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

61850-TypeWYE61850-Type

OPC item path for a I angleI a Angle OPC Item
Path

OPC item path for a I magnitudeI a Magnitude OPC
Item Path

OPC item path for b I angleI b Angle OPC Item
Path

OPC item path for b I magnitudeI b Magnitude OPC
Item Path

OPC item path for c I angleI c Angle OPC Item
Path

OPC item path for c I magnitudeI c Magnitude OPC
Item Path

OPC item path for n I angleI n Angle OPC Item
Path

OPC item path for n I magnitudeI n Magnitude OPC
Item Path

I net angle OPC item pathI net Angle OPC
Item Path

I net magnitude OPC item pathI net Magnitude
OPC Item Path

I res angle OPC item pathI res Angle OPC
Item Path

I res magnitude OPC item pathI res Magnitude
OPC Item Path

ID of the connected OPC server.DefaultOPC Server ID

Object subtypeLIMIT_CHECKSub Type

Defines how often the value is updated.0 to 65535

Default: 0

Update Rate

Scale and Unit

253

COM600 series 5.11MRS758689

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Multiplier for netyocto, zepto, atto, femto, pico,
nano, micro, milli, centi, deci,
deka, hecto, kilo, mega, giga,
tera, peta, exa, zetta, yotta

Default: No multiplier

Net Multiplier

Number of decimals for net0 to 9

Default: 0

Net Number Of
Decimals

Scale for net angleLookup Table Scale

Stepwise Linear Scale

Default: None

Net Scale Ang

Scale for net magnitudeLookup Table Scale

Stepwise Linear Scale

Default: None

Net Scale Mag
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Unit for netdimensioless, meter, kilogram,
second, ampere, kelvin, mole,
candela, degrees, radian,
steradian, gray (J/Kg),
becquerel (l/s), degrees
Celsius), sievert (J/Kg), farad,
coulomb, siemens, henry, volt,
ohm, joule (Nm), newton (kg
m/s^2), hertz, lux (lm/m^2)lx,
lumen (cd sr), weber (V s),
tesla (Wb / m^2), watt (J/s),
pascal (N/m^2), square meter
(m^2), cubic meter (m^3),
meters per second (m/s),
meters per second^2 (m/s^2),
cubic meters per second
(m^3/s), mass per cubic meter
(kg/m^3), kilogram meter (kg
m), kilogram per cubic meter
(kg/m^3), meter square /
second (m^2/s), watt per meter
kelvin (W / m K), joule per
kelvin (J / K), parts per million,
rotations per second (1 / s),
radian per second (rad / s), volt
ampere (VA), watts (I^2R), volt
ampere reactive (VISin),
degrees, (dimensionless) Cos,
volt seconds (Ws / A), volt
square (W^2 / A^2), amp
second (As), amp square (A^2),
amp square second (A^2s), volt
ampere hours, watt hours, volt
ampere reactive hours, volts
per hertz

Default: Dimensioless

Net Unit

Multiplier for neutralSee Net MultiplierNeutral Multiplier

Number of decimals for neutral0 to 9

Default: 0

Neutral Number Of
Decimals

Scale for neutral angleLookup Table Scale

Stepwise Linear Scale

Default: None

Neutral Scale Ang

Scale for neutral magnitudeLookup Table Scale

Stepwise Linear Scale

Default: None

Neutral Scale Mag

Unit for neutralSee Net UnitNeutral Unit
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Multiplier for phaseSee Net MultiplierPhase Multiplier

Number of decimals for phase0 to 9

Default: 0

Phase Number Of
Decimals

Scale for phase angleLookup Table Scale

Stepwise Linear Scale

Default: None

Phase Scale Ang

Scale for phase magnitudeLookup Table Scale

Stepwise Linear Scale

Default: None

Phase Scale Mag

Unit for phaseSee Net UnitPhase Unit

Multiplier for resSee Net MultiplierRes Multiplier

Number of decimals for res0 to 9

Default: 0

Res Number Of
Decimals

Scale for res angleLookup Table Scale

Stepwise Linear Scale

Default: None

Res Scale Ang

Scale for res magnitudeLookup Table Scale

Stepwise Linear Scale

Default: None

Res Scale Mag

Unit for resSee Net UnitRes Unit

Limit Value Super-
vision

Hi limit for net0Net Hi Limit

HiHi limit for net0Net HiHi Limit

Lo limit for net0Net Lo Limit

LoLo limit for net0Net LoLo Limit

Max limit for net20000Net Max Limit

Min limit for net0Net Min Limit

Hi limit for neutral0Neutral Hi Limit

HiHi limit for neutral0Neutral HiHi Limit

Lo limit for neutral0Neutral Lo Limit

LoLo limit for neutral0Neutral LoLo Limit
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Max limit for neutral20000Neutral Max Limit

Min limit for neutral0Neutral Min Limit

Hi limit for phase0Phase Hi Limit

HiHi limit for phase0Phase HiHi Limit

Lo limit for phase0Phase Lo Limit

LoLo limit for phase0Phase LoLo Limit

Max limit for phase20000Phase Max Limit

Min limit for phase0Phase Min Limit

Hi limit for res0Res Hi Limit

HiHi limit for res0Res HiHi Limit

Lo limit for res0Res Lo Limit

LoLo limit for res0Res LoLo Limit

Max limit for res20000Res Max Limit

Min limit for res0Res Min Limit

Configuring DCOM7.6.

Introduction7.6.1.

DCOM is a Microsoft technology that allows COM (OPC) servers and clients to commu-
nicate with each other while running on separate computers. DCOM must be enabled
by making the proper DCOM configuration for the OPC server, OPC client and general
DCOM settings on both computers.

There are several ways to configure DCOM depending on the needs of the applications,
users and network administration structure. The following sections provide instructions
on DCOM configuration when the COM600 computer and OPC server computer are
part of different Windows domains, or are not part of any domain. This kind of config-
uration provides relatively good security by not allowing more users than necessary to
access the OPC server.

DCOM is configured using a shared user account on both computers for authentication
between the OPC client running on COM600 computer and the OPC server running on
the OPC server computer. Authorization for the user account must be configured on both
computers. On the COM600 computer, the shared user account must be granted remote
access rights so that OPC callbacks from the remote OPC server work. On the OPC
server computer, the shared user account must be granted rights to launch, activate and
access the OPC server. Additionally, similar access rights are needed for the OpcEnum
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component from OPC Foundation. The OpcEnum component is used for browsing OPC
servers on a computer and for mapping progIds to CLSIDs. ProIds are used to configure
the remote OPC server on COM600. CLSIDs are needed to start the OPC server via
DCOM.

For more information on setting up the DCOM, see Microsoft and OPC Foundation web
sites.

Configuring DCOM7.6.2.

The DCOM settings are configured with the DCOMCNFG program.

To configure the DCOM settings:
1. Execute the DCOMCNFG program by selecting Start > Run As menu or via a

command prompt.
2. Select Component Services > Computers > My Computer.
3. Right-click My Computer and select Properties to open the DCOM settings

property sheet.

Configuring COM600 and OPC server computers7.6.3.

Configuring DCOM default properties7.6.3.1.

To configure the DCOM default properties:
1. In the My Computer Properties dialog, select the Default Properties tab.
2. Select Enable Distributed COM.
3. Set the default authentication level to Connect from the drop-down menu.
4. Set the default impersonation level to Identify from the drop-down menu.
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DCOM_default_properties.png

Figure 7.6.3.1-1 Configuring DCOM default properties

Creating a common user account7.6.3.2.

The COM600 local user account will be used for authentication between the two com-
puters. The user account is already included on the COM600 computer, thus it only needs
to be created on the OPC server computer. Make sure that the account on the OPC server
computer has exactly the same password as on the COM600 computer.

If the password on the COM600 computer is changed,
remember to change it on the OPC server computer as well.
Change the password via the SAB Management tool.

The shared account is used for logging on to both computers.
Make sure that the account will not be locked out by the
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Windows security policy, for example, because of too many
failed login attempts.

Local security policy settings7.6.3.3.

Depending on the current Windows security policy settings and Windows version, remote
users may be authenticated as Guest. As a Guest, the remote user is not authorized to
use OPC via DCOM unless the Guest account is given authorization (not recommended).
You can prevent remote users from being authenticated as Guest by modifying the local
security settings.

To modify the local security policy settings:
1. Select  Start > Control Panel > Administrative Tools.
2. Open the Local Security Settings window.
3. Expand the tree view and select Security Options in the left-hand pane.
4. In the right-hand pane, scroll down to Network Access: Sharing and security

settings for local accounts and right-click it.
5. Select Properties.
6. Select Classic - local users authenticate as themselves.

Disabling firewalls and security software7.6.3.4.

Firewalls and other security software may block the connections needed by DCOM.
Therefore, you may need to disable them while configuring and testing DCOM. After
you have completed the DCOM configuration, enable needed firewalls and security
software again and make sure that DCOM communication still works. If the DCOM
communication does not work, the security software must be disabled or configured to
allow DCOM communication.

A built-in Windows firewall is enabled in COM600 by default. It should be disabled
before taking DCOM into use. For information on configuring the Windows firewall to
allow DCOM, see MSDN Library web site.

Restarting OPC programs7.6.3.5.

After you have configured all DCOM settings, close or terminate all affected programs:

• the OPC client OPCS_CONN on the COM600 computer
• the OPC server processes and OpcEnum component on the OPC server computer

The existing DCOM connections with old security tokens may still be in use instead of
new ones created with the current DCOM settings from the Windows registry. Restart
both computers to ensure that the new settings are taken into use.
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Configuring DCOM on COM600 computer7.6.4.

To be able receive incoming data callbacks from the OPC server to the COM600 com-
puter, you must enable remote access permissions for the COM600 user account.

To configure DCOM access permissions on COM600 computer:
1. Select Component Services > Computers > My Computer.
2. In the My Computer Properties dialog, select the COM Security tab.
3. Click Edit Limits in the Access Permissions section of the dialog, see Figure 7.6.4-

1.

COM_security.png

Figure 7.6.4-1 Editing COM600 Security settings

4. In the Access Permission dialog, allow Local Access and Remote Access for
COM600, see Figure 7.6.4-2.
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COM600_permissions.png

Figure 7.6.4-2 Adding permissions for COM600 computer

If you want to run the remote OPC server on a different user
account, you must create the additional user account on the
COM600 computer with same password as on the OPC server
computer including the same remote access rights as the
COM600 user account. Even if you create the additional user
account with the same access rights, the COM600 user account
is still required.

Configuring DCOM on OPC server computer7.6.5.

To configure COM600S permissions on the OPC server computer:
1. Select Component Services > Computers > My Computer.
2. In the My Computer Properties dialog, select the COM Security tab.
3. Click Edit Limits in the Access Permissions section of the dialog, see Figure 7.6.4-

1.
4. In the Access Permission dialog, allow Local Access and Remote Access for

COM600 and click OK (see Figure 7.6.5-1).
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COM600_permissions_OPC.png

Figure 7.6.5-1 Adding permissions for COM600 computer

5. Click Edit Limits in the Launch and Activation Permissions section of the dialog,
see Figure 7.6.4-1.

6. In the Launch and Activation Permission dialog, allow Local Launch, Remote
Launch, Local Activation and Remote Activation for COM600 and click OK (see
Figure 7.6.5-2).
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launch_permission.png

Figure 7.6.5-2 Adding launch and activation permissions for COM600

7. Configure the OPC server to run as the (local) COM600 user created on the computer
for this purpose. Select My Computer > DCOM Config > OPC server to open
the properties.

8. Select the Identity tab. Enter the COM600 user name and password and click OK
(see Figure 7.6.5-3).
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identity_tab.png

Figure 7.6.5-3 Configuring the COM600 user to run the OPC server

9. Select the Security tab and click Edit in the Launch and Activation Permissions
section of the dialog, see Figure 7.6.5-4.
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customizing_lanuch_permissions.png

Figure 7.6.5-4 Customizing launch and activation permissions

10. In the Access Permission dialog, allow Local Launch, Remote Launch, Local
Activation and Remote Activation for the OpcEnum component and click OK (see
Figure 7.6.5-5).
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allowing_launch_and_activation.png

Figure 7.6.5-5 Adding launch and activation permissions for the OpcEnum component

11. Click Edit in the Access Permissions section of the dialog, see Figure 7.6.5-4.
12. In the Access Permission dialog, allow Local Access and Remote Access for the

OpcEnum component and click OK (see Figure 7.6.5-6).
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allowing_access_permissions.png

Figure 7.6.5-6 Adding local and remote access permissions for the OpcEnum component
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SNMP OPC server configuration8.

About this section8.1.

This section guides you in the configuration tasks required before you can start using
the SNMP OPC Server. For information on the IEC 61850 data modeling, refer to
COM600 User's Manual.

Start SAB600 to open a project. You can also open and name a new project.

1. Select File > Open/Manage Project....
2. In the Open/Manage Project dialog, select the required location for the project:

• Projects on my computer
• Projects on network

3. Select New Project on the left.
• Enter a Project Name. The Description is optional.

4. Click Create.
5. Click Open Project.

Overview of configuration8.2.

Before you can start using the SNMP OPC Server, you need to build and configure an
object tree in SAB600 to define the Communication structure within the Gateway object.

The possible objects are:
• Gateway
• SNMP OPC Server
• SNMP Subnetwork
• SNMP IED
• Logical Device objects
• Logical Node objects
• Data objects

Figure 8.2-1 shows an example view of SAB600 including an object tree in the commu-
nication structure on the left and Object Properties window displaying the object properties
on the right.

When configuring OPC servers the following characters cannot
be used in object names: \ ` ' ' #
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SAB600_SNMP_Example_View.png

Figure 8.2-1 Example view of SAB600

The configuration work can basically be divided into two separate tasks:
1. building an object tree, and
2. configuring object properties.

First, you need to build an object tree. This is done by adding objects to the object tree,
see 8.3.1, General information about building object tree.

Figure 8.2-1 shows an example of how the object tree may look like after it has been
built. In the example tree you can see the SNMP OPC Server object and its child objects
like subnetworks, devices, and data objects. Indentation is used to indicate the parent-
child relationship between the objects.

After you have added the necessary objects to the object tree in the communication
structure, you need to configure them, see 8.4.1, General information about configuring
objects.

Table 8.2-1 SNMP OPC Server related objects
DescriptionObject

An object representing the SNMP OPC Server.SNMP OP Server

An object representing the network which the
SNMP device resides.

SNMP OPC Subnetwork

An object representing a network device that
supports SNMP protocol.

SNMP IED

An object representing a group of functions.
Each function is defined as a Logical Node. A
device consists of one or several LDs.

SNMP OPC Logical Device (LD)
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An object defined by its data and methods. LN
is the smallest part of a function that exchanges
data.

Logical Node (LN)

Data object is an instance of one of the IEC
61850 Data Object Classes such as Single point
status and Measured Value. Depending on the
class, each data object has a set of attributes
for monitoring and controlling the object, e.g.
value, quality, and control.

Data Object (DO)

Building object tree8.3.

General information about building object tree8.3.1.

The object tree is built in the Communication structure of SAB600, see Figure 8.2-1. It
is built by adding objects in a logical order starting from the Gateway.

You have several possible ways to add objects to the object tree in the Communication
structure:
• You can right-click the object to which you want to add a child object. Then select

New > Object type group > Object name, for example New > SNMP > SNMP
OPC Server.

• You can right-click the object type and select New > New. A New Object window
appears. Select the object type you want to add and click OK or double-click it.

• You can copy the object.

Add the objects in the following order:
1. Gateway
2. SNMP OPC Server
3. SNMP Subnetwork
4. SNMP IED
5. Logical Device objects
6. Logical Node objects
7. Data objects

Adding Gateway object8.3.2.

To start building the object tree, add a Gateway object in the Communication structure
by selecting the project name, right-click it and select New > Communication > Gate-
way.
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Adding SNMP OPC Server object8.3.3.

After the Gateway object has successfully been added, you can continue building the
object tree by adding an SNMP OPC Server object.

To add SNMP OPC Server object:
1. Select the Gateway object in the communication structure and right-click it.
2. Select New > SNMP > SNMP OPC Server.

By using the SCL Import function, it is possible to import an entire server’s or individual
device's configurations without having to insert them manually. To open the SCL Import
function, right-click the desired object, and select SCL Import.

For more information about the SCL Import function, see COM600 User's Manual.

Adding SNMP subnetwork objects8.3.4.

After the server object has been successfully added, you can continue building the object
tree by adding subnetwork objects.

To add SNMP OPC subnetwork object:
1. Select the SNMP OPC Server object.
2. Right-click the SNMP OPC Server object.
3. Select New > New or New > SNMP > SNMP Subnetwork.

Adding SNMP IED objects8.3.5.

After adding a subnetwork you can add device objects.

To add an SNMP subnetwork object:
1. Select a Subnetwork object.
2. Right-click on the Subnetwork object and select New > New or New > SNMP >

SNMP IED.

With SCL import function, you can import new objects with configurations from an
existing file. Right-click the device and select SCL Import from the shortcut menu.

To import a new configuration file:
1. Click Select File.
2. Browse to a new configuration file from the appearing dialog.
3. Select the file and click Open.
4. Select the device to import from the drop-down list. You can preview the configur-

ation on the right.
5. Click Import.
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The new preconfigured objects appear in the object tree. If the configuration file is large,
the import may take time. To import a configuration file for a different device, right-
click the device, select SCL Import again and repeat the steps above.

For more information about the SCL Import function, see COM600 User's Manual.

Adding Logical Device objects8.3.6.

To add a Logical Device object:
1. Select an SNMP IEC object and right-click it.
2. Select New > New or New > Communication > SNMP LD.

Each SNMP IED must have at least one Logical Device object
as a child object.

Adding Logical Node objects8.3.7.

To add a Logical Node:
1. Select a Logical Device object and right-click it.
2. Add a Logical Node object.
3. Rename the new object. The names of the Logical Node objects have to be unique.

You should have only one Logical Node 0 (LLN0) as a child
object to a Logical Device object.

Adding data objects8.3.8.

To add a data object:
1. Select a Logical Node object and right-click it.
2. Add a data object.
3. Rename the new object. The names of the data objects have to be unique. However,

you can have a data object with same name under a different Logical Node.

Configuring objects8.4.

General information about configuring objects8.4.1.

After the objects have been added, configure the object properties. Figure 8.4.1-1 shows
an example of how to use SAB600 to configure the object properties for SNMP OPC
Server.
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To configure an object:
1. Select an object in the object tree of the communication structure.

• The object properties appear now in the Object Properties window. The proper-
ties and their values can be viewed as shown in Figure 8.4.1-1

SAB600_SNMP_Object_Properties_Example.png

Figure 8.4.1-1 Example of object properties in the Objects Properties window

2. Select the property you want to configure. Depending on the property value type,
configuring is always done either by
• selecting a predefined value from a drop-down menu, or
• entering a text string or a numerical value in a text field.

The available properties for different objects are listed in the following subsections.

Configuring SNMP Server properties8.4.2.

SNMP OPC Server does not have any configurable properties.

Configuring SNMP Subnetwork properties8.4.3.

The SNMP OPC Server subnetwork properties that can be configured and value ranges
for them can be found in Table 8.4.3-1. The actual configuration by using SAB600 is
performed as described in 8.4.1, General information about configuring objects.
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Table 8.4.3-1 SNMP Subnetwork properties
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic

Controls if the device communication is
initially in use or not.

In Use

Not In use

Default: In Use

In Use

Configuring SNMP IED properties8.4.4.

The SNMP OPC Server IED properties that can be configured and value ranges for them
can be found in Table 8.4.4-1. The actual configuration by using SAB600 is performed
as described in 8.4.1, General information about configuring objects.

Table 8.4.4-1 SNMP IED properties
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic

Specifies whether IED is in use or not.In Use

Not In use

Default: In Use

In Use

Defines whether IED is used in simulation
mode.

False

True

Default: False

Simulation Mode

SNMP version supported by the network
device.

SMNP v1

SNMP v2c

SNMP v3

Default: SNMP v2c

SNMP Version

Addresses

IP address of the IED.127.0.0.1IP Address

Community

Community name defined on the network
device. Community name is used to
authenticate SNMP packets, which must
match the community name that is spe-
cified on the agent.

publicCommunity Name
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DescriptionValue or Value range/ DefaultProperty/Para-
meter

Community name used for the writing
operation. The community name is used
to authenticate SNMP packets, which must
match the community name that is spe-
cified on the agent.

privateWrite Community
Name

Polling

Polling rate in seconds.0 to 3600

Default: 2

Poll Rate

A timeout of the component in seconds.
Timeout property is set to 0, all operations
return immediately. If the timeout is set to
a positive value, the system will want for
the operation to complete before returning.

0 to 3600

default: 5

Timeout

Security

The password used for SNMPv3 authen-
tication.

Authentication
Password

The authentication protocol used for
SNMPv3.

Not Used

MD5 SHA

Default: Not Used

Authentication Pro-
tocol

The encryption algorithm used for
SNMPv3 packets.

Not Used

DES

AES

3DES

Default: Not Used

Encryption
Algorithm

The encryption password used for
SNMPv3 privacy.

Encryption Pass-
word

The user name used for SNMPv3
authentication.

User name

Control Authoriza-
tion

Station/Remote Switch OPC Path

OPC Path of the station remote switch
position to be used with this device. The
format is Node#ProgID For OPC
Server#Channel Name\IED Name\Logical
Device Name\Logical Node Name\Data
Object Name E.g.
GW#ABB.DNP_LAN_OPC_DA_Server.Instance[1]#Chan-
nel1\IED1\LD1\GGI01\loc

Station/Remote
Switch OPC Path
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Configuring Logical Device properties8.4.5.

Table 8.4.5-1 Logical Device properties
DescriptionValue or Value range/

Default
Property/Parameter

Basic

OPC path of the station remote switch position
to be used with this logical device.

The format is Node#ProgID For OPC
Server#Channel Name\IED Name\Logical
Device Name\Logical Node Name\Data Object
Name

For example:

GW#ABB.conn_OPC_DA_Server.Instance[1]#Chan-
nel1\IED1\LD1\GGIO1\loc

Station/Remote Switch
OPC Path

Configuring Logical Node properties8.4.6.

Table 8.4.6-1 Logical Node properties
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic

Logical node class.LLN0 and Logical NodeLogical Node Class
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DescriptionValue or Value range/ DefaultProperty/Parameter

Logical node class.ANCR, ARCO, ATCC, AVCO,
LPHD, CALH, CCGR, CILO,
CPOW, CSWI, GAPC, GGIO,
GSAL, IARC, IHMI, ITCI, ITMI,
MDIF, MHAI, MHAN, MMTR,
MMXN, MMXU, MSQI, MSTA,
PDIF, PDIR, PDIS, PDOP,
PDUP, PFRC, PHAR, PHIZ,
PIOC, PMRI, PMSS, POPF,
PPAM, PSCH, PSEF, PTEF,
PTOC, PTOF, PTOV, PTRC,
PTTR, PTUC, PTUV, PUPF,
PTUF, PVOC, PVPH, PZSU,
RDRE, RADR, RBDR, RDRS,
RBRF, RDIR, RFLO, RPSB,
RREC, RSYN, SARC, SIMG,
SIML, SPDC, XCBR, XSWI,
TCTR, TVTR, YEFN, YLTC,
YPSH, YPTR, ZAXN, ZBAT,
ZBSH, ZCAB, ZCAP, ZCON,
ZGEN, ZGIL, ZLIN, ZMOT,
ZREA, ZRRC, ZSAR, ZTCF,
ZTCR

Default: GGIO

Logial Node Class

Configuring data objects for Internal OPC Data8.4.7.

General information about configuring data objects for Internal
OPC Data

8.4.7.1.

Internal data objects describe internal status information of an OPC server, for example
whether the connection between the SNMP OPC Server and the device (IED) is working
or not. When internal information of an OPC server needs to be transferred, that is
information that does not originate from a device, to an OPC Client, virtual data objects
must be created.

The available properties for different objects are listed in the following subsections.

Integer status (INS) for OPC internal data8.4.7.2.

Table 8.4.7.2-1 Configurable INS (for OPC internal data) properties for OPC Servers
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic
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DescriptionValue or Value range/ DefaultProperty/Para-
meter

Common data class according to IEC
61850

INSCommon Data
Class

Addresses

Item tag path for the internal status
information. The internal server tags that
can be used are located in the Attributes
nodes that are located under the root, line,
and IED nodes. When an attribute tag is
referred to in the internal item definitions
below, it is possible to use either the whole
tag path or just the path relative to the IED
(the internal tags are configured per IED);
for example, Attributes\Diagnostic coun-
ters\Transmitted data messages. When
the whole path is used, it must be pre-
ceded by a slash (/) character, for
example, /Channel Name\Attributes\Dia-
gnostic counters\Transmitted data mes-
sages.

Default: NoneItem Tag Path

Controllable single point (SPC) for OPC internal data8.4.7.3.

Table 8.4.7.3-1 Configurable SPC (for OPC internal data) properties for OPC Servers
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic

Common data class according to IEC
61850.

SPCCommon Data
Class

Addresses

Item tag path for the internal status
information. The internal server tags that
can be used are located in the Attributes
nodes that are located under the root, line
and IED nodes. When an attribute tag is
referred to in the internal item definitions
below it is possible to use either the whole
tag path or just the path relative to the IED
(the internal tags are configured per IED)
e.g. Attributes\Diagnostic counters\Trans-
mitted data messages. When the whole
path is used it must be preceded by a
slash (/) character e.g. /Channel
Name\Attributes\Diagnostic counters\Trans-
mitted data messages.

Default: NoneItem Tag Path
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Single point status (SPS) for OPC internal data8.4.7.4.

Table 8.4.7.4-1 Configurable SPS (for OPC internal data) properties for OPC servers
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic

SPSCommon Data Class

Addresses

Item tag path for the internal
status information. The internal
server tags that can be used
are located in the Attributes
nodes that are located under
the root, line, and IED nodes.
When an attribute tag is
referred to in the internal item
definitions below, it is possible
to use either the whole tag path
or just the path relative to the
IED (the internal tags are con-
figured per IED); e.g. Attrib-
utes\Diagnostic counters\Trans-
mitted data messages. When
the whole path is used, it must
be preceded by a slash (/)
character, e.g. /Channel
Name\Attributes\Diagnostic
counters\Transmitted data
messages.

Attributes\Device connection
status

Item Tag Path

Alarm and Event

Indication event used with this
data object.

Default: Empty stringIndication Event

Configuring data objects for SNMP Device8.4.8.

General information about configuring data objects for SNMP
Device

8.4.8.1.

Object Identifiers (OIDs) are used in data object configuration. Each OID identifies a
variable that can be read or set via SNMP. The SNMP device uses a hierarchical
namespace Management Information Base (MIB) to contain OIDs. You can find all
available OIDs from the MIB file published by the device. The MIB files have the
extension .mib and are generally distributed with the device.

The available properties for different objects are listed in the following subsections.
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The parameters are stored in Object Properties in SAB600, see the tables for each data
object type. The actual configuration by using SAB600 is performed as described in
8.4.1, General information about configuring objects.

Device name plate (DPL)8.4.8.2.

Table 8.4.8.2-1 Configurable DPL properties for SNMP OPC Server, subtype Basic
DescriptionValue or Value range/ DefaultProperty/ Para-

meter

Basic

Common data class according to IEC
61850

DPLCommon Data
Class

Object subtype.BasicSub Type

Vendor

Text string describing the vendor.ABBVendor

Hardware Revision

Text string describing the hardware revi-
sion.

1.0Hardware Revision

Software Revision

Text string describing the software revi-
sion.

1.0Software Revision

Serial Number

Text string describing the serial number.ABB123456789Serial Number

Location

Textstring describing the location.VaasaLocation

Table 8.4.8.2-2 Configurable DPL properties for SNMP OPC Server, subtype Read
From Device

DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Basic

Common data class according to IEC
61850

DPLCommon Data
Class

Object subtype.Read From DeviceSub Type

Vendor

SNMP Object Identifier (OID) of the
vendor.

Vendor OID

Hardware Revision

SNMP Object Identifier (OID) of the device
hardware revision.

Hardware Revision
OID
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DescriptionValue or Value range/ DefaultProperty/ Para-
meter

Software Revision

SNMP Object Identifier (OID) of the device
software revision.

Software Revision
OID

Serial Number

SNMP Object Identifier (OID) of the device
serial number.

Serial Number OID

Location

SNMP Object Identifier (OID) of the device
location.

Location OID

Controllable integer status (INC)8.4.8.3.

Table 8.4.8.3-1 Configurable INC properties for OPC servers with SNMP device
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

Common data class according to IEC
61850.

INCCommon Data
Class

Object Identifier

SNMP Object Identifier (OID) of the man-
aged object.

1.3.6.1.2.1.25Object Identifier

Scale and Unit

Scale for output.Lookup Table Scale

Stepwise Linear Scale

Default: None

Output Scale

Scale for status.Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Integer status (INS)8.4.8.4.

You can select the subtype in the Object Properties of
SAB600.
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Table 8.4.8.4-1 Configuring INS properties for OPC Servers with SNMP Device
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic

Common data class according
to IEC 61850.

INSCommon Data Class

Object Identifier

SNMP Object Identifier (OID)
of the managed object.

1.3.6.1.2.1.25Object Identifier

Scale and Unit

Scale to be used with this type.Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Logical Node name plate (LPL)8.4.8.5.

Table 8.4.8.5-1 Configurable LPL properties for SNMP OPC Server, subtype Basic
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

Common data class according to IEC
61850.

LPLCommon Data
Class

Object subtype.BasicSub Type

Vendor

A text string describing the vendor.ABBVendor

Software Revision

A text string describing software revision.1.0Software Revision

Table 8.4.8.5-2 Configurable LPL properties for SNMP OPC Server, subtype Read
From Device

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

Common data class according to IEC
61850.

LPLCommon Data
Class

Object subtype.Read From DeviceSub Type

Vendor

SNMP Object Identifier (OID) of the
vendor.

Default: NoneVendor OID
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Software Revision

SNMP Object Identifier (OID) of device
software revision.

Default: NoneSoftware Revision
OID

Measured value (MV)8.4.8.6.

Table 8.4.8.6-1 Configurable MV properties for SNMP OPC Servers, subtype MV
Simple

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

Common data class according to IEC
61850

MVCommon Data
Class

Object subtype.MV SimpleSub Type

Object Identifier

SNMP Object Identifier (OID) of the man-
aged object.

1.3.6.1.2.1.25Object Identifier

Scale and Unit

Specifies the multiplier for current SI unit.yocto, zepto, atto, femto, pico,
nano, micro, milli, centi, deci,
No multiplier, deka, hecto, kilo,
mega, giga, tera, petra, exa,
zetta, yotta

Default: Deka

Multiplier

Specifies the number of decimals shown
in HSI. (0..9)

Default: 0Number of Decimals

Scale to be used with this type.Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

SI unit for measurement as described in
IEC 61850.

meter, kilogram, second,
ampere, kelvin, mole, candela,
degrees, radian, steradian,
gray (J/Kg), becquerel (l/s),
degrees (Celsius), sievert
(J/Kg), farad, coulomb,
siemens, henry, volt, ohm, joule
(Nm), newton (kg m/s^2), hertz,
lux (lm/m^2)lx, lumen (cd sr),
weber (V s), tesla (Wb / m^2),
watt (J/s), pascal (N/m^2),
square meter (m^2), cubic
meter (m^3), meters per
second (m/s), meters per
second^2 (m/s^2), cubic meters
per second (m^3/s), mass per
cubic meter (kg/m^3), kilogram
meter (kg m), kilogram per
cubic meter (kg/m^3), meter
square / second (m^2/s), watt
per meter kelvin (W / m K),
joule per kelvin (J / K), parts
per million, rotations per
second (1 / s), radian per
second (rad / s), volt ampere
(VA), watts (I^2R), volt ampere
reactive (VISin), degrees,
(dimensionless) Cos, volt
seconds (Ws / A), volt square
(W^2 / A^2), amp second (As),
amp square (A^2), amp square
second (A^2s), volt ampere
hours, watt hours, volt ampere
reactive hours, volts per hertz

Default: Dimensionless

Unit

Limit Value Super-
vision

Maximum value for measurement.20000Max

Minimum value for measurement.0Min

Table 8.4.8.6-2 Configurable MV properties for SNMP OPC Servers, subtype MV
Limit Check

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

Common data class according to IEC
61850

MVCommon Data
Class

Object subtype.MV Limit CheckSub Type
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Object Identifier

SNMP Object Identifier (OID) of the man-
aged object.

1.3.6.1.2.1.25Object Identifier

Scale and Unit

Specifies the multiplier for current SI unit.yocto, zepto, atto, femto, pico,
nano, micro, milli, centi, deci,
No multiplier, deka, hecto, kilo,
mega, giga, tera, petra, exa,
zetta, yotta

Default: Deka

Multiplier

Specifies the number of decimals shown
in HSI.

0 to 9

Default: 0

Number of Decimals

Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

SI unit for measurement as described in
IEC 61850.

meter, kilogram, second,
ampere, kelvin, mole, candela,
degrees, radian, steradian,
gray (J/Kg), becquerel (l/s),
degrees (Celsius), sievert
(J/Kg), farad, coulomb,
siemens, henry, volt, ohm, joule
(Nm), newton (kg m/s^2), hertz,
lux (lm/m^2)lx, lumen (cd sr),
weber (V s), tesla (Wb / m^2),
watt (J/s), pascal (N/m^2),
square meter (m^2), cubic
meter (m^3), meters per
second (m/s), meters per
second^2 (m/s^2), cubic meters
per second (m^3/s), mass per
cubic meter (kg/m^3), kilogram
meter (kg m), kilogram per
cubic meter (kg/m^3), meter
square / second (m^2/s), watt
per meter kelvin (W / m K),
joule per kelvin (J / K), parts
per million, rotations per
second (1 / s), radian per
second (rad / s), volt ampere
(VA), watts (I^2R), volt ampere
reactive (VISin), degrees,
(dimensionless) Cos, volt
seconds (Ws / A), volt square
(W^2 / A^2), amp second (As),
amp square (A^2), amp square
second (A^2s), volt ampere
hours, watt hours, volt ampere
reactive hours, volts per hertz

Default: Dimensionless

Unit

Limit Value Super-
vision

High limit for measurement. Event is cre-
ated, when value crosses the limit.

0High

High-high limit for measurent. Event is
created, when value crosses the limit.

0High-High

Low limit for measurement. Event is cre-
ated, when value crosses the limit.

0Low

Low-low limit for measurement. Event is
created, when value crosses the limit.

0Low-Low

Maximum value for measurement.20000Max

Minimum value for measurement.0Min
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Controllable Single point (SPC)8.4.8.7.

Table 8.4.8.7-1 Configurable SPC properties for OPC servers with SNMP device,
subtype Basic

DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Basic

Common data class according to IEC
61850

SPCCommon Data
Class

Object subtypeBit Mask

Default: Basic

Sub Type Basic

Object Identifier

SNMP Object Identifier (OID) of the man-
aged object.

1.3.6.1.2.1.25Object Identifier

Scale and Unit

Scale for output.Lookup Table Scale

Stepwise Linear Scale

Default: None

Output Scale

Scale for status.Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Table 8.4.8.7-2 Additional configurable properties for Sub-Type Bit Mask
DescriptionValue or Value range/ Default

/Example
Property/Para-
meter

Basic

Common data class according to IEC
61850

SPCCommon Data
Class

Object subtype.Bit MaskSub Type

Object Identifier

Object Identifier (OID) of the managed
object.

1.3.6.1.2.1.25Object Identifier

Addresses

Bit Mask for ouput.0..65535

Default: 1

Output Bit Mask

Bit Mask for status.0..65535

Default: 1

Status Bit Mask

Scale and Unit
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DescriptionValue or Value range/ Default
/Example

Property/Para-
meter

Scale for output.Lookup Table Scale

Stepwise Linear Scale

Default: None

Output Scale

Scale for status.Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale

Single point status (SPS) for OPC internal data8.4.8.8.

Table 8.4.8.8-1 Configurable SPS (for OPC internal data) properties for OPC servers
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic

SPSCommon Data Class

Addresses

Item tag path for the internal
status information. The internal
server tags that can be used
are located in the Attributes
nodes that are located under
the root, line, and IED nodes.
When an attribute tag is
referred to in the internal item
definitions below, it is possible
to use either the whole tag path
or just the path relative to the
IED (the internal tags are con-
figured per IED); e.g. Attrib-
utes\Diagnostic counters\Trans-
mitted data messages. When
the whole path is used, it must
be preceded by a slash (/)
character, e.g. /Channel
Name\Attributes\Diagnostic
counters\Transmitted data
messages.

Attributes\Device connection
status

Item Tag Path

Alarm and Event

Indication event used with this
data object.

Default: Empty stringIndication Event
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Binary counter reading (BCR)8.4.8.9.

Table 8.4.8.9-1 Configuring BCR properties for OPC Servers with SNMP Device
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic

Common data class according
to IEC 61850.

BCRCommon Data Class

Object Identifier

SNMP Object Identifier (OID)
of the managed object.

1.3.6.1.2.1.25Object Identifier

Scale and Unit

Scale to be used with this type.Lookup Table Scale

Stepwise Linear Scale

Default: None

Scale
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SNTP OPC server configuration9.

About this section9.1.

This section guides you in the configuration tasks required before you can start using
the SNTP OPC Server. For information on the IEC 61850 data modeling, refer to
COM600 User's Manual.

Start SAB600 to open a project. You can also open and name a new project.

1. Select File > Open/Manage Project....
2. In the Open/Manage Project dialog, select the required location for the project:

• Projects on my computer
• Projects on network

3. Select New Project on the left.
• Enter a Project Name. The Description is optional.

4. Click Create.
5. Click Open Project.

Overview of configuration9.2.

Before you can start using the SNTP OPC Server, you need to build and configure an
object tree in SAB600 to define the Communication structure within the Gateway object.

The possible objects are:
• Gateway
• SNTP OPC Server
• SNTP Virtual Subnetwork
• SNTP Virtual IED
• Logical Device objects
• Logical Node objects
• Data objects

Figure 9.2-1 shows an example view of SAB600 including an object tree in the commu-
nication structure on the left and Object Properties window displaying the object properties
on the right.

When configuring OPC servers the following characters cannot
be used in object names: \ ` ' ' #

291

COM600 series 5.11MRS758689

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



SAB600_SNTP_Example_View.png

Figure 9.2-1 Example view of SAB600

The configuration work can basically be divided into two separate tasks:
1. building an object tree, and
2. configuring object properties.

First, you need to build an object tree. This is done by adding objects to the object tree,
see 8.3.1, General information about building object tree.

Figure 9.2-1 shows an example of how the object tree may look like after it has been
built. In the example tree you can see the SNMP OPC Server object and its child objects
like subnetworks, devices, and data objects. Indentation is used to indicate the parent-
child relationship between the objects.

After you have added the necessary objects to the object tree in the communication
structure, you need to configure them, see 9.5.1, Configuring object properties.

Table 9.2-1 SNTP OPC Server related objects
DescriptionObject

An object representing the SNTP OPC Server.SNTP OP Server

Object representing a physical subnetwork.SNTP Virtual Subnetwork

The IED object presents a virtual device.SNTP Virtual IED

An object representing a group of functions.
Each function is defined as a Logical Node. A
device consists of one or several LDs.

SNTP Virtual Logical Device (LD)

An object defined by its data and methods. LN
is the smallest part of a function that exchanges
data.

Logical Node (LN)
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Data object is an instance of one of the IEC
61850 Data Object Classes such as Single point
status and Measured Value. Depending on the
class, each data object has a set of attributes
for monitoring and controlling the object, e.g.
value, quality, and control.

Data Object (DO)

Configuring SNTP OPC Server properties9.3.

Table 9.3-1 lists the configurable SNTP OPC Server properties and value ranges for
them. The actual configuration by using SAB600 is performed as described in
9.5.1, Configuring object properties.

Table 9.3-1 SNTP OPC Server properties
DescriptionValue/Value rangeName

SNTP Client

IP address or node name for SNTP
Server (Primary)

1. Address for
SNTP Server

TCP/IP port number(1..65535)

Default: 123

1. Port Number

Time syncronization interval in
seconds. If value is 0, no time syn-
cronization will be done.

(0..3600)

Default: 15

1. Synchroniza-
tion Interval

IP address or node name for SNTP
Server.

Default: None2. Address for
SNTP Server

TCP/IP port number(1...65535)

Default: 123

2. Port Number

Time synchronization interval in
seconds. If value is 0, no time syn-
cronization will be done.

(0..3600)

Default: 15

2. Synchroniza-
tion Interval

IP address or node name for SNTP
Server.

3. Address for
SNTP Server

TCP/IP port number.(1...65535)

Default: 123

3. Port Number

Time syncronization interval in
seconds. If value is 0, no time syn-
cronization will be done.

(0..3600)

Default: 15

3. Synchroniza-
tion Interval

IP address or node name for SNTP
Server.

Default: None4. Address for
SNTP Server

TCP/IP port number.(1...65535)

Default: 123

4. Port Number
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DescriptionValue/Value rangeName

Time syncronization interval in
seconds. If value is 0, no time syn-
cronization will be done.

(0..3600)

Default: 15

4. Synchroniza-
tion Interval

Controls if time synchronization client
is initially in use or not.

True

False

Default: False

Enable Time Syn-
chronization Cli-
ent

SNTP Server

Controls if time synchronization server
is initially in use or not.

True

False

Default: False

Enable Time Syn-
chronization
Server

Port number for time synchronization
server

(1...65535)

Default: 123

Port Number For
Time Synchroniza-
tion Server

Building object tree9.4.

General information about building object tree9.4.1.

The object tree is built in the Communication structure of SAB600, see Figure 9.2-1. It
is built by adding objects in a logical order starting from the Gateway.

You have several possible ways to add objects to the object tree in the Communication
structure:
• You can right-click the object to which you want to add a child object. Then select

New > Object type group > Object name, for example New > Time Synchroniz-
ation > SNTP OPC Server.

• You can right-click the object type and select New > New. A New Object window
appears. Select the object type you want to add and click OK or double-click it.

• You can copy the object.

Add the objects in the following order:
1. Gateway
2. SNTP OPC Server
3. SNTP Virtual Subnetwork (optional)
4. SNTP Virtual IED (optional)
5. Logical Device objects (optional)
6. Logical Node objects (optional)
7. Data objects (optional)
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Virtual Subnetwork and objects below it are only needed for
diagnostic purpose.

Adding Gateway object9.4.2.

To start building the object tree, add a Gateway object in the Communication structure
by selecting the project name, right-click it and select New > Communication > Gate-
way.

Adding SNTP OPC Server object9.4.3.

After the Gateway object has successfully been added, you can continue building the
object tree by adding an SNTP OPC Server object.

To add SNMP OPC Server object:
1. Select the Gateway object in the communication structure and right-click it.
2. Select New > Time Synchronization > SNTP OPC Server.

By using the SCL Import function, it is possible to import an entire server’s or individual
device's configurations without having to insert them manually. To open the SCL Import
function, right-click the desired object, and select SCL Import.

For more information about the SCL Import function, see COM600 User's Manual.

Adding SNTP Virtual Subnetwork objects (optional)9.4.4.

Virtual Subnetwork and the objects below it are only used to
provide diagnostic status information about the SNTP server
or client for the COM600 WebHMI or other applications.

After the server object has been successfully added, you can continue building the object
tree by adding subnetwork objects.

To add SNTP Virtual subnetwork object:
1. Select the SNTP OPC Server object.
2. Right-click the SNTP OPC Server object.
3. Select New > New or New > Virtual > SNTP Virtual Subnetwork.

295

COM600 series 5.11MRS758689

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



Adding virtual IED objects (optional)9.4.5.

After adding a subnetwork you can add virtual device objects.

To add a virtual device object:
1. Select a Subnetwork object.
2. Right-click on the Subnetwork object and select New > New or New > Virtual >

SNTP Virtual IED.

With SCL import function, you can import new objects with configurations from an
existing file. Right-click the device and select SCL Import from the shortcut menu.

To import a new configuration file:
1. Click Select File.
2. Browse to a new configuration file from the appearing dialog.
3. Select the file and click Open.
4. Select the device to import from the drop-down list. You can preview the configur-

ation on the right.
5. Click Import.

The new preconfigured objects appear in the object tree. If the configuration file is large,
the import may take time. To import a configuration file for a different device, right-
click the device, select SCL Import again and repeat the steps above.

For more information about the SCL Import function, see COM600 User's Manual.

Adding Logical Device objects (optional)9.4.6.

Virtual subnetwork and the objects below it are only used for diagnostic purpose. Once
a Virtual IED object is added, two data objects representing Server Status and Client
Status are pre-populated and included in the object tree.

To add a Logical Device object:
1. Select an SNTP Virtual IED object and right-click it.
2. Select New > New or New > Communication > SNTP Virtual LD.

Each SNTP IED must have at least one Logical Device object
as a child object.

Adding Logical Node objects (optional)9.4.7.

To add a Logical Node:
1. Select a Logical Device object and right-click it.
2. Add a Logical Node object.
3. Rename the new object. The names of the Logical Node objects have to be unique.
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You should have only one Logical Node 0 (LLN0) as a child
object to a Logical Device object.

Adding data objects (optional)9.4.8.

To add a data object:
1. Select a Logical Node object and right-click it.
2. Add a data object.
3. Rename the new object. The names of the data objects have to be unique. However,

you can have a data object with same name under a different Logical Node.

Configuring objects9.5.

Configuring object properties9.5.1.

After the objects have been added, you must configure the object properties.

To configure an object:
1. Select an object in the object tree of the Communication structure.
2. The object properties appear now in the Object Properties window, see Figure 9.5.1-

1. You can see the selected object on the left and the available properties on the
right.

3. Select the property you want to configure. Depending on the property value type,
configuring is always done either by
• selecting a predefined value from a drop-down combo box, or
• entering a text string or a numerical value in a text field.
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SAB600_SNTP_Object_Properties_Example.png

Figure 9.5.1-1  Example of object properties

The available properties for different objects are listed in the following subsections.

Configuring SNTP OPC Server properties9.5.2.

Table 9.3-1 lists the configurable SNTP OPC Server properties and value ranges for
them. The actual configuration by using SAB600 is performed as described in
9.5.1, Configuring object properties.

Table 9.5.2-1 SNTP OPC Server properties
DescriptionValue/Value rangeName

SNTP Client

IP address or node name for SNTP
Server (Primary)

1. Address for
SNTP Server

TCP/IP port number(1..65535)

Default: 123

1. Port Number

Time syncronization interval in
seconds. If value is 0, no time syn-
cronization will be done.

(0..3600)

Default: 15

1. Synchroniza-
tion Interval
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DescriptionValue/Value rangeName

IP address or node name for SNTP
Server.

Default: None2. Address for
SNTP Server

TCP/IP port number(1...65535)

Default: 123

2. Port Number

Time synchronization interval in
seconds. If value is 0, no time syn-
cronization will be done.

(0..3600)

Default: 15

2. Synchroniza-
tion Interval

IP address or node name for SNTP
Server.

3. Address for
SNTP Server

TCP/IP port number.(1...65535)

Default: 123

3. Port Number

Time syncronization interval in
seconds. If value is 0, no time syn-
cronization will be done.

(0..3600)

Default: 15

3. Synchroniza-
tion Interval

IP address or node name for SNTP
Server.

Default: None4. Address for
SNTP Server

TCP/IP port number.(1...65535)

Default: 123

4. Port Number

Time syncronization interval in
seconds. If value is 0, no time syn-
cronization will be done.

(0..3600)

Default: 15

4. Synchroniza-
tion Interval

Controls if time synchronization client
is initially in use or not.

True

False

Default: False

Enable Time Syn-
chronization Cli-
ent

SNTP Server

Controls if time synchronization server
is initially in use or not.

True

False

Default: False

Enable Time Syn-
chronization
Server

Port number for time synchronization
server

(1...65535)

Default: 123

Port Number For
Time Synchroniza-
tion Server
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Configuring data objects for Internal OPC Data9.5.3.

General information about configuring data objects for Internal
OPC Data

9.5.3.1.

Internal data objects describe internal status information of an OPC server, for example
whether the connection between the SNTP OPC Server and the device (IED) is working
or not. When internal information of an OPC server needs to be transferred, that is
information that does not originate from a device, to an OPC Client, virtual data objects
must be created.

The SNTP OPC Server supports three internal data object types that provide status
information:
• 8.4.7.2, Integer status (INS) for OPC internal data
• 7.5.7.4, Controllable single point (SPC) for OPC internal data
• 9.5.3.4, Single point status (SPS) for OPC internal data

Integer status (INS) for OPC internal data9.5.3.2.

Table 9.5.3.2-1 Configurable INS (for OPC internal data) properties for OPC Servers
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic

Common data class according to IEC
61850

INSCommon Data
Class

Addresses

Item tag path for the internal status
information. The internal server tags that
can be used are located in the Attributes
nodes that are located under the root, line,
and IED nodes. When an attribute tag is
referred to in the internal item definitions
below, it is possible to use either the whole
tag path or just the path relative to the IED
(the internal tags are configured per IED);
for example, Attributes\Diagnostic coun-
ters\Transmitted data messages. When
the whole path is used, it must be pre-
ceded by a slash (/) character, for
example, /Channel Name\Attributes\Dia-
gnostic counters\Transmitted data mes-
sages.

Default: NoneItem Tag Path
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Controllable single point (SPC) for OPC internal data9.5.3.3.

Table 9.5.3.3-1 Configurable SPC (for OPC internal data) properties for OPC Servers
DescriptionValue or Value range/ DefaultProperty/Para-

meter

Basic

Common data class according to IEC
61850.

SPCCommon Data
Class

Addresses

Item tag path for the internal status
information. The internal server tags that
can be used are located in the Attributes
nodes that are located under the root, line
and IED nodes. When an attribute tag is
referred to in the internal item definitions
below it is possible to use either the whole
tag path or just the path relative to the IED
(the internal tags are configured per IED)
e.g. Attributes\Diagnostic counters\Trans-
mitted data messages. When the whole
path is used it must be preceded by a
slash (/) character e.g. /Channel
Name\Attributes\Diagnostic counters\Trans-
mitted data messages.

Default: NoneItem Tag Path

Single point status (SPS) for OPC internal data9.5.3.4.

Table 9.5.3.4-1 Configurable SPS (for OPC internal data) properties for OPC servers
DescriptionValue or Value range/ DefaultProperty/Parameter

Basic

SPSCommon Data Class

Addresses
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Item tag path for the internal
status information. The internal
server tags that can be used
are located in the Attributes
nodes that are located under
the root, line, and IED nodes.
When an attribute tag is
referred to in the internal item
definitions below, it is possible
to use either the whole tag path
or just the path relative to the
IED (the internal tags are con-
figured per IED); e.g. Attrib-
utes\Diagnostic counters\Trans-
mitted data messages. When
the whole path is used, it must
be preceded by a slash (/)
character, e.g. /Channel
Name\Attributes\Diagnostic
counters\Transmitted data
messages.

Client Status:

Attributes\TimeSync\Timesync
client\In use

Attributes\TimeSync\Timesync
client\Timesync status

Server Status:

Attributes\TimeSync\Timesync
server\In use

Attributes\TimeSync\Timesync
server\Timesync status

Item Tag Path

Alarm and Event

Indication event used with this
data object.

Default: Empty stringIndication Event
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Redundant OPC server configuration10.

Introduction10.1.

The Redundant OPC server allows the user to have Redundant IED objects, where each
Redundant IED object encapsulates the data of two source IED objects with an identical
data object configuration.

One of the source IEDs is set as the active source of the Redundant IED, which will then
act as if it was that source IED. The Redundant IED forwards indication and measurement
data from the active source IED, and sends received commands to it.

It’s possible for the user to switch the active source between the two source IEDs on
demand, for example when the currently active source IED loses connection or has some
other mishap, or is simply taken down for maintenance.

The source OPC server and IEDs are required to follow the common IEC-61850 data
object model used in COM600, otherwise there are no limitations. There is special support
in SAB600 for making redundant configurations with SSC600, though.

Configuration10.2.

General information about the configuration10.2.1.

The Redundant OPC server and IED are configured like any other OPC server in
COM600. The needed objects are added to the communication tree in SAB600 and their
properties are configured.

The starting point of the SCC600 redundancy configuration is to export the SSC600
configuration from PCM600 as an SCD file, importing that to SAB600 and transferring
the configuration to COM600.

The SAB600 configuration can be done via the COM600 configuration wizard or from
an SAB600 object tree. In both cases IEC61850 configuration is created first. After
IEC61850 configuration has been created.

Use the IED compare tool in PCM600 to verify that IEDs are
identical. SAB600 prevents from creating a redundant pair in
case IEDs in the SCD file are not consistent.
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Configuration from SAB600 object tree10.2.2.

1. Import IEC61850 OPC Configuration
2. Create Redundant OPC Server object
3. Select “Redundant Pair Tool” from the context menu of the Redundant OPC object.

SAB600_launch_redundant_pair_tool.png

Figure 10.2.2-1 SAB600 launch Redundant Pair Tool
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4. Select pairs

Configuration_wizard_select_redundant_pair.png

Figure 10.2.2-2 Configuration Wizard select redundant pair
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5. Click Finish.
6. Admire configuration.

SAB600_Project_created.png

Figure 10.2.2-3 SAB600 Project created
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Configuration using COM600 Configuration Wizard10.2.3.

1. Import IEC61850 configuration.

Configuration_wizard_first_server_SCL_import.png

Figure 10.2.3-1 Configuration Wizard First Server SCL Import

2. Select Redundant Server from the Optional Servers Page.
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Configuration_wizard_optional_servers.png

Figure 10.2.3-2 Configuration Wizard optional servers
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3. Click Finish.

Configuration_wizar_summary.png

Figure 10.2.3-3 Configuration Wizard summary

4. Select pairs when needed.
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Configuration_wizard_select_redundant_pair.png

Figure 10.2.3-4 Configuration Wizard select redundant pair

5. Admire configuration.
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SAB600_Project_created.png

Figure 10.2.3-5 SAB600 Project created

Active source10.3.

General information about the active source10.3.1.

Active source determines which of the two source IEDs is currently active. This can be
both configured in SAB600 and changed dynamically at runtime.

The configuration is done via the Active Source Default property of the redundant IED.
It’s also possible to define an event class for a generated event when the active source
is changed and a refresh interval to automatically re-send this event with the current
active source after a specified interval. This might be useful to ensure the current active
source shows up at a regular interval in the COM600 event list.
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External inputs10.3.2.

General information about external inputs10.3.2.1.

It’s possible to change the active source from the external input signals. This can either
be done by modifying Attributes\Active source directly via e.g. an Internal data object,
or by defining an active source input signal via the Redundant IED properties.

Internal data object10.3.2.2.

To update the active source via an internal data object, simply add an Internal SPC data
object under the Redundant IED and set its Item Tag Path to Attributes\Active source.
The added SPC data object can be updated from external data sources like the COM600
cross-reference or from COM600 OPC clients as needed.

It will still be possible to update the active source from other signals, or directly from
COM600 WebHMI as well.

Input signal10.3.2.3.

To update the active source from a specific input signal, such a signal must first be
configured as a data object in an OPC server reachable from COM600. Then, simply
specify this OPC server ProgID and the OPC path of the data object in the server to the
Redundant IED properties for Active Source – Input Signal. A scale can additionally
be defined in case the input signal does not have the interval 0...1.

When this is done, the active source can only be updated from this specific input signal
and not from any other ones, the COM600 WebHMI as well will not be able to update
the active source.

Consistency checking10.4.

Enable consistency checking10.4.1.

When enabled, there are several options to control how consistency checking is performed.
First, which CDC types will be consistency checked and second, how the checks will
be performed. This is done via the three Consistency Compare For properties of the
Redundant IED. They allow the user to configure whether value, value + quality or
value + quality + time is compared for the specified CDC types.

Additionally, it’s possible to configure the timestamp epsilon to define the range in which
two timestamp values are considered equal. Timestamp is only compared for indication
CDC types, never for measurements. Instead, for measurements it’s possible to configure
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a value epsilon to define a range in which two values (direct value without considering
multiplier) are considered equal.

Finally, a minimum check age is defined. This determines how much time must elapse
since the last update to a data object until it can be checked for consistency. This is done
to ensure that the “same” values from the two source IEDs are compared, as there are
no sequence numbers for the updated OPC data and no guaranteed update order.

Supported data object CDC types10.4.2.

These indication CDC types support consistency checking: ACD, ACT, BCR, BSC,
DPC, DPS, ENC, ENS, INC, INS, ISC, SEC, SPC and SPS.

These measurement CDC types support consistency checking: APC, CMV, DEL, MV,
SEQ and WYE.

Consistency checking effects10.4.3.

When consistency checking fails there are a number of actions that can be taken. There
are Redundant IED properties to enable/disable all of these:

• Quality for the data object in the Redundant IED is set to UNCERTAIN
• An event is generated to the COM600 event list

• Can have an event generated for each inconsistent update of a specific data
object

• Or only for the first inconsistent update and no more until the object gets con-
sistent again first

• This event shows the inconsistent data object, the specific attribute and the
value, quality or timestamp values from the source IEDs

• It’s possible to filter the event list to show only this event type
• An alarm is generated to the COM600 event list
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• This alarm affects the Redundant IED itself and is activated when there is any
inconsistent data

COM600-Redundant_OPC_server-Event_list-inconsistent_data_events.png

Figure 10.4.3-1 Inconsistent event in COM600 event list

COM600_Redundant_OPC_server-Event_list-filter-inconsistent.png

Figure 10.4.3-2 Filtering inconsistent events from the event filter
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IEC 61850 OPC server operation11.

Activating COM600 with new configuration11.1.

For information about activating COM600 with new configuration, see COM600 User’s
Manual.

IEC 61850 OPC Server diagnostics11.2.

After the IEC 61850 OPC Server has been installed and configured, you can, for example,
monitor and control the condition of connections in an IEC 61850 network.

This is done by using the Online Diagnostics function in , select Tools > Online Dia-
gnostics or select the object, right-click the IEC 61850 Server object and select Online
Diagnostics from the shortcut menu.

The server, a device, or data object is dragged and dropped from the Project Explorer’s
Communication structure under the Online Diagnostics function. Select the Project
Explorer from the View menu if it is not already open.

You have the following alternatives:
• to reset counters (restart the OPC server)
• to view the event log file
• to clear the log file
• to reconnect the online diagnostics
• to enable or disable the SNTP client

Diagnostic AE Client11.3.

Diagnostic events can be monitored and controlled using the Diagnostic AE Client
function. Click Refresh to update the status information. To be able to receive events
from a certain device, diagnostic events must be enabled for this device

To enable diagnostic events:
1. Right-click the device.
2. Select Diagnostic AE client.

Monitoring and controlling IEC 61850 subnetwork
activity

11.4.

The IEC 61850 subnetwork activity can be monitored with the Online Diagnostics
function.
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You can also take a subnetwork into use or out of use.

To monitor and control IEC 61850 subnetwork activity:
1. Select the subnetwork you want to monitor in the object tree of .
2. Right-click the channel.
3. Select Online Diagnostics.

In the Diagnostic counters field, you can monitor the subnetwork activity and the available
properties. To reset Diagnostic counters, click Reset counters.

You can take an IEC 61850 subnetwork into use by selecting the In use check box. If
you clear the check box, the subnetwork is taken out of use. To update the diagnostic
counters click Refresh.

Monitoring and controlling IEC 61850 device
communication

11.5.

The IEC 61850 device communication can be monitored with the Online Diagnostics
function.

To monitor and control IEC 61850 device communication:
1. Select the device you want to monitor in the object tree of .
2. Right-click the device.
3. Select Online Diagnostics.

In the Status information field, you can monitor the device status. The Diagnostic
counters field provides information on device activity. To reset diagnostic counters, click
Reset counters. To update the diagnostic counters click Refresh.

You can take an IEC 61850 device into use by selecting the In Use check box. If you
clear the check box, the device is taken out of use.

Monitoring and controlling IEC 61850 data object
communication

11.6.

The IEC 61850 data object diagnostics can be monitored with the Online Diagnostics
function.

To monitor and control IEC 61850 data object communication:
1. Select the data object you want to monitor in the object tree.
2. Right-click the device.
3. Select Online Diagnostics.

In the Status information field, you can monitor and set attribute values and use control
services. The Diagnostic counters field provides information on device activity.
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IEC 104 OPC server operation12.

About this section12.1.

This section describes the basic operation procedures you can carry out after the IEC104
OPC Server has been configured.

After this, you can, for example, monitor and control the condition of connections in an
IEC104 network by using the Online diagnostics function SAB600.

Activating COM600 with new configurations12.2.

For information about activating COM600 with new configuration, see COM600 User’s
Manual.

IEC104 OPC Server diagnostics12.3.

To view the IEC104 OPC Server diagnostics, right-click the IEC104 OPC Server object
and select Online diagnostics, see Figure 12.3-1.

IEC104_OPC_Server_Online_diagnostics.bmp

Figure 12.3-1 IEC104 OPC Server Online diagnostics

You have the following alternatives:
• to view version information
• to reset the IEC104 OPC Server
• to view the event log file, see Figure 12.3-2
• to clear the log file
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IEC104_OPC_Server_Event_Log.bmp

Figure 12.3-2 Event log file

Diagnostic AE Client

Diagnostic events can be monitored and controlled using the Diagnostic AE Client
function, see Figure 12.3-3. Click Refresh to update the status information. To be able
to receive events from a certain device, diagnostic events must be enabled for this
respective device.

To enable diagnostic events:
1. Right-click the device.
2. Select Online diagnostics.
3. Mark the Diagnostic events enabled check box. See Figure 12.3-3 for example.

IEC104_OPC_Server_Diagnostic_AE_Client.bmp

Figure 12.3-3 IEC104 OPC Server Diagnostic AE client
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Monitoring and controlling IEC104 Channel Activity12.4.

The IEC104 Channel activity can be monitored with the Online diagnostics function.

You can also take a channel into use or out of use as described in this section.

To monitor and control IEC104 channel activity:
1. Select the channel you want to monitor in the object tree of SAB600.
2. Right-click the channel.

In the Diagnostic counters field, you can monitor the channel activity. To reset Diagnostic
counters, click Reset counters.

You can take an IEC104 Channel into use by marking the In use check box. If you
unmark the check box, the channel is taken out of use. Diagnostic counters are updated
every 2 seconds. To update them manually, click Refresh.

For more information on the channel online diagnostics with the Analyzer function, see
COM600 User's manual.

Monitoring and controlling IEC 104 Device
communication

12.5.

The IEC104 Device communication can be monitored with the Online diagnostics
function. You can also take a device into use or out of use as described in this section.

To monitor and control IEC104 Device communication:
1. Select the device you want to monitor in the object tree of SAB600.
2. Right-click the device.
3. Select Online diagnostics.

In the Status information field, you can monitor the device status.

The Diagnostic counters field provides information on device activity. To reset diagnostic
counters, click Reset counters.

You can take an IEC104 Device into use by marking the In use check box. If you unmark
the check box, the device is taken out of use. To update diagnostic counters manually,
click Refresh.
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IEC104_OPC_IED_Online_Diagnostics.bmp

Figure 12.5-1 IEC104 IED Online Diagnostics

Data object diagnostics12.6.

For information on data object diagnostics, refer to COM600 User’s Manual.
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DNP3 LAN/WAN OPC server operation13.

About this section13.1.

This section describes the basic operation procedures you can carry out after the server
has been configured.

After reading this section, you can, for example, monitor and control network connections.
Monitoring and controling is done by using the Online diagnostics function in SAB600.

Activating COM600 with new configurations13.2.

For information about activating COM600 with new configuration, see COM600 User’s
Manual.

Server diagnostics13.3.

Diagnostic events can be monitored and controlled using the Diagnostic AE Client
function. Click Refresh to update the status information. To be able to receive events
from a certain device, diagnostic events must be enabled for this respective device.

You have the following alternatives:
• View version information
• Reset the OPC Server
• View the event log file
• Clear the log file

dnp_serial_opc_client_ae.png

Figure 13.3-1 DNP OPC Client Diagnostic AE client
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DNP channel diagnostics13.4.

The DNP channel activity can be monitored with the Online diagnostics function. You
can also take a channel into use or out of use as described in this section.

To monitor and control DNP Channel activity:
1. Select the channel you want to monitor in the object tree of SAB600.
2. Right-click the channel.
3. Select Online diagnostics.

In the Diagnostic counters field, you can monitor the channel activity. To reset Diagnostic
counters, click Reset counters.

You can take a DNP channel into use by marking the In use check box. If you unmark
the check box, the channel is taken out of use.

For more information on the channel online diagnostics with the Analyzer function, see
COM600 User's manual.

Monitoring and controlling DNP communication13.5.

The DNP device communication can be monitored with the Online diagnostics function.
You can also take a device or module into use or out of use as described in this section.

To monitor and control DNP device communication:
1. Select the device/ module you want to monitor in the object tree of SAB600.
2. Right-click the device.
3. Select Online diagnostics.

In the Status information field, you can monitor the device status.

The Diagnostic counters field provides information on device activity. To reset diagnostic
counters, click  Reset counters.

You can take a DNP device into use by marking the In use check box. If you unmark
the check box, the device is taken out of use.

Diagnostic counters are updated every 2 seconds. To update them manually, click Refresh.

Data object diagnostics13.6.

For information on data object diagnostics, refer to COM600 User’s Manual.
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External OPC server operation14.

About this section14.1.

This section describes the basic operation procedures you can carry out after the object
properties for the External OPC Server have been configured.

After this, you can, for example, monitor and control the condition of connections in an
OPC network. This is done by using the Online diagnostics function in SAB600.

Activating COM600 with new configurations14.2.

For information about activating COM600 with new configuration, see COM600 User’s
Manual.

External OPC Server diagnostics14.3.

To view the External OPC Server diagnostics, right-click the External OPC Server object
and select Online diagnostics, see Figure 14.3-1.

Ext_OPC_Server_Diagnostics.png

Figure 14.3-1 External OPC Server diagnostics

You have the following alternatives:
• to view version information
• to reset the External OPC Server
• to view the event log file
• to clear the log file
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Ext_Event_log_file.png

Figure 14.3-2 Event log file

Diagnostic AE Client

Diagnostic events can be monitored and controlled using the Diagnostic AE Client
function. Click Refresh to update the status information. To be able to receive events
from a certain device, diagnostic events must be enabled for this respective device.

To enable diagnostic events:
1. Right-click the device.
2. Select Online diagnostics.

Select Diagnostic AE Client.

lisää kuva

Figure 14.3-3 OPC Server Diagnostic AE client

Data object diagnostics14.4.

For information on data object diagnostics, refer to COM600 User’s Manual.
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MODBUS TCP server operation15.

About this section15.1.

This section describes the basic operation procedures you can carry out after the object
properties for the Modbus OPC Server have been configured.

After this, you can, for example, monitor and control the condition of connections in a
Modbus network. This is done by using the Online diagnostics function in SAB600.

Activating COM600 with new configurations15.2.

For information about activating COM600 with new configuration, see COM600 User’s
Manual.

Modbus OPC Server diagnostics15.3.

To view the Modbus OPC Server diagnostics, right-click the Modbus OPC Server object
and select Online diagnostics.

You have the following alternatives:
• to view version information
• to reset the OPC Server
• to view the event log file
• to clear the log file

Modbus Channel diagnostics15.4.

The Modbus Channel activity can be monitored with the Online diagnostics function.

You can also take a channel into use or out of use as described in this section.

To monitor and control Modbus Channel activity:
1. Select the channel you want to monitor in the object tree of SAB600.
2. Right-click the channel.
3. Select Online diagnostics.

In the Diagnostic counters field, you can monitor the channel activity. To reset Diagnostic
counters, click Reset counters.

You can take a Modbus Channel into use by marking the In use check box. If you unmark
the check box, the channel is taken out of use. To update diagnostic counters, click
Refresh.
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For more information on the channel online diagnostics with the Analyzer function, see
COM600 User's manual.

Monitoring and controlling Modbus Device
communication

15.5.

The Modbus device communication can be monitored with the Online diagnostics
function. You can also take a device or module into use or out of use as described in this
section.

To monitor and control Modbus Device communication:
1. Select the device/ module you want to monitor in the object tree of SAB600.
2. Right-click the device.
3. Select Online diagnostics.

In the Status information field, you can monitor the device status.

The Diagnostic counters field provides information on device activity. To reset diagnostic
counters, click  Reset counters.

You can take a Modbus device into use by marking the In use check box. If you unmark
the check box, the device is taken out of use.

Diagnostic counters are updated every 2 seconds. To update them manually, click Refresh.
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Modbus_Device_online_diagnostics.bmp

Figure 15.5-1 Modbus Device Online diagnostics

Data object diagnostics15.6.

For information on data object diagnostics, refer to COM600 User’s Manual.
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SNMP OPC server operation16.

About this section16.1.

This section describes the basic operation procedures you can carry out after the SNMP
OPC Server has been configured.

After this, you can, for example, monitor and control the condition of connections in an
SNMP network. This is done by using the Online diagnostics function in SAB600.

Activating COM600 with new configurations16.2.

For information about activating COM600 with new configuration, see COM600 User’s
Manual.

SNMP OPC Server diagnostics16.3.

To view the SNMP OPC Server diagnostics, right-click the SNMP OPC Server object
and select Online diagnostics, see Figure 16.3-1.

SNMP_Online_diagnostics.png

Figure 16.3-1 SNMP OPC Server diagnostics

You have the following alternatives:
• to view version information
• to reset the SNMP OPC Server
• to view the event log file
• to clear the log file
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SNMP_event_log.png

Figure 16.3-2 Event log file

Diagnostic AE Client

Diagnostic events can be monitored and controlled using the Diagnostic AE Client
function. Click Refresh to update the status information. To be able to receive events
from a certain device, diagnostic events must be enabled for this respective device.

To enable diagnostic events:
1. Right-click the device.
2. Select Online diagnostics.

Monitoring and controlling SNMP IED communication16.4.

The SNMP IED communication can be monitored with the Online diagnostics function.
You can also take a device or module into use or out of use as described in this section.

To monitor and control SNMP IED communication:
1. Select the device you want to monitor in the object tree of SAB600.
2. Right-click the device.
3. Select Online diagnostics.

• In the Status information field, you can monitor the device status.
• The Diagnostic counters field provides information on device activity. To reset

diagnostic counters, click Reset counters.
• Take the SNMP device into use by selecting the In use check box. If you clear

the check box, the device is taken out of use.
• Diagnostic counters are updated every 2 seconds. To update them manually,

click Refresh.
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SNMP_IED_online_diagnostics.png

Figure 16.4-1 SNMP IED Online diagnostics

Data object diagnostics16.5.

For information on data object diagnostics, refer to COM600 User’s Manual.
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SNTP OPC server operation17.

About this section17.1.

This section describes the basic operation procedures you can carry out after the SNTP
OPC Server has been configured.

After this, you can, for example, monitor and control the condition of connections in the
SNTP network. This is done by using the Online diagnostics function in SAB600.

Activating COM600 with new configurations17.2.

For information about activating COM600 with new configuration, see COM600 User’s
Manual.

SNTP OPC Server diagnostics17.3.

You have the following alternatives:
• to view version information
• to reset the SNTP OPC Server
• to view the event log file
• to clear the log file

Diagnostic AE Client

Diagnostic events can be monitored and controlled using the Diagnostic AE Client
function. Click Refresh to update the status information. To be able to receive events
from a certain device, diagnostic events must be enabled for this respective device.

To enable diagnostic events:
1. Right-click the device.
2. Select Diagnostic AE Client.

Data object diagnostics17.4.

For information on data object diagnostics, refer to COM600 User’s Manual.

331

COM600 series 5.11MRS758689

Master Protocols (Ethernet) and Applications Configuration
and Operation Manual



Redundant OPC server operation18.

Switch-over18.1.

Switch-over happens when the active source is changed from one source IED to the
other.

Currently switch-over is only done manually (though it would be possible to define
external rules in e.g. the COM600 Logic Processor to automatically do it when, say, the
connection status of the current source IED becomes bad).

When switch-over is executed, the Redundant IED will update its data objects to be
consistent with the data objects in the new active source IED. The time and value epsilons
defined for consistency checking are used when these switch-over checks are done.

Generally, value, quality and time will be compared for indications, while for measure-
ments only value and quality will be compared. If the redundant IED data object is not
consistent with the new active source IED data object, then the former will be updated
with the values of the latter.

Parameter setting18.2.

The COM600 WebHMI has special support for Redundant IEDs in its Parameter setting
tool.

This feature is only supported when the source IEDs are IEC
61850 IEDs.

When opening the Redundant IED parameter setting tool, it will display the source IED
names in the header. The currently active source IED will be marked with bolded text.

Changing parameters for the Redundant IED will automatically change them in both
source IEDs at the same time. Parameters in the source IEDs that have inconsistent values
will be clearly marked with yellow for the user to address. For those parameters the
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values from both source IEDs are displayed, in the same order as the source IED names
in the header.

COM600-Redundant_OPC_server-PST-Redundant_IED.png

Figure 18.2-1 Redundant IED with inconsistent data
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Communication diagnostics18.3.

WebHMI communication diagnostics18.3.1.

Communication diagnostics for the Redundant IED is shown in the WebHMI commu-
nication structure for the IED.

In addition to the standard Connection status and Detailed status there is also Incon-
sistent data count, which shows the current number of inconsistent data objects.
Assuming consistency checking is enabled.

It also offers the option to change the active source (providing no active source input
signal has been defined) and to enable/disable consistency checking.

To the normal diagnostic counters for data objects it adds Inactive source updates and
Inconsistent data detections.

Inactive source updates is the other side of Data object updates, it shows the number of
updates for the inactive source IED.

Inconsistent data detections shows the total number of inconsistent data updates so far.
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COM600-Redundant_OPC_server-Redundant_IED-comm_diagnostics.png

Figure 18.3.1-1 Redundant IED communication diagnostics

SAB600 communication diagnostics18.3.2.

About the SAB600 communication diagnostics18.3.2.1.

Redundant OPC Server diagnostics use the connectivity OPC Server. To view the
Redundant OPC Server diagnostics, right-click the Redundant OPC Server object and
select online diagnostics.
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SAB600_Redundant_OPC_server_online_diagnostics.png

Figure 18.3.2.1-1 Redundant OPC server online diagnostics

You have the following alternatives:

• View version information
• Reset the Redundant OPC Server
• View the event log file
• Clear the log file

Diagnostic AE Client18.3.2.2.

Diagnostic events can be monitored and controlled using the Diagnostic AE Client
function. Click Refresh to update the status information. To be able to receive events
from a certain device, diagnostic events must be enabled for this respective device.

To enable diagnostic events:
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1. Right-click the device
2. Select Online diagnostics
3. Select Diagnostic AE Client.

Monitoring and controlling Redundant IED communication18.3.2.3.

The Redundant IED communication can be monitored with the Online diagnostics
function. You can also take an IED into use or out of use as described in this section.

To monitor and control Redundant IED communication:

1. Select the IED you want to monitor in the object tree of SAB600.
2. Right-click the device.
3. Select Online diagnostics.

In the Status information field, you can monitor the device status.

In the Inconsistent data count field, you can monitor the number of inconsistent data.
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Active source defines the currently active SSC600 unit.

Consistency checking enabled defines whether consistency is checked between the
data provided from SSC600 units.

The Diagnostic counters field provides information on device activity. To reset diagnostic
counters, click Reset counters.

Diagnostic counters are updated every 2 seconds. To update them manually, click Refresh.

SAB600_Redundant_OPC_server_online_diagnostics.png

Figure 18.3.2.3-1 Redundant IED online diagnostics
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